
T.D.O.T. Design Division Programs 
The T.D.O.T. Design Division has developed several special programs or applications for use in 
MicroStation to perform a variety of functions including cell access, generating graphical 
elements or altering them and computing quantities or other needed information. These 
applications include Geopak 3 port criteria program files or 3PC files as they are commonly 
called,  MicroStation Basic programs as well as MicroStation Visual Basic Applications.  

All of them can be accessed from Geopak’s Design & Computation Manager. When running the 
T.D.O.T. Design Division interface most of them can be accessed from the TDOT drop down 
menu. Many are available from short cuts provided on other associated program dialogs. The 
TDOT Design Division Toolbox program\dialog provides access to many of the tools, 
commands and functions used most often by TDOT Design Division personnel. 

 This document contains program descriptions and workflow for these special programs listed in 
the order as they appear in Geopak’s Design & Computation Manager. From there the programs 
can be activated in two ways.  

If you are running in the dialog mode with the expanded D&C Manager window then double 
click on the item with Design mode active. 

 
If you are running D&C Manager window in the toolbox mode then just click on the Execute 
Design Keyin button 
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Drafting Standards 

Tools 
TDOT Design Division Toolbox 
D&C location: Drafting Standards>Tools > Design Toolbox 
MicroStation VBA Program: TDOTDesignDivToolbox.mvba 
Description: 
This program\dialog provides access to many of the tools, commands and functions used most 
often by TDOT Design Division personnel. It is an alternative to access  of them through the 
TDOT interface drop down menu or Geopak's D&C Manager. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Tools > Design Division Toolbox  
or by using the keyin  
vba run [TDOTDesignDivToolbox]DesignToolbox.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Design Toolbox. The TDOT Design Division Toolbox 

dialog appears. 

 
Step 2. Click on any command button to access the specified tool or any cell group 

description in the list provided to open that cell dialog. 
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TDOT Survey Project Workflow Toolbox 
D&C location: Drafting Standards>Tools > Survey Toolbox 
MicroStation VBA Program: SurveyProjectWorkFlowToolbox.mvba 
Description: 
This program\dialog provides access to many of the tools, commands and functions used most 
often by TDOT Survey personnel. It is an alternative to access of them through the Geopak 
Survey drop down menu and are presented in a work flow format as was shown on the Survey 
Operations dialog in Geopak 2001. The dialog includes the following categories: Project Control, 
Dataset Processing, Graphics Display, Coordinate Geometry & DTM Processing. When this vba 
program is started Geopak Survey is loaded and when the dialog is closed Geopak Survey and 
the vba is unloaded. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Survey Project Workflow Toolbox 
or by using the keyin  
vba run [SurveyProjectWorkFlowToolbox]SurveyToolbox.main 
Special Requirements: 
Requires updated version of Geopak mdl program survmain.ma dated 2/1/2006 for use with 
Geopak version 08.05.02.35. Prior version of this mdl program created a vba interface error 
when Preferences were accessed from visual basic dialogs. 
Usage: 
Step 1. In D&C manager activate Survey Toolbox. The TDOT Survey Project Workflow 

Toolbox dialog appears. 

 
Step 2. Click on any command button to access the specified tool. 
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Text Styles Plus 
D&C location: Drafting Standards > Tools > Textstyles Plus 
MicroStation VBA Program: TextstylesPlus.mvba 
Description: 
This program activates text styles and sets the active level, color and weight. The current active 
scale is shown with a keyin field to reset as needed. Scale is used to control the text size in 
conjunction with the standard size associated with the text style. This includes all text styles 
except for those used on cross sections. 

A command button is provided to access TDOT Design Division MicroStation Basic macro 
which is used to set any standard text size based on scale (command button: Alternate STD Text 
Size). 
A command button is provided to access the Place Label with Leader Line vba program. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Text Styles Plus…  
or by using the keyin  
vba run [TextstylesPlus]Textstyles.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Textstyles Plus. The Text Styles Plus dialog appears. 

 
Step 2. Check and reset the scale as needed. Click on any text style description in the dialog 

list to activate the text style and set the appropriate active level, color and weight. 
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Place Label with Leader Line 
D&C location: Drafting Standards > Tools > LabelwithLeader 
MicroStation VBA Program: PlaceLabel.mvba 
Description: 
This program places general labels with leader lines. Options include 1 or 2 lines of text, 
horizontal line and choice of terminators including arrowheads or a dot. The current active scale 
is shown with a keyin field to reset as needed. Scale is used to control the terminator cell scale 
when included. Graphics are  placed at the current active level, symbology & text parameters. 
All label graphics are combined in a graphic group for easy movement or deletion. 
The most efficient use of this tool is in conjunction with the Text Style Plus vba program which 
will set the active level, symbology & text parameters. A command button is provided to access 
this program. 
ALL options on the dialog can be adjusted on the fly as the label is placed. 
This tool can be used without the placement of text to simply place a leader line. If a horizontal 
line is included without text then the length of the line is set at 10 character widths of the current 
text size. 

This program can also be activated from the MicroStation drop down menu 
 TDOT > Tools > Place Label with Leader  
or by using the keyin  
vba run [PlaceLabel]TDOTLabel.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate LabelwithLeader. The Place Label with Leader Line 

dialog appears. 

 
Step 2. In the Place Label with Leader Line dialog click on the desired options and keyin text 

for the label in the keyin fields provided. If a terminator is requested click on the 
desired type. Check and reset the scale as needed. Since this program uses the current 
active settings you may wish to start Text Styles Plus to control those. 
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When all settings are made click on the Place Label command button to start 
placement of the label.  

Step 3. The  user is first prompted to Identify Location for End of Leader.  

 
Step 4. Once this point is given,  a second point is required to position the label. 

 
The label appears dynamically on the cursor as the user moves the mouse. If a horizontal 
line is included, the leader will jump to either end of the line. If no horizontal line is 
requested, the leader will jump to either end or above or below the text as the label is 
positioned. When a point is given the graphics are placed. 
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Label Station / Offset 
D&C location: Drafting Standards > Tools> StaOffsetLabel 
MicroStation VBA Program: StaOffLabel.mvba  
Description:  

This program places a station and offset label based on a data point, or a station and offset keyed 
in by the user.  Options include title text, line separating station and offset, leader line and choice 
of terminator including arrowheads or a dot.  The current active scale is shown with a keyin field 
to reset as needed. Scale is used to control the terminator cell scale when included.  Graphics are 
placed at the current active level, symbology & text parameters. All text and the divider line are 
combined in one graphic group and the leader and terminator combined in another. An ID button 
is provided for graphic selection of the chain to use.   

The most efficient use of this tool is in conjunction with the Text Styles Plus vba program which 
will set the active level, symbology & text parameters. A command button is provided to access 
this program.  

This tool can be used simply as a horizontal alignment tracking device with dynamic mode 
without placing labels. 

After using this tool, the job number  and chain name are remembered and will be used to 
populate those fields when the dialog is opened again as long as the previously defined job 
number is found in the current active folder.  

Metric application includes both metric & English measurements. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Tools> Place Station Offset Label  
or by using the keyin  
vba run [StaOffLabel]StationOffset.main 

Special Requirements:  

Chain that station and offset are measured from must be stored in a Geopak GPK file in the 
folder where the DGN file resides.  

The ID Chain function uses a special VBA reference to program GetCogoElement.mvba which 
was provided by Bentley and must be present with the program for it to function. 

Set level, symbology and text size for label using Text Styles Plus or manual methods prior to 
use. 
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Usage:  User Key-In Method 

Step 1. In D&C manager activate StaOffsetLabel. The Label Station/Offset dialog appears. 

All Geopak jobs found within the current active folder are listed in the Job drop down 
box.  The dialog defaults to no title text or terminator, and placing the divider line. 

 

Step 2. After selecting the Geopak Job number, the Chain drop down is populated with all 
chains stored in the job.  Select the chain to use for labeling.  If you do not know the 
chain name but have chain graphics, the ID button can be used to select the chain.  

Check the box next to title text and key in a title if desired.  The title will only be 
placed if the Title Text box is checked.  Uncheck the divider line or leader line if 
either is unneeded.  Select whether you would like the label to be placed 
perpendicular to the chain or horizontal with the view.  The diagrams below show 
how each will appear. 

                       
Perpendicular to Chain    Horizontal with View 

Note:  Any or all of the placement options can be changed on the fly, but changing 
the Job number or Chain name stops the labeling process. 
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Step 3.  Key in a station value and offset value, use a negative offset value to indicate left of 
the centerline.  Stations may be entered with or without a “+”.  After keying in the 
values, move the cursor off the dialog to identify the location of the label.  If Place 
Leader is checked, the end of the line will be at the station and offset entered, and the 
label moves dynamically with the cursor.  Data point to place the label in the desired 
location or reset to stop placement. 

 
If at the time of placement you find it necessary to access other MicroStation 
commands,  label placement can be re-started by clicking on the Place Label button. 

Usage:  Dynamic Method 

Step 1.   Set job number, chain name and placement options as described previously in Steps 1 
and 2 under User Key-In Method 

Step 2.  Click the Dynamic button to initiate the dynamic placement mode.  Move the cursor 
off the dialog and a temporary label will follow the cursor with the station and offset 
values changing dynamically on the screen and within the dialog’s text boxes as the 
cursor moves along the specified chain.   

 
Snapping to a point in the DGN file will pause the dynamic mode.  Reset after a snap 
to resume the dynamic mode.  After snapping to a point, edit the station and/or offset 
if desired in the dialog text boxes.  Editing the text will lock the respective value.  If 
the station is locked, but offset is not, the temporary label will then only move 
perpendicular to the chain at that station.  If the offset is locked, and the station is not, 
the temporary label will only move along the chain at that offset.   
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Notes:  

If either the station or offset are known prior to placement, set the value first and then 
start dynamic mode. 

If the cursor moves to a point off the chain the label will disappear and the dialog text 
boxes will display the last available station and offset. 

If both station and offset are locked the mode will switch to the place label mode as 
described in User Key-In Method Step 3.  

Step 3. Once the station and offset are set in any of the ways described in the previous step, 
data point to initiate label placement.  After the label is positioned correctly, data 
point again to place the label. 
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Data Point Profile Station Elevation 
D&C location: Drafting Standards > Tools> DP Sta Elev 
MicroStation VBA Program: DPprofile.mvba  
Description:  
'This program was primarily designed to issue a  data point based on a station and elevation on 
the profile. Chain, reference datum, and other profile information are attained when the user 
selects the Geopak profile cell.  The Geopak profile cell must be identified first before any tools 
are used. This program also includes options to dynamically track station and elevation values on 
the profile and to place labels for them. 
Dynamic tracking options include dynamic graphic label, station lock and elevation lock. Locks 
allow dynamic tracking on just station or elevation. 
 Geopak accuracy format controls are provided for station and elevation. These control values 
placed with labels and when using the dynamic tracking function. 
When placing labels, the current active element symbology and text settings are used to control 
all aspects of the labels which are placed. For this reason, a command button is provided to 
access the Text Styles Plus program to aide in making these settings. The length of the leader 
line which is placed with the labels is controlled dynamically by the user. Annotation may be 
placed above or below the profile point being labeled. 
This tool stores the current location of the dialog in the file C:\Temp\MVBA_FormStorage.log 
when the dialog is closed. When opened later it uses this information to bring up the dialog on 
the screen where you last used it. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Profiles> DP Profile Sta Elev w/Tracking 
or by using the keyin  
vba run [DPprofile]DataPointonProfile.main 

Special Requirements:  
A Geopak profile cell must be present.  

Usage:  Send Profile Data Point  

Step 1. In D&C manager activate DP Sta Elev. The 
Data Point Profile Station Elevation dialog 
appears. 
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Step 2. Click on the Identify Profile Cell command button and data point on the Geopak 
profile cell for the profile. The window shade button on the upper right of the dialog 
can be used to get the dialog out of the way as you identify the profile cell.  Just click 
it again to re-expand the dialog after identifying the cell. 

Step 3.  Key in the Station and Elevation values where you wish for a data point to be sent.  
After keying in the values, click on the Data Point command button to send the 
point.  
 
In the example shown below we needed to place a box culvert at station 103+05 and 
elevation 779.35. After making the desired settings in the box culvert tool, the user is 
prompted to “Identify Flow Line Location at Center”. Rather than just data pointing 
or graphically locating this location, the Data Point Profile Station Elevation tool 
allows you to set the point by the known station and elevation at the centerline. 
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Usage:  Dynamic Tracking 

Step 1.   Start the program and identify the Geopak profile cell as described previously in 
Steps 1 and 2 under Send Profile Data Point 

Step 2.  Click the Dynamic Tracking button to start the tracking mode.  Move the cursor off 
the dialog and a temporary label will follow the cursor with the station and elevation 
values changing dynamically on the screen and within the dialog’s text boxes as the 
cursor moves across the profile.   

 
Snapping to a point in the DGN file will pause the dynamic mode.  After snapping to a 
point, edit the station or elevation if desired in the dialog text boxes.  Editing the text 
will lock the respective value. Click the Dynamic Tracking button to restart the 
tracking mode.  

If either the station or elevation are known, set that value first and then start dynamic 
tracking. 

Use the Geopak accuracy format controls below the station and elevation text fields on 
the dialog to control the decimal values which are shown. 

The lock symbols can be clicked at any time to lock or un-lock the station or elevation 
values. If the station is locked, but elevation is not, the temporary label will then only 
move up  & down on the profile at that station.  If the elevation is locked, and the 
station is not, the temporary label will only move along the profile at that elevation 
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Usage:  Placing Station & Elevation Labels 

Step 1.   Start the program and identify the Geopak profile cell as described previously in 
Steps 1 and 2 under Send Profile Data Point 

Step 2.  Make MicroStation symbology and text settings, manually or by clicking the Text 
Styles Plus… command button to choose from the standard TDOT Design Division 
tezxt styles and set the appropriate level and weight as well.   

Step 3.  In the Data Point Profile Station Elevation dialog, either key in a known station and 
elevation or click the Dynamic Tracking button to start the tracking mode.   

Step 4. If the station and elevation were keyed in click the Label Station & Elevation 
command button to start label placement.  
 
If using the Dynamic Tracking mode, data point at any time while tracking to start 
label placement. 

Step 5. The user is prompted to Lidentify End for Leader. Move the cursor up and down to 
set the length of the leader line and to place the label above or below the point being 
labeled. Data point to set and place the label. 

 

The Geopak accuracy format controls below the station and elevation text fields on the 
dialog control the decimal values which are shown in labels. 
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Place Arrowhead 
D&C location: Drafting Standards > Tools > Arrowheads 
MicroStation VBA Program: PlaceArrowHead.mvba 
Description: 
This program places arrowhead cells. Option for small, medium(standard), large or extra large 
arrowhead is given. The current active scale is shown with a keyin field to reset as needed. Scale 
is used to control the size of arrowhead cells. 
The Place as Terminator command button can be used to place the chosen arrowhead as a 
terminator cell. Clicking this button starts MicroStation's Place Terminator command but note 
that when this command is used arrowheads are placed on the level and with the symbology as 
they were created (level 1, color 0). 
A command button is provided to reset the active scale and the terminator scale. When a new 
scale value is entered in the scale keyin field that scale is automatically used for the cell 
placement with Place by 2 Points but does not automatically reset the files current active scales. 
If you wish to do so just click on the Set Scale button on the dialog. This was set up in this way 
so that users could adjust the scale of arrowheads on the fly without changing the current scales. 

This program can also be activated from the MicroStation drop down menu  
TDOT >Tools > Place Arrowhead  
or by using the keyin  
vba run [PlaceArrowHead]Arrowhead.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Arrowheads. The Place Arrowhead dialog appears. 

 
Step 2. Choose the type of arrowhead and check the scale. Then click on the Place by 2 

Points command button to start placement of the arrowhead. 
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Step 3. The user is first prompted to Identify Point for Tip.  

 
Step 4. Once this point is given,  a point back is requested to set the angle of the arrowhead. 

 
The cell is placed at the current active level & symbology. Scale or choice of 
arrowhead can be changed in the dialog during arrowhead placement. Level & 
symbology can be changed on the fly as well. 
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Rotate Element To Horizontal 
D&C location: Drafting Standards > Tools > RotateToHoriz 
MicroStation VBA Program: RotateElementHorizontal.mvba 
Description: 
This program rotates elements horizontal to the view. It is normally used for clean up of notes, 
labels etc. to appear horizontal on plan sheets. 
This program supports the following element types: lines, line strings, shapes, text, text nodes, 
ellipses, arcs, cells, shared cells, shared cell definitions, tags, cones. 
For line strings and shapes the nearest segment is used to control the angle. For these elements as 
well as lines the smallest angle of rotation is utilized. 
If the chosen element is a in a graphic group and the graphic group lock is on then the rotation 
from the element chosen is applied to all members of the group. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Tools > Rotate Element To Horizontal  
or by using the keyin  
vba run [RotateElementHorizontal]RotateElementHoriz.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate RotateToHoriz. When the command is started the user is 

prompted to Identify Element. 

 
In this example we will use the tool to rotate a set of cure data to be horizontal on the 
plan sheet. To rotate all of the text at once the graphic group lock is turned on. This 
lock setting can be changed while using the command. 
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Step 2. When the top line of text is identified with a data point you are prompted to 
Accept\Reject. 

 

Step 3. When the accept data point is given the curve data is rotated to horizontal. 
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Rotate Fence\Selection Set Horizontal 
D&C location: Drafting Standards > Tools > RotateFencHoriz 
MicroStation VBA Program: RotateFenceContentsHorizontal.mvba 
Description: 
This program rotates the contents of a fence or selection set horizontal to the view based on 2 
points which define the desired horizontal. It is normally used to rotate groups of elements to 
appear horizontal on plan sheets. 
This is an alternative to the Rotate Element to Horizontal vba program for groups of un-
associated elements as well as for element types not supported by that command. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Tools > Rotate Fence\SS Horizontal 
or by using the keyin  
vba run [RotateFenceContentsHorizontal]RotateFenceContentsHoriz.Main 
Special Requirements: 
A fence or selection set must be active at the time the command is accessed. If both are present 
then the fence is processed. 
Usage: 
Step 1. Place a fence around the elements to be rotated or add them to a selection set. Current 

fence settings such as inside, overlap,  etc. are used so set as needed.  
Step 2. In D&C manager activate RotateFencHoriz. When the command is started the user 

is first prompted to Identify Point Back. This point will define the left end of an 
imaginary line you desire to be horizontal when the rotation is complete. 

 
 In this example we are rotating a special ditch detail originally set up on another 

sheet. 
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Step 2. After giving the point back you are prompted to Identify Point Forward. A 
temporary line is dynamically shown to aide in setting this final point of your desired 
horizontal. 

 

Step 3. Once the desired horizontal is set you are prompted to Identify Rotation Point. 
Graphics are dynamically shown rotated so this final point can be used to position 
graphics. After the final point is given, graphics are rotated. 
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Calculate & Label Slope 
D&C location: Drafting Standards > Tools > Slope Tool 
MicroStation VBA Program: SlopeCalculater.mvba 
Description: 
Calculates slopes based on 2 points and if desired will place a label for the slope. Slope is shown 
in the dialog in the 3 standard formats: cross slope, percent grade & side slope. Slope label 
graphics are placed at the current active level, symbology & text parameters. 
The Label Type option controls the format which is used when the Place Label command button 
is clicked. Includes an entry field for Profile Exaggeration to control how slopes are calculated 
when used on profiles. Command buttons are provided to access the Text Styles Plus & XS Text 
Styles Plus vba programs which will set the active level, symbology & text parameters.  . 

This program can also be activated from the MicroStation drop down menu  
TDOT >Tools > Calculate & Label Slope  
or by using the keyin  
vba run [SlopeCalculater]SlopeToolStart.main 
Special Requirements: 
Set level, symbology and text size for label using Text Styles Plus, XS Text Styles Plus or 
manual methods. 
Usage: 
Step 1. In D&C manager activate Slope Tool. The Calculate & Label Slope dialog appears. 

 
Step 2. As soon as the dialog opens the slope calculator starts and the user is prompted to 

Identify Begin Point. Data point or snap and data point on the end of an element as 
needed to mark the beginning of the slope you wish to calculate. If you are 
calculating on a profile, make sure the Profile Exaggeration is set correctly. The 
normal exaggeration of 10 is specified by default. 
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Step 3. After giving the beginning point the user is then prompted to Identify End Point. A 
temporary line is shown dynamically to indicate the slope that is being measured.  

 
Step 4. After the end point is given the dialog is populated with the slope in its different 

formats and the calculator again prompts the user for a new begin point to continue 
calculating slopes. 
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Step 5. To label the slope, click on the desired Label Type option and click the Place Label 
command button. The text appears on the cursor point and the user is prompted to 
Identify location for text. 

 

After the text location point is given, the text remains available for additional 
placements as needed. A reset will stop text placement and restart the slope 
calculator. 

When other tools are accessed, the Calculate Slope command button can be clicked 
to restart the slope calculator.  
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DGN Batch Text Editor 
D&C location: Drafting Standards > Tools > Batch Text Edit 
MicroStation VBA Program: BatchTextEditor.mvba 
Description: 
This program looks for the specified text string in the selected DGN files and changes it to the 
new text string given. It uses the MicroStation Find/Replace text tool to make the changes. 
Match Case and Edit Text in Cells is enabled. No confirmation is offered and all changes are 
automatically done so it is critical that a full example of the text string is provided to avoid 
changing the wrong text. This tool was specifically created to edit project numbers when they 
change but can be used to edit any text string in multiple DGN files. 

This program can also be activated from the MicroStation drop down menu  
TDOT >DGN Batch Text Editor  
or by using the keyin  
vba run [BatchTextEditor]EditTexttStart.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Batch Text Edit. The DGN Batch Text Editor dialog 

appears. 

 
Step 2. In the keyin fields provided, enter the Original Text and the New Text. 

Step 3. Using standard Windows selection techniques select the files you wish to edit text in 
or just click the Select All command button to select all files. 
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Step 4. Click on the Edit Text command button to start edits. Each file is opened and 
MicroStation’s Find/Replace Text tool is used to make the changes. 

When the last file is processed a completion message is displayed. Click OK to 
dismiss the message. 

 
A review of the files will show that the text has been changed. 
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Place North Arrow 
D&C location: Drafting Standards > Tools > North Arrow 
MicroStation VBA Program: PlaceNorthArrow.mvba 
Description: 
This program places the standard north arrow cell at true north. 

Current active angle and view rotation are ignored by program to maintain true north orientation 
of cell. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Tools > Place North Arrow  
or by using the keyin  
vba run [PlaceNorthArrow]NorthArrow.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate North Arrow. After starting the command the north arrow 

cell is activated and  the user is prompted to Identify Location. 

 
Step 2. A data point places the cell in the location given and the cell remains active for 

additional placements as needed. A reset will de-activate the cell and end exit the 
program. 
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Set Text Parameters by Active Scale 
D&C location: Drafting Standards > Tools > Set Text 
MicroStation VBA Program:  SetTextParametersAS.mvba 
Description: 
This program sets active text size, weight, and line spacing based on the active scale and the text 
size desired when plotted. The user given plot scale is used to set the active scale.  
To avoid problems when placing text, the text node lock is turned off and line length is set to 
255. This program can be utilized at any time during text placement. 
This tool is best used after picking a standard text style from the program, Text Styles Plus, 
which will set the appropriate level and color for the text. 
Program is set up for use on English or Metric projects 

This macro can also be activated from the MicroStation drop down menu  
TDOT > Text Parameters by Active Scale  
or by using the keyin  
vba run [SetTextParametersAS]Settext.main    
Special Requirements: 
Make MicroStation element symbology settings manually or with pprogram, Text Styles Plus, 
which will set the appropriate level and color for the text. 
Usage: 
Step 1. In D&C manager activate Set Text. The Set Text Parameters by Active Scale 

dialog appears. The Scale value is read from the active scale currently set in the 
design file. 

 
Step 2. Set Scale to an alternate value if needed. If changed this will reset the active scale in 

the file. This should be set to the scale at which the text graphics are to be 
plotted. 

Step 3. Choose the Plot Text Size desired from the standard text size list. Text parameters 
are immediately set in the file based on the dialog settings. Any MicroStation text 
command can now be used to place text. 

 

When text parameters are manually altered, the Reset Size command button can be 
clicked to reset all text parameters for the current selection on the dialog. 
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Measure Area & Annotate 
D&C location: Drafting Standards > Tools > AnnotateArea 
MicroStation VBA Program: MeasureAreaandAnnotate.mvba 
Description: 
This program places text reflecting the most recent values generated by the measure area 
command. Area text is given in square feet & acres for English files and in metric files it is given 
in square meters, square feet, hectares & acres. The current active scale is shown with a keyin 
field to reset as needed. Scale is used to control the text size. 

For the user's convenience, a command button is provided for MicroStation's Measure Area 
command. If other commands are used after the initial start of this program the user can use this 
command button to go back to measuring areas. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Tools > Measure Area & Annotate  
or by using the keyin  
vba run [MeasureAreaandAnnotate]AnnotateArea.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate AnnotateArea. When the command is first started 

MicroStation's Measure Area command is invoked and the Measure Area & 
Annotate dialog is displayed. Measure any area as needed. 

 
Step 2. In the Measure Area & Annotate dialog check the scale and then click on the Place 

Area Text command button. The area text will appear on your cursor and you are 
prompted to Identify Location to place the text. 

 
After this point is given the Measure Area command is re-started so that the user can 
measure another area. 
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Move Raster by Datum Adjustment Factor 
D&C location: Drafting Standards > Tools > Move Raster 
MicroStation Basic Program: moveraster.ba 
Description: 
This application moves the active raster attachment by a user given datum adjustment factor.  

Raster images which are geo-referenced to the Tennessee state plane coordinates will come near 
our projects but due to the datum adjustment factor on coordinates they will usually be off some. 
This program will take that value and move the raster attachment to align properly with project 
data.  

This macro can also be activated from the MicroStation drop down menu  
TDOT > Raster – Move by Datum Adjust  
or by using the keyin  
macro moveraster.  

Special Requirements: 
Raster Manager must be open with the raster image to be moved highlighted in the dialog. 

Usage: 

Step 1. In MicroStation activate File>Raster Manager. Highlight the attachment to be 
moved. 

 

Step 2. In D&C manager activate Move Raster. Keyin the datum adjustment factor for the 
project area. Once that is set click on Go Move Raster. 
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Step 3. The user is then prompted to Identify any point near project.  

Data point in the project area and the raster attachment is moved to overlay the 
project data correctly. 
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Change Line Style Scale 
D&C location: Drafting Standards > Tools > Scale LineStyle 
MicroStation VBA Program: ChangeLinestyleScale.mvba 
Description: 
This program is used to change the line style scale on existing lines that have a custom line style 
applied on them. The current active scale is read at program start up and is shown in a keyin 
field. This value which can be set as needed by the user is used to build the keyin to change the 
line style scale. After setting the scale desired the user can immediately apply by identifying an 
element or accepting the fence contents if a fence is active. Active selection sets are 
automatically updated to the new scale.  
A command button is provided to restart the command with the current specified scale after 
using other MicroStation commands. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Custom Line Styles > Change Line Style Scale  
or by using the keyin  
vba run [ChangeLinestyleScale]ChangeLSscale.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Scale LineStyle. The Change Line Style Scale dialog 

appears. The current active scale is applied in the dialog. 

 
Step 2. Check and reset the scale as needed. Data Point on any element to reset its scale. 
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Step 3. Data point to accept the element and it is scaled to the given value. 

 
Step 4. To process multiple elements, place a fence around them or add them to a selection 

set. Click on the Change Line Style Scale command button. Selection sets are 
immediately processed. If using a fence, the user is prompted to accept the fence 
contents, data point to start fence processing. 

 

After changing the scale on custom line styles, it may be necessary to use the Shift 
Line Style Pattern tool to improve appearance of the line work. 
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Draw Plot Border 
D&C location: Drafting Standards > Tools > Plot Border 
MicroStation VBA Program: DrawPlotBorder.mvba 
Description: 
This program sets symbology, etc. and provides a tool for users to draw plot border shapes on 
plans sheets. This is intended for use on older jobs where sheets were used that did not include 
plot shapes as they do now. These plot shapes make it possible to use batch plotting without 
having to open the individual files to plot the sheets. A Plot Border Type option is provided to 
place either standard or PDF plot border shapes.  
An Open DGN command button is provided to go to the File Open dialog so that the user can 
jump to the next sheet file. 
This tool is not intended for use on cross sections. Instead, use the Place & Annotate XS Sheets 
tool to place cross section plot borders in a batch mode. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Tools > Draw Plot Border  
or by using the keyin  
vba run [DrawPlotBorder]PlotBorder.Main 

Special Requirements: 

Old non-cross section DGN sheet files that need plot borders so that batch plotting can be used. 

Usage: 

Step 1. In D&C manager activate Plot Border. The Draw Plot Border dialog appears.  

 
Step 2. Check and reset the Plot Border Type option as needed to place either a standard or 

PDF plot border shape. 
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Step 3. Click on the Draw Plot Shape command button to start placement. The user is 
prompted to Identify 1st Corner  

For standard plot shapes, snap and data point at one of the plot area snap points. . 

 
Step 4. The shape is displayed dynamically and the user is then prompted to Identify 

Opposite Corner.  

For standard plot shapes, snap and data point at the plot area snap point at the 
opposite corner of the sheet. The plot shape is drawn into the file. 

 

 34



The plot shapes go on level DESIGN - SHEET - Plot Shape so that level must be on 
to see them after placement. This level does not need to be turned on to be 
recognized for batch plotting. 

Step 5. Click the Open DGN command button to jump to the next sheet file. 

PDF Plot Borders 

The only difference when placing PDF plot borders is where you snap to. For the first 
point you should snap to the upper left corner of the File Room data block as shown 
below. 

 

When prompted for the second point, snap to the lower right corner of the inside sheet 
border. 

 

Note:  
Use the Place & Annotate XS Sheets tool to place plot borders on cross section sheets. 
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Import Additional V8 Settings 
D&C location: Drafting Standards > Tools > V8 Import 
MicroStation VBA Program: V8_Import.mvba 
Description: 
This tool can be used in 2 workflows, for updating any V8 DGN file to current standards or to 
complete the conversion of V7 DGN files. After using MicroStation's Batch Converter for the 
initial conversion of V7 DGN files with levels 1-63 to V8, several additional settings need to 
made in order to make the files fully functional in V8.  
This program deletes all existing level filters, imports current levels & level filters, text styles, 
attaches the current color table and will update English working units to use Survey Feet in 
multiple DGN files in a batch mode.  
All levels, level filters & text styles are applied from TDOTmain.dgnlib.  
All files with DGN, MFC, 2D, 3D or SHT extensions from the open DGN file's folder are 
included in the file list. 
When processing metric DGN files, the option to update English working units to use Survey 
Feet is ignored even if this option is clicked on since it is not required in those files. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > V8 – Import Additional Settings 
or by using the keyin  
vba run [V8_Import]V8_ImportStart.main 

Special Requirements: 
MicroStation DGN file opened from the folder in which files which need to be updated reside. 
Usage: 

Step 1. Open a DGN file from the folder where files are to be processed. This can be one of 
the files to which you wish to import additional V8 settings. 

Step 2. In D&C manager activate V8 Import. When the command is first started the Import 
Additional V8 Settings dialog is displayed. 
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Step 3. Under  Import Options, choose which of the V8 additional settings are desired for 
import. By default levels, level filters & text styles are turned on. 

Step 4. Use standard selection methods to highlight the DGN files to be processed. Single 
click for one file, shift key with clicks at each end for groups of files or the control 
key with clicks to pick various files. To un-select a file hold the control key down and 
select it again.  

 

Step 5. When files to be processed have been selected, click on the Process Files command 
button to start the import of additional settings. Each file is opened and processed.  

Step 6. When finished a completion message is given. Click OK to dismiss the message.  

 

Step 7. Click on the Cancel button to dismiss the dialog.  
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Cross Sections 
Delete ALL Prop. XS Graphics 
D&C location: Drafting Standards >Cross Sections > Delete XSs 
MicroStation VBA Program: DeletePropXSectionGraphics.mvba 
Description: 
This program deletes all proposed cross section graphics by level name. When the program is 
executed, it records all levels currently shown in view 1, turns all levels off and then turns all 
proposed cross section levels on using their names. It then sets up a temporary fence and does a 
void delete on all graphics. Finally it restores the levels originally displayed in view 1.  

It does not matter if view 1 is on or not for this program to function. The file must contain 
standard TDOT Design Division cross section level names or it will fail. 

This macro can also be activated from the MicroStation drop down menu  
TDOT > Cross Sections > Delete ALL Prop. XS Graphics  
or by using the keyin  
vba run [DeletePropXSectionGraphics]CleanXS.main  

Special Requirements: 
MicroStation DGN file must contain standard TDOT Design Division cross section level names. 

Usage: 

Step 1. In D&C manager activate Delete XSs. Program immediately deletes all graphics from 
proposed cross section levels and then refreshes the view 1 display.  
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Delete ALL XS Grids 
D&C location: Drafting Standards > Cross Sections > Delete XS Grids 
MicroStation VBA Program: DeleteAllXSectionGrids.mvba 
Description: 
This program deletes all working cross section grids by level name. When the program is 
executed, it records all levels currently shown in view 1, turns all levels off and then turns all 
working cross section grid levels on using their names. It then sets up a temporary fence and 
does a void delete on all graphics. Finally it restores the levels originally displayed in view 1.  

It does not matter if view 1 is on or not for this program to function. The file must contain 
standard TDOT Design Division cross section level names or it will fail. 

This macro can also be activated from the MicroStation drop down menu  
TDOT > Cross Sections > Delete ALL XS Grids  
or by using the keyin  
vba run [DeleteAllXSectionGrids]CleanXSGrids.main  

Special Requirements: 
MicroStation DGN file must contain standard TDOT Design Division cross section level names. 

Usage: 

Step 1. In D&C manager activate Delete XS Grids. Program immediately deletes all 
graphics from working cross section grid levels and then refreshes the view 1 display.  
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Delete Earthwork Shapes 
D&C location: Drafting Standards > Cross Sections > Delete EW Shape 
MicroStation VBA Program: DeleteEarthworkShapes.mvba 
Description: 
This program deletes all earthwork shape graphics by level name. When the program is executed, 
it records all levels currently shown in view 1, turns all levels off and then turns the earthwork 
shape level on using its name. It then sets up a temporary fence and does a void delete on all 
graphics. Finally it restores the levels originally displayed in view 1. 

It does not matter if view 1 is on or not for this program to function. The file must contain 
standard TDOT Design Division cross section level names or it will fail. 

This macro can also be activated from the MicroStation drop down menu  
TDOT > Cross Sections > Delete Earthwork Shapes 
or by using the keyin  
vba run [DeleteEarthWorkShapes]CleanEarthWorkShapes.main  

Special Requirements: 
MicroStation DGN file must contain standard TDOT Design Division cross section level names. 

Usage: 

Step 1. In D&C manager activate Delete EW Shape. Program immediately deletes all 
graphics from level DESIGN - EARTHWORK – Shapes and then refreshes the view 
1 display.  

Calculate & Label Slope 
D&C location: Drafting Standards > Cross Sections >Slope Tool 
MicroStation VBA Program: SlopeCalculater.mvba 
Description: 
Calculates slopes based on 2 points and if desired will place a label for the slope. Slope is shown 
in the dialog in the 3 standard formats: cross slope, percent grade & side slope. Slope label 
graphics are placed at the current active level, symbology & text parameters. 
The Label Type option controls the format which is used when the Place Label command button 
is clicked. Includes an entry field for Profile Exaggeration to control how slopes are calculated 
when used on profiles. Command buttons are provided to access the Text Styles Plus & XS Text 
Styles Plus vba programs which will set the active level, symbology & text parameters.  . 

This program can also be activated from the MicroStation drop down menu  
TDOT >Cross Sections > Calculate & Label Slope  
or by using the keyin  
vba run [SlopeCalculater]SlopeToolStart.main 
Special Requirements: 
Set level, symbology and text size for label using Text Styles Plus, XS Text Styles Plus or 
manual methods. 
Usage: 
This tool has been described previously under Drafting Standards > Tools. See the description 
of usage at that location.  
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XS Text Styles Plus 
D&C location: Drafting Standards > Cross Sections > XS Textstyles+ 
MicroStation VBA Program: XSTextstylesPlus.mvba 
Description: 
This program activates cross section text styles and sets the active level, color and weight. The 
current active scale is shown with a keyin field to reset as needed. Scale is used to control the 
text size in conjunction with the standard size associated with the text style. 

Command buttons are provided to access vba programs to Set Alternate STD Text Size (Set Text 
Parameters by Active Scale) and Place Label with Leader Line. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Cross Sections > XS Text Styles Plus  
or by using the keyin  
vba run [XSTextstylesPlus]Textstyles.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate XS Textstyles+. The XS Text Styles Plus dialog appears. 

 
Step 2. Check and reset the scale as needed. Click on any text style description in the dialog 

list to activate the text style and set the appropriate active level, color and weight. 
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Update Project XS Criteria Files 
D&C location: Drafting Standards > Cross Sections > Update Criteria 
MicroStation VBA Program: UpdateProjectCriteriaFiles.mvba 
Description: 
This program is for use when new versions of cross section criteria files are downloaded from 
the web and project criteria files need to be updated. After downloading the new files to the 
standard criteria folder this program is used to copy the new versions to your project folder to 
replace/update individual criteria files or all as needed. 

The default criteria folder is determined by the setting for the MicroStation configuration 
variable GPK_MY_CRITERIADIR. 

This macro can also be activated from the MicroStation drop down menu  
TDOT > Cross Sections >  Update Project XS Criteria Files 
or by using the keyin  
vba run [UpdateProjectCriteriaFiles]UpdatetStart.main.  

Special Requirements: 
MicroStation DGN file opened from the folder in which criteria files which need to be updated 
reside.     . 

Usage: 

Step 1. Open a DGN file from the folder where criteria files are to be updated. 

Step 2. In D&C manager activate Update Criteria. When the command is first started the 
Update Project XS Criteria Files dialog is displayed. 
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Step 3. Use standard selection methods to highlight the criteria files to be processed.  Single 
click for one file, shift key with clicks at each end for groups of files or the control 
key with clicks to pick various files. To unselect a file hold the control key down and 
select it again. To update all criteria files click on the Select All command button.  

 

Step 4. When files to be updated have been selected, click on the Update Files command 
button. A file named UpdateCriteriaFiles.bat is created in the project folder with 
commands to copy the selected files from the default criteria folder to the project 
folder and then this batch file is processed. A DOS command window is briefly 
displayed during this process.  

Step 5. Click Cancel to dismiss the dialog.  
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Place & Annotate XS Sheets 
D&C location: Drafting Standards > Cross Sections > XS Sheets 
MicroStation VBA Program: PlaceandAnnotateXSsheets.mvba 
Description: 
This program places shared cross section sheet cells, plot borders and annotation as requested by 
the user on cross section sheets set up by Geopak. All graphics are optional.  
Graphics and annotation can be placed for either roadway or culvert cross section sheets. 
Individual parts of Project Data annotation are optional as well as placement on either line 1 or 2 
in the project data block. A title for roadway cross sections sheets can be keyed in or for culvert 
cross section sheets the standard sheet title cell can be placed. Plot scale defaults to current active 
scale and controls cell & text sizes.  
Separate graphic groups are set up for sheets, plot borders, project data annotation & title 
annotation to allow easy deletion and replacement as needed. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Cross Sections > Place and Annotate XS Sheets  
or by using the keyin  
vba run [PlaceandAnnotateXSsheets]XSsheets.main 
Special Requirements: 
Program is specifically set up to place graphics on cross section sheets set up by Geopak in 
stacks of 5 sheets with cross section grids spaced 60' vertically and 60' horizontally at a 10 scale. 
Usage: 
Step 1. In D&C manager activate XS Sheets. The Place & Annotate XS Sheets dialog 

appears. 

 

 44



Step 2. Fill in dialog:  
Pick type of cross sections, roadway or culvert  
Keyin the total number of sheets  
Adjust the plot scale if needed 
Set Start Point X & Y, either keyin the X & Y coordinates or set them graphically 
with  the DP button (first cross section sheet's origin point at lower left corner of 
inside border, same point given as the Sheet Placement Point in Geopak's Cross 
Section Sheet dialog.) 
Under Placement Control click on the graphics required: shared sheet cell, plot 
border and/or annotation. 
If annotation is requested… 

Click on the desired project data fields  
Keyin project data field values, sheet no. value is beginning sheet  number 
Pick option for project data location, line 1 or 2.  
If title annotation is desired  on lower right of sheet, click on the appropriate 
option and if annotating roadway cross sections key in a name in the field 
provided. 

Step 1. Once all control settings have been made, click on the Place Graphics command 
button and all requested graphics are placed. 

 
Often when cross section sheets are first set up the project number is not yet known. 
This additional text annotation can easily be added later with this program 
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Roadway Horizontal Alignments 
Place Horizontal Alignment Points 
D&C location: Drafting Standards > Roadway Horizontal Alignments > HA Points 
MicroStation VBA Program: HApoints.mvba 
Description: 
This program places the required point text symbols for all keypoints of any horizontal 
alignment/chain stored in the project GPK file in the plan view. The PI symbol (triangle) with 
short sub tangents are placed for all spiral-curve combinations or simple curves. The point on 
chain symbol (circle) is placed at the begin & end and at all on chain curve points. The PI 
symbol (triangle) by itself is placed at any break in tangent direction without a curve along the 
horizontal alignment. This is applicable to the following horizontal alignment types: Proposed 
Roadway Centerline, Preliminary Roadway Centerline, Existing Roadway Centerline, Proposed 
Special Ditch Centerline, Existing Stream Baseline, Functional Roadway Centerline, Proposed 
Private Drive Centerline. 
All graphics are placed in a single graphic group for easy deletion as needed. 
This tool stores the current location of the dialog, GPK job number, chain name and horizontal 
alignment type in the file C:\Temp\MVBA_FormStorage.log when the dialog is closed. When 
opened later it uses this information if applicable to bring up the dialog as you last used it. 
This program can also be activated from the MicroStation drop down menu at  
TDOT > Centerlines > Place Horizontal Alignment Points  
or by using the keyin  
vba run [HApoints]HApointsStart.main   
Special Requirements: 

Chains that are to be processed must be stored in a Geopak GPK file in the folder where the 
MicroStation DGN file resides.  

The ID Chain function uses a special VBA reference to program GetCogoElement.mvba which 
was provided by Bentley and must be present with the program for it to function. 

Usage: 

Step 1. In D&C manager activate HA Points. The Place Horizontal Alignment Points 
dialog is displayed. 

All Geopak jobs found within the current active folder are listed in the Job drop down 
box.  If this tool was used previously for that job, the last chain processed is set as 
well as the last horizontal alignment type which was used.  Scale defaults to active 
scale set in the MicroStation DGN file. 
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Step 2. After selecting the Geopak Job number as needed, the Chain drop down is populated 
with all chains stored in the job.  Select the chain to place point symbols for.  If you 
do not know the chain name but have chain graphics, the ID button can be used to 
select the chain.  

Step 3. Set the Type by clicking on one of the Roadway Centerline options in the drop 
down list provided. This setting controls the level, symbology, etc. for the point 
symbols which are to be placed. 

 

If this tool was used previously, the last horizontal alignment type which was used is 
set automatically when the tool is activated. 

Step 4. Reset the Scale if needed and click the Place Points command button. Point symbols 
are displayed for the specified chain. 

Step 5. If you need to place point symbols for other chains, reset the chain name and click the 
Place Points command button for each one.  
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Centerline Cells 
D&C location: Drafting Standards > Roadway Horizontal Alignments > CL Cells 
MicroStation VBA Program: CenterlineCells.mvba 
Description: 
This program provides access to TDOT Design Division centerline cells. 

A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Centerlines > Cells 
or by using the keyin  
vba run [CenterlineCells]CLcells.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate CL Cells. The Centerline Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 

Any of these cell placement options can also be used in conjunction with Geopak’s 
DP Station/Offset tool to place the cell at a specific station and offset along the 
horizontal alignment. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Label Horizontal Alignment Intersections or Ends 
D&C location: Drafting Standards > Roadway Horizontal Alignments > HA Intersection 
MicroStation VBA Program: HA_IntersectLabel.mvba 
Description: 
This program labels horizontal alignment (chain) intersections in the plan view and includes an 
alternate dialog for labeling chain ends with station and coordinate values.  It includes a Type 
option which sets the graphics attributes & text sizes based on selection which include: Proposed 
Centerline, Preliminary Centerline, Existing Drainage, Existing Centerline & Scratch. .  
Terminator option sets the type of terminator to be displayed at end of leader line if desired.  
Also includes a coordinate decimals control to adjust the displayed accuracy of the coordinate 
values. The default is 4. The dialog has a preview window so that you can see how the label will 
appear when placed. 

For the Label Intersections dialog view, the mainline chain and intersecting chain drop-downs 
are populated based on chains stored in the GPK file.  Text boxes display chain name and 
intersecting station for each chain and can be modified within each text box. If multiple 
intersections are found a Select Intersection Number control is displayed so that the user can pick 
the correct one to be labeled. 
For the Label Chain Ends dialog view, all visible controls described above behave the same.  The 
option buttons indicate which end of the chain is to be used to generate text displayed in the label 
and it's location 
This program can also be activated from the MicroStation drop down menu  
TDOT > Centerlines > HA Intersection Labeler 
or by using the keyin  
vba run [HA_IntersectLabel]modMain.main 
Special Requirements: 
None. 
Label Intersections Usage: 
Step 1. In D&C manager activate HA Intersection. The Label Intersections dialog appears. 

 
Set the GPK Job and Mainline Chain you wish to label an intersection on. 
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Step 2. Set Scale and choose the Type of alignment being labeled. These settings control 
level, symbology and text sizes used for the label. 

 
Step 2. Set the Intersecting Chain for the label. Chain names are used by default in the label 

text but these can be edited as desired in the Text fields provided. Click the Label 
command button and the user is prompted to Data Point to Accept/Reset to Exit. 
Data point to place the label at the desired location. 

 
If more than one intersection is found for the chain then an option is provided to Select 
Intersection Number. Pick the  intersection number from the option box provided. 
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label Ends Usage: 
Step 1. At the bottom left of the Label Intersections dialog, click the Chain Ends Dialog 

command button and the dialog switches to Label Chain Ends. 
Set Mainline Chain and Type as needed and choose End Location 1 or 2. 

 
Step 2. Click the Label command button and the user is prompted to Data Point to 

Accept/Reset to Exit. Data point to place the label at the desired location. 
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Roadway Vertical Alignments 
Label Vertical Alignment 
D&C location: Drafting Standards > Roadway Vertical Alignments > VA Labeler 
MicroStation/Geopak VBA Program: VA_Labeler.mvba 
Description: 
This program was designed to label pertinent vertical alignment information on the profile. The 
user has the ability to choose the options they would like to label by selecting the check box 
corresponding to the label.  Chain, reference datum, and scale information is attained when the 
user selects the Geopak profile cell.   
Only profiles applicable to the identified Geopak profile cell are offered for labeling.  
Type option allows for application for roadways, private drives or special ditches. The type 
controls text sizes, orientation and symbology. 
A Maximum Speed Label keyin field is provided. When set, all curves exceeding the given 
speed are labeled with the speed and a “+”. Any vertical curves where the speed is less than this 
value will also display a warning message as well. 
Program is set up for use on English or Metric projects 

This program can also be activated from the MicroStation drop down menu  
TDOT > Profiles >  Vertical Alignment Labeler 
or by using the keyin  
vba run [VA_Labeler]modStartUp.label_VApts 
Special Requirements: 
A Geopak profile cell must be present.  
K value text file, VALabel_Speed_kvl.txt must be present in TDOT Design Division’s 
GeopakStandards folder at  C:\Program Files\GeopakStandards\.  

Usage: 
Step 1. In D&C manager activate VA Labeler. The 

Label Vertical Alignment dialog is opened. By 
default the type is set to Roadway. 
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Step 2. Click on the Identify Profile Cell command button and data point on the Geopak 
profile cell for the profile. The window shade button on the upper right of the dialog 
can be used to get the dialog out of the way as you identify the profile cell.  Just click 
it again to re-expand the dialog after identifying the cell. 

Note: 
After reading the profile cell and populating the Profile Settings at the top of the 
dialog, the GPK file is read for all profiles/vertical alignments applicable for display 
on this profile and fills the profile list box 

Step 3. Scroll through the Profile list and choose the vertical alignment that you wish to 
annotate. 

Step 4. Set the Scale value as needed. The current active scale is read when the program is 
started to fill in this field automatically. Scale controls text sizes & label offsets. 

Step 5. Finally the label options can be adjusted as needed. The type of profile to be labeled 
determines which default options are turned on. Key in a Maximum Speed value in 
the keyin field which is provided to control speed labels placed with vertical curve 
information. 
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Step 5. Now that all control values are set, click on the Place Labels command button and 
the vertical alignment is annotated. Review the annotation graphics and click the red 
X to close the dialog. 

 

Label Intersections Usage: 

Step 1. In the Label Vertical Alignment dialog, click on the Label Intersections command 
button.  The Label Vertical Alignment dialog is minimized and the Intersect 
Alignments dialog is opened.  

 

The drop down chain selection list is automatically populated with all chains that 
intersect the mainline chain whose profile is being annotated. 
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Step 2. Select the desired chain from the drop down list and then click the Add button on the 
right side of the dialog. Add additional chains as needed and then click Apply to 
annotate the intersection on the profile. 

 

By clicking the User Defined command button at the bottom you can add your own 
station locations with titles for intersections to be labeled. The Save & Open buttons 
at the bottom can be used to save these custom locations and recall them later. 
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Calculate & Label Slope 
D&C location: Drafting Standards > Roadway Vertical Alignments >Slope Tool 
MicroStation VBA Program: SlopeCalculater.mvba 
Description: 
Calculates slopes based on 2 points and if desired will place a label for the slope. Slope is shown 
in the dialog in the 3 standard formats: cross slope, percent grade & side slope. Slope label 
graphics are placed at the current active level, symbology & text parameters. 
The Label Type option controls the format which is used when the Place Label command button 
is clicked. Includes an entry field for Profile Exaggeration to control how slopes are calculated 
when used on profiles. Command buttons are provided to access the Text Styles Plus & XS Text 
Styles Plus vba programs which will set the active level, symbology & text parameters.  . 

This program can also be activated from the MicroStation drop down menu  
TDOT >Tools > Calculate & Label Slope  
or by using the keyin  
vba run [SlopeCalculater]SlopeToolStart.main 
Special Requirements: 
Set level, symbology and text size for label using Text Styles Plus, XS Text Styles Plus or 
manual methods. 
Usage: 
This tool has been described previously under Drafting Standards > Tools. See the description 
of usage at that location.  
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Vertical Curve Design Tool 
D&C location: Drafting Standards > Roadway Vertical Alignments > VC Design Tool 
MicroStation/Geopak VBA Program: VerticalCurveDesign.mvba 
Description: 
This program is set up to be used to design or check  vertical curves for roadways. Entrance and 
exit grades for the vertical curve can be keyed in or identified graphically. They must be 
identified graphically for visual vertical curve displays. Command buttons are provided to 
identify these lines together or individually as needed. After the grades are set, one of 3 Design 
Controls must be set, length, K value or design speed. Then click on the Calculate Curve 
command button and the unknown design values are computed, shown in the dialog and the 
curve is temporarily visualized in graphics.  
If desired, the curve can be drawn in permanently by clicking the Draw Curve command button. 
Curve graphics include the curve and circle point text symbols at the VPC, VPI & VPT. All 
graphics are joined as a graphic group. Current active level and element symbology are used for 
permanent curve displays. The current active scale controls the size of the point symbols. 
Options are provided for the use of either RD or RD01 vertical curve design standards which are 
read from the text file VALabel_Speed_kvl.txt. 
 A key in field is provided to enter the profile vertical exaggeration factor. This value defaults to 
the standard 10 times exaggeration but can be reset as needed. This controls grade values that are 
computed from graphics and how the vertical curve will appear on the profile. 
Program is set up for use on English or Metric projects 

This program can also be activated from the MicroStation drop down menu  
TDOT > Profiles >  Vertical Curve Design Tool 
or by using the keyin  
vba run [VerticalCurveDesign]VCDesign.main 
Special Requirements: 
K value text file, VALabel_Speed_kvl.txt must be present in TDOT Design Division’s 
GeopakStandards folder at  C:\Program Files\GeopakStandards\.  

Usage: 
Step 1. In D&C manager activate VC Design Tool. The Vertical Curve Design Tool dialog 

is opened.  
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Step 2. Click the Identify Entrance & Exit Grade Elements button and you are prompted 
to Identify Entrance Element. Data point on the line or line string segment for the 
entrance grade. When the entrance element is highlighted, data point to accept.  The 
entrance grade is calculated from the element and is shown in the dialog. The user is 
then prompted to Identify Exit Element. Repeat these actions to set the exit grade. 

 

Individual ID buttons are provided so that you can reset either the entrance or exit 
grades separately.  

The entrance and exit grades can be keyed in manually but no visualization of the 
designed vertical curve is possible when the tool is used in this way. 

Step 3. If your profile uses an alternate Profile Vertical Exaggeration than the default 10 
value (1”=50’ Horiz./1”=5’ Vert.) , then reset that value at the upper right of the 
dialog. 
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Step 4. Set the desired design control value, Length, K Value or Design Speed. If you are 
designing a vertical curve for the first time you may wish to start with the Design 
Speed. In this example we are checking a vertical curve design so we will just key in 
the Length of the vertical curve which has been proposed. 

Step 5. Click the Calculate Curve button. The grades and the design control value are used 
to calculate the other vertical curve design values which are filled in on the dialog. If 
the grades were entered by identifying graphical elements the curve is temporarily 
visualized. 

 
If your project uses the older RD design standards then click the RD option between 
the K Value & Design Speed controls prior to calculating the vertical curve. By 
default the RD01 standards are used. 

Step 6. If desired, the curve can be drawn in permanently by clicking the Draw Curve 
button. Curve graphics include the curve and circle point text symbols at the VPC, 
VPI & VPT. Current active level and element symbology are used for permanent 
curve displays. The current active scale controls the size of the point symbols. 
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Exist. Profiles 
Draw Profile Grid 
D&C location: Drafting Standards > Exist. Profiles > Profile Grid 
MicroStation VBA Program: DrawProfileGrid.mvba 
Description: 
This program draws a profile grid for any profile area, based on control values provided by the 
user. A dialog is provided for entry of Horizontal & Vertical Scale, Minimum & Maximum 
Elevation  and Beginning & Ending Station. 
All graphics for the profile grid are combined in a graphic group for easy movement or deletion 
as needed. 
Program is set up for use on English or Metric projects 

This program can also be activated from the MicroStation drop down menu  
TDOT > Profiles >  Draw Profile Grid  
or by using the keyin  
vba run [DrawProfileGrid]DrawGrid.main 
Special Requirements: 
Profile's lower left reference origin location must be visible. This is the location which 
corresponds to the minimum elevation and beginning station of the desired profile grid. 

Usage: 

Step 1. Set your view so that the lower left reference origin location of the profile area is 
visible. 

Step 2. In D&C manager activate Profile Grid. The Draw Profile Grid dialog opens. The 
current active scale is read from the DGN file to set the Horizontal Scale & Vertical 
Scale.  

 

Adjust the scale values if needed, enter Minimum and Maximum Elevation and 
Beginning & Ending Station. 
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Step 3. When all control values have been set, click on the Draw Profile Grid command 
button. 

You are prompted to Data Point at Profile Origin. The profile grid range is shown 
dynamically. If the profile coverage is not acceptable, you may give a Reset to stop 
and adjust the control values. 

 

Step 4. Data point at the lower left reference origin location of the profile area. 

The program generates the profile grid based on your given control values on level 
DESIGN - SHEET - Light Grid. Annotation is placed on level DESIGN - SHEET - 
Corner Text. 
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Draw Benchmark on Profile 
D&C location: Drafting Standards > Exist. Profiles > BMonPro 
Geopak 3PC Program: bmonpro.x 
Description: 
Draws and labels benchmarks and control points with annotation from plan view on to profile. 
Used by Survey personnel. 

Special Requirements: 
All graphics must be in a MicroStation selection set prior to running the program and a Geopak 
profile cell must be present. This must be a 3D MicroStation DGN file since the tool reads the 
graphics for elevation values. 

If a benchmark or control point is not within the limit of the horizontal alignment the program 
will generate an error file noting those.  

After running the program check the elevation on the profile text.  At this time remove any 
points from the profile that you do not want shown there. 

Usage: 

Step 1. Using MicroStation's Selection Set tool add all plan view graphics to a selection set. 

Step 2. In D&C manager activate BMonPro. The initial warning message is displayed, Click 
OK to go on. 

 

Step 3. You are then prompted for a job no. Key that in and click OK. 

 
 

Step 4. You are then prompted for the chain name. Key that in and click OK. 
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Step 5. If errors are encountered then an error log file named bmonpro.log is created and the 
user is notified with a message prompt.  Click on OK to dismiss this message. 

 

Step 6. If an error log was generated use any ASCII text editor to review errors. Make 
corrections in plan view graphics as needed and reprocess.  

You do not have to re-do the entire project. This can be done on localized areas by 
limiting the plan view graphics which are placed in the selection set prior to 
activating the 3PC program. 

Step 7. If no benchmarks are found then a message is given indicating that situation 
otherwise the final completion message is given. Click on OK to dismiss this 
message. 

 

Step 8. Edit/check text on profile as needed to indicate the correct elevation. Any points 
which are not desired on the profile should be deleted. 
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Draw Exist. SA/ST System on Profile 
D&C location: Drafting Standards > Exist. Profiles > Utilities > Ex SA/ST System 
Geopak 3PC Program: draw_cb.x 
Description: 
Draws existing storm and sanitary sewer catch basins, drop inlets & manholes as well as 
connecting pipes on profile using plan view graphics. Includes annotation of structures and 
pipes. Produces error log for missing data, etc. Used by Survey personnel. 

Special Requirements: 
All graphics must be in a MicroStation selection set prior to running the program and a Geopak 
profile cell must be present. This must be a 3D MicroStation DGN file since the tool reads the 
graphics for elevation values. 

The use of this application requires that field data be collected in a certain manner.  Please note 
that some data can be added or corrected in the office if the field crew does not take all shots 
required for the 3PC program to run. 

When a point is set in the field and coded:  XCB, XDI, XMHSTS or XMHSAS this sets the top 
invert of the structure.   At this time another point is set using XBOT code and the elevation is 
adjusted to the bottom invert of the structure. 

For pipe coding all pipes need a FROM / TO field shot, using ?STS or ?SAS.  Doing this will 
place the correct custom line style for the existing pipe and place an XINV cell at each end of all 
runs of pipe.  

If there is a run of pipe that begins or ends outside the limits of the horizontal alignment this run 
of pipe needs to be adjusted in the office by placing a XINV cell on the pipe run within the limit 
of the alignment and setting a break in the existing pipe line at that location. To get this done:   

1. On level DESIGN - SCRATCH - User 1 draw a MicroStation line crossing the existing 
run of pipe within the alignment. 

2. Draw another MicroStation line from exist. invert to exist. invert on the existing pipe. 

3. Temporarily turn off the level of the existing pipe. 

4. Using MicroStation extend to intersection the second line drawn with the first line placed. 

5. Place a XINV cell at the new end of this line.   

6. Delete the two lines that you placed to locate the new XINV cell.   

7. Turn the level of the existing pipe back on 

8. Add a break in the existing pipe line at the location of the new XINV cell just placed 
using MicroStation partial delete snapping to the cell location each time to make a zero 
length break in the pipe line. 
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Usage: 

Step 1. Using MicroStation's Selection Set tool add all plan view graphics to a selection set. 

Step 2. In D&C manager activate Ex SA/ST System. The initial warning message is 
displayed, Click OK to go on. 

 

Step 3. You are then prompted for a job no. Key that in and click OK. 

 
 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

 
 

Step 5. If errors are encountered then an error log file named draw_cb.log is created and the 
user is notified with a message prompt.  Click on OK to dismiss this message. 
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Step 6. If an error log was generated use any ASCII text editor to review errors. Make 
corrections in plan view graphics as needed, delete any invalid graphics placed 
previously on the profile and reprocess.  

You do not have to re-do the entire project. This can be done on localized areas by 
limiting the plan view graphics which are placed in the selection set prior to 
activating the 3PC program. 

Step 7. Edit or move text on profile as required. Add CB, MH and DI numbers if a table is 
used. 
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Draw OH Wire Crossings on Profile 
D&C location: Drafting Standards > Exist. Profiles > Utilities > OHonPro 
Geopak 3PC Program: ohonpro.x 
Description: 
Draws and labels low wire crossings with annotation from plan view on to profile. Used by 
Survey personnel. 

Special Requirements: 
All graphics must be in a MicroStation selection set prior to running the program and a Geopak 
profile cell must be present. This must be a 3D MicroStation DGN file since the tool reads the 
graphics for elevation values. 

The low wire crossing shot needs to be on the proposed centerline if it is not the program will not 
run.  After running the program the user must edit text annotation on the profile to list the 
temperature, crossing wire types and numbers located at each location. The elevation shown is 
for the lowest wire only. 

Usage: 

Step 1. Using MicroStation's Selection Set tool add all plan view graphics in View #1 to a 
selection set. 

Step 2. In D&C manager activate OHonPro. The initial warning message is displayed, Click 
OK to go on. 

 

Step 3. You are then prompted for a job no. Key that in and click OK. 

 
 

Step 4. You are then prompted for the chain name. Key that in and click OK. 
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Step 5. If errors are encountered then an error log file named OHonPRO.log is created and 
the user is notified with a message prompt.  Click on OK to dismiss this message. 

 

Step 6. If an error log was generated use any ASCII text editor to review errors. Make 
corrections in plan view graphics as needed, delete any invalid graphics placed 
previously on the profile and reprocess.  

You do not have to re-do the entire project. This can be done on localized areas by 
limiting the plan view graphics which are placed in the selection set prior to 
activating the 3PC program. 

Step 7. If no overhead wire crossings are found then a message is given indicating that 
situation otherwise the final completion message is given. Click on OK to dismiss 
this message. 

 

Step 8. Edit text on profile as needed to indicate the temperature, crossing wire types and 
numbers at each crossing location. 
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Draw & Label Existing Pipes from GPK 
D&C location: Drafting Standards > Exist. Profiles > Drainage> Profile ExPipes 
MicroStation VBA Program: ExistingPipeProfileLabeler.mvba 
Description: 
Draws and labels existing pipes on the profile.  Chain,  reference datum, and scale information is 
attained when the user selects the Geopak profile cell. Scale controls text sizes that are used. 
When the Apply command button is clicked the GPK file is scanned for all existing pipe features 
and any that intersect the specified chain are drawn and labeled on the profile based on the 
information found in the GPK file. 

This program can also be activated by using the keyin  
vba run [ExistingPipeProfileLabeler]modMain.Exist_ProfileLabelMain 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Profile ExPipes. The Draw & Label Existing Pipes 

dialog appears. 

 
Step 2. Click on the Identify Profile Cell command button and data point on the Geopak 

profile cell for the profile. The window shade button on the upper right of the dialog 
can be used to get the dialog out of the way as you identify the profile cell.  Just click 
it again to re-expand the dialog after identifying the cell. 
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Step 3. Adjust scale if needed in the Label Scale text entry field. Click on the Apply 
command button.  

The GPK file is read and all PIPE features which cross the chain are located, plotted 
and annotated on the profile. 

 

If a pipe is found that does not include the size in its description then the user is 
prompted for the size. 
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Draw Exist. SA/ST System on Profile 
D&C location: Drafting Standards > Exist. Profiles > Drainage> Ex SA/ST System 
Geopak 3PC Program: draw_cb.x 
Description: 
Draws existing storm and sanitary sewer catch basins, drop inlets & manholes as well as 
connecting pipes on profile using plan view graphics. Includes annotation of structures and 
pipes. Produces error log for missing data, etc. Used by Survey personnel. 

Special Requirements: 
All graphics must be in a MicroStation selection set prior to running the program and a Geopak 
profile cell must be present. This must be a 3D MicroStation DGN file since the tool reads the 
graphics for elevation values. 

The use of this application requires that field data be collected in a certain manner.  Please note 
that some data can be added or corrected in the office if the field crew does not take all shots 
required for the 3PC program to run. 

When a point is set in the field and coded:  XCB, XDI, XMHSTS or XMHSAS this sets the top 
invert of the structure.   At this time another point is set using XBOT code and the elevation is 
adjusted to the bottom invert of the structure. 

For pipe coding all pipes need a FROM / TO field shot, using ?STS or ?SAS.  Doing this will 
place the correct custom line style for the existing pipe and place an XINV cell at each end of all 
runs of pipe.  

If there is a run of pipe that begins or ends outside the limits of the horizontal alignment this run 
of pipe needs to be adjusted in the office by placing a XINV cell on the pipe run within the limit 
of the alignment and setting a break in the existing pipe line at that location. To get this done:   

1. On level DESIGN - SCRATCH - User 1 draw a MicroStation line crossing the existing 
run of pipe within the alignment. 

2. Draw another MicroStation line from exist. invert to exist. invert on the existing pipe. 

3. Temporarily turn off the level of the existing pipe. 

4. Using MicroStation extend to intersection the second line drawn with the first line placed. 

5. Place a XINV cell at the new end of this line.   

6. Delete the two lines that you placed to locate the new XINV cell.   

7. Turn the level of the existing pipe back on 

8. Add a break in the existing pipe line at the location of the new XINV cell just placed 
using MicroStation partial delete snapping to the cell location each time to make a zero 
length break in the pipe line. 

Usage: 
This tool has been described previously under Drafting Standards > Exist. Profiles > Utilities. 
See the description of usage at that location.  
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Draw Exist. Pipe(s) on Profile by Center Flow Point 
D&C location: Drafting Standards > Exist. Profiles > Drainage> Profile Pipe Ex 
MicroStation Basic Program: drawEXpipeprofile.ba 
Description: 
This application is used to draw a existing pipe(s) on a profile. Drainage structure graphics and 
annotation are added to 2 separate graphic groups  to aide in moving or deleting. 

This program can also be activated by using the keyin  
macro drawEXpipeprofile 

Special Requirements: 
The center flow line point of the pipe(s) must be located in graphics prior to running the 
application.  
Usage: 
Step 1. Establish the center flow line point of the pipe(s). This may be located with 

MicroStation tools or with Geopak's  Vertical Alignment Generator and it's Issue 
Data Point tool.  

Step 2. In D&C manager activate Profile Pipe Ex. The Draw Exist. Pipe(s) on Profile by 
Center Flow Point dialog opens. Defaults which are displayed . .Number of Pipes 1, 
Space between Pipes 12 inches, Skew Angle 90, Vertical Exaggeration 10, Label 
Control - Scale (Current Active Scale) & Label Control - Type CMP. Note that 
skew angles in degrees minutes & seconds are supported. 

 
Pipe Size - Width is optional and is provided so that horizontal & vertical oval pipes 
can be drawn as needed. 
Vertical Exaggeration should usually be 10 for profiles … 
(Example: 50 scale horiz. / 5 scale vert. = 10)  
It is provided for special profile cases and for the occasional need to draw on culvert 
sections which would use an exaggeration value of 1. 
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Step 3. Make settings in the dialog as needed for the pipe(s) you need to draw. In our 
example we are placing a 48" CMP at a 90 degree skew. Once settings are made click 
on the Draw Structure button. 

 

Step 4. You are then prompted to Identify Flow Line Location at Center. Snap and Data 
point at the flow line point. 
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Step 6. The pipe is drawn and the user is prompted to Identify location for Text Label. A 
Reset can be given to skip placement or Data point at location for the text to be 
placed.  

 

Since it is difficult to see small pipes on profiles when drawn at actual size, this 
program plots pipes at a minimum width of  42"(3.5') when the Vertical 
Exaggeration is greater than 1. The pipe height is always shown at actual size times 
the Vertical Exaggeration value. 

When text  annotation is placed, size, type & skew information is included. 
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Draw Exist. Box Culvert on Profile by Flow Point 
D&C location: Drafting Standards > Exist. Profiles > Drainage> Profile Box Ex 
MicroStation Basic Program: drawEXboxprofile.ba 
Description: 
This application is used to draw a existing box culvert or bridge on a profile. Drainage structure 
graphics and annotation are added to 2 separate graphic groups  to aide in moving or deleting.  

This program can also be activated by using the keyin  
macro drawEXboxprofile 

Special Requirements: 
The center flow line point of the structure must be located in graphics prior to running the 
application.  

Usage: 

Step 1. Establish the center flow line point of the structure. This may be located with 
MicroStation tools or with Geopak's  Vertical Alignment Generator and it's Issue 
Data Point tool.  

Step 2. In D&C manager activate Profile Box Ex. The Draw Exist. Box Culvert on Profile 
by Flow Point dialog opens. Defaults which are displayed . . . Number of Barrels 1, 
Outside Wall 8 inches, Inside Wall 8 inches, Top Slab 12 inches, Bottom slab 12 
inches, Skew Angle 90, Label Scale (Current Active Scale) & Vertical 
Exaggeration 10. Note that skew angles in degrees minutes & seconds are supported. 

 

Vertical Exaggeration should usually be 10 for profiles … 
(Example: 50 scale horiz. / 5 scale vert. = 10)  
It is provided for special profile cases and for the occasional need to draw on culvert 
sections which would use an exaggeration value of 1. 
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Step 3. Make settings in the dialog as needed for the structure you need to draw. In our 
example we are placing a 3 @ 10X8 structure at a 90 degree skew. It has an outside 
wall thickness of 8" and an inside wall thickness of 8" so we can use the defaults. The 
top slab thickness is 9" and the bottom slab thickness is 8" so we enter those.  Once 
settings are made click on the Draw Structure button. 

 

Step 4. You are then prompted to Identify Flow Line Location at Center. Snap and Data 
point at the flow line point. 
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Step 6. The structure is drawn and the user is prompted to Identify location for Text Label. 
A Reset can be given to skip placement or Data point at location for the text to be 
placed. 

 

When text  annotation is placed, size, type & skew information is included. 
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Draw Exist. Slab Culvert on Profile by Flow Point 
D&C location: Drafting Standards > Exist. Profiles > Profile Slab Ex 
MicroStation Basic Program: drawEXslabprofile.ba 
Description: 
This application is used to draw a existing slab culvert or bridge on a profile. Drainage structure 
graphics and annotation are added to 2 separate graphic groups  to aide in moving or deleting.  

This program can also be activated by using the keyin  
macro drawEXslabprofile 

Special Requirements: 
The center flow line point of the structure must be located in graphics prior to running the 
application.  

Usage: 

Step 1. Establish the center flow line point of the structure. This may be located with 
MicroStation tools or with Geopak's  Vertical Alignment Generator and it's Issue 
Data Point tool.  

Step 2. In D&C manager activate Profile Slab Ex. The Draw Exist. Slab Culvert on Profile 
by Flow Point dialog opens. Defaults which are displayed . . . Number of Barrels 1, 
Outside Wall 8 inches, Inside Wall 8 inches, Top Slab 12 inches, Footing slab 18 
inches, Skew Angle 90, Label Scale (Current Active Scale) & Vertical 
Exaggeration 10. Note that skew angles in degrees minutes & seconds are supported. 

 

Vertical Exaggeration should usually be 10 for profiles … 
(Example: 50 scale horiz. / 5 scale vert. = 10)  
It is provided for special profile cases and for the occasional need to draw on culvert 
sections which would use an exaggeration value of 1. 
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Step 3. Make settings in the dialog as needed for the structure you need to draw. In our 
example we are placing a 2 @ 14X10 structure at a 45 degree skew. The outside wall 
thickness is 8", inside wall thickness is 8" and the footing slab thickness is 18" so we 
can use the defaults. The top slab thickness is 11" so we enter that.  Once settings are 
made click on the Draw Structure button. 

 

Step 4. You are then prompted to Identify Flow Line Location at Center. Snap and Data 
point at the flow line point. 
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Step 6. The structure is drawn and the user is prompted to Identify location for Text Label. 
A Reset can be given to skip placement or Data point at location for the text  to be 
placed. Due to the 45 degree skew, structure widths are adjusted. 

 

When text  annotation is placed, size, type & skew information is included. 
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Survey Control 
Draw Control Point Table 
D&C location: Drafting Standards > Survey Control > Cntrl Pt Table 
Geopak 3PC Program: draw_contrl_pt_table.x 
Description: 
Builds control point table for placement in plan view. Used by Survey personnel. 

Special Requirements: 
All graphics must be in a MicroStation selection set prior to running the program. This must be a 
3D MicroStation DGN file since the tool reads the graphics for elevation values. 
If a benchmark or control point is not within the limit of the horizontal alignment the program 
will generate an error file noting those.  
After building the control point table with this program it is necessary to edit the data to show 
point numbers.  

Usage: 

Step 1. Using MicroStation's Selection Set tool add all plan view graphics to a selection set. 

Step 2. In D&C manager activate Cntrl Pt Table. You are prompted for a job no. Key that 
in and click OK. 

 

Step 3. You are then prompted for the chain name. Key that in and click OK. 

 

Step 4. You are then prompted for a Data point for the table location in the plan view area.  
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Step 5. If errors are encountered then an error log file named control_table.log is created and 
the user is notified with a message prompt.  Click on OK to dismiss this message. 

 

Step 6. If an error log was generated use any ASCII text editor to review errors. Make 
corrections in plan view graphics as needed and reprocess.  

Step 7. If no control points are found then a message is given indicating that situation 
otherwise the final completion message is given. Click on OK to dismiss this 
message. 

 

Step 8. Edit the control point data in the table to show point numbers. 
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Place Coordinate Grid Tick 
D&C location: Drafting Standards > Survey Control  > Coor Grid Tick 
MicroStation VBA Program: PlaceCoorGridTick.mvba 
Description: 
This program places a single coordinate grid tick with northing and easting coordinate 
annotation. All graphics are combined in a graphic group. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Topographic > Place Coordinate Grid Tick  
or by using the keyin  
vba run [PlaceCoorGridTick]GridTick.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Coor Grid Tick. When started the program goes 

immediately into a dynamic mode with the tick on the user's cursor. As the mouse is 
moved, coordinate information updates with tracking. 

 
 

Step 2. When the user gives a data point by mouse or via keyin, tick and annotation are 
placed at the location. Additional placements can then be made. Command remains 
active until another command is chosen. 
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Place Coordinate Grid Ticks by Range 
D&C location: Drafting Standards > Survey Control > Grid Tick Range 
MicroStation VBA Program: PlaceCoorGridTick.mvba 
Description: 
This program places coordinate grid ticks with northing and easting coordinate annotation based 
on a range and increment given by the user. All graphics are combined in a graphic group. Scale 
controls size of grid tick cells and text. 
Each placement of graphics are in a separate graphic group so the user can easily delete and 
replace as needed. 
For the user's convenience, the command button Place Grid Ticks is provided on the dialog to 
restart the command after the initial start of the program. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Topographic > Place Grid Ticks by Range 
or by using the keyin  
vba run [PlaceCoorGridTick]GridTickRange.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Grid Tick Range. The Grid Ticks by Range dialog 

appears. When started program immediately prompts user to Identify Beginning of 
Range for placing coordinate grid ticks. User should check scale & grid tick 
increment given in Grid Ticks by Range dialog and adjust as needed.  

 
Once settings are made, enter a data point at any corner of the range to which you 
wish apply coordinate grid ticks. 
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Step 3. The  user is then prompted to Identify End of Range. A rectangle is shown 
dynamically to illustrate the limits of the desired range. 

 
Step 4. After entering the second point, coordinate grid ticks and annotation are placed for 

the range. The user is again prompted for a beginning point for range in order to place 
additional graphics. 
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Prop. R.O.W. 
Pattern Loss of Access Area 
D&C location: Drafting Standards > Prop. R.O.W. > Loss of Access 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a loss of 
access area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns  
or by using the keyin  
vba run [AreaPatterns]LossOfAccess.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Loss of Access. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 

 

 86



Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Pattern Wetlands Mitigation Area 
D&C location: Drafting Standards > Prop. Easements > Wetlands Mit A 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a prop. 
wetlands mitigation ROW acquisition area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns  
or by using the keyin  
vba run [AreaPatterns]WetlandsMitigationArea.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Wetlands Mit A. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. This pattern is one of our most 
dense dot patterns but due to the size of the example area, it appears solid black when 
zoomed out.  
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Place Proposed ROW Flags 
D&C location: Drafting Standards > Prop. R.O.W. > ROW Flags 
Geopak 3PC Program: place_row_flags.x 
Description: 
This application reads a selection set of proposed R.O.W. lines and calculates & then places 
station and offset flags at each break and if desired R.O.W.  markers are placed as well.  

The prop. R.O.W. flags are placed at the alignment angle. To aide in the clean up of flag 
locations the text information and it's horizontal line form a single graphic group allowing them 
to be easily relocated with a single move command. The leader can then be modified to the new 
location of the horizontal line. MicroStation's Fence Stretch may be used to re-position flags in 
some cases where flag graphics can be fenced. 

Proposed R.O.W. marker types are determined based on the 45 degree rule. Any turn out greater 
than 45 degrees requires a C marker, any turn in greater than 45 degrees requires a B marker and 
all others are to be type A markers. The type is labeled with the marker. No marker is placed if 
there is no change in direction between R.O.W. lines. This is done to prevent placement at 
R.O.W. and property line intersections. 

A ROW marker and it's text label form a single graphic group to aide in clean-up if the marker is 
to be removed totally. Be sure to turn off graphic group lock prior to repositioning it's text label 
to avoid moving the marker. 

Complete documentation of all prop. R.O.W. procedures can be found in ProposedROW.pdf. 

Special Requirements: 
Proposed R.O.W. lines must be previously displayed using D&C manager and added to a 
MicroStation selection set.  

Selection set should contain any connected group of prop. R.O.W. lines that are referenced to a 
specified chain. 

Use of line strings or complex chains are not supported. 

Usage: 

Step 1. Display proposed R.O.W. lines using D&C manager. 

 Step 2. Add a connected group of proposed R.O.W. lines to a MicroStation selection set. 

Step 3. In D&C manager activate ROW Flags.  

Step 4. You are prompted for a job no. Key that in and click OK. 
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Step 5. You are then prompted for the chain name. Key that in and click OK. 

 

Step 6. Finally you are given an option to place prop. R.O.W. markers. Click OK to place 
them or Cancel to skip placement. 

 

Step 7. Station/Offset flags are placed at all locations along the prop. R.O.W. lines in the 
selection set. If requested prop. R.O.W. markers and their text labels are placed 
everywhere except at the beginning and end or at any location where there is no 
change in direction. Use MicroStation to re-position labels as needed for clarity in the 
plans. 
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Place ROW Marker 
D&C location: Drafting Standards > Prop. R.O.W. > ROW Marker 
Geopak 3PC Program: place_row_marker.x 
Description: 
This application reads a selection set of 2 adjoining proposed R.O.W. lines, calculates the angles 
between them & then  places the appropriate R.O.W. marker and labels it.   

Proposed R.O.W. marker types are determined based on the 45 degree rule. Any turn out greater 
than 45 degrees requires a C marker, any turn in greater than 45 degrees requires a B marker and 
all others are to be type A markers. The type is labeled with the marker.  

A ROW marker and it's text label form a single graphic group to aide in clean-up if the marker is 
to be removed totally. Be sure to turn off graphic group lock prior to repositioning it's text label 
to avoid moving the marker. 

Complete documentation of all prop. R.O.W. procedures can be found in ProposedROW.pdf. 

Special Requirements: 
Two adjoining proposed R.O.W. lines must be previously displayed using D&C manager and 
added to a MicroStation selection set.  

Use of line strings or complex chains are not supported. 

Usage: 

Step 1. Display proposed R.O.W. lines using D&C manager if needed. 

 Step 2. Create a MicroStation selection set of the two adjoining R.O.W. lines. They should be 
selected in a forward direction along the main roadway. Hold Ctrl down on the 
keyboard and data point on the lines in order as shown below. 

On the first intersection of the side road prop. R.O.W.  
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or on the other side  

 

Step 3. In D&C manager activate ROW Marker.  

Step 4. You are prompted for a job no. Key that in and click OK. 

 

Step 5. You are then prompted for the chain name. Key that in and click OK. 

 

Step 6. Angles between prop. R.O.W. lines are measured and the marker is placed. Use 
MicroStation to re-position label as needed for clarity in the plans. 
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Label Station / Offset 
D&C location: Drafting Standards > Prop. R.O.W. > StaOffsetLabel 
MicroStation VBA Program: StaOffLabel.mvba  
Description:  

This program places a station and offset label based on a data point, or a station and offset keyed 
in by the user.  Options include title text, line separating station and offset, leader line and choice 
of terminator including arrowheads or a dot.  The current active scale is shown with a keyin field 
to reset as needed. Scale is used to control the terminator cell scale when included.  Graphics are 
placed at the current active level, symbology & text parameters. All text and the divider line are 
combined in one graphic group and the leader and terminator combined in another. An ID button 
is provided for graphic selection of the chain to use.   

The most efficient use of this tool is in conjunction with the Text Styles Plus vba program which 
will set the active level, symbology & text parameters. A command button is provided to access 
this program.  

This tool can be used simply as a horizontal alignment tracking device with dynamic mode 
without placing labels. 

After using this tool, the job number  and chain name are remembered and will be used to 
populate those fields when the dialog is opened again as long as the previously defined job 
number is found in the current active folder.  

Metric application includes both metric & English measurements. 

This program can also be activated from the MicroStation drop down menu  
TDOT > R.O.W.> Label Station Offset 
or by using the keyin  
vba run [StaOffLabel]StationOffset.main 

Special Requirements:  

The ID Chain function uses a special VBA reference to program GetCogoElement.mvba which 
was provided by Bentley and must be present with the program for it to function. 

Chain that station and offset are measured from must be stored in a Geopak GPK file in the 
folder where the DGN file resides.  

Set level, symbology and text size for label using Text Styles Plus or manual methods prior to 
use. 

Usage: 
This tool has been described previously under Drafting Standards > Tools. See the description 
of usage at that location.  
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Place Bearing & Distance Label 
D&C location: Drafting Standards > Prop. R.O.W. > BearingDistance 
MicroStation VBA Program: DistanceBearingLabel.mvba 
Description: 
Calculates the bearing angle and distance from a line or line string segment and sets it up for 
placement as a label. Text can be placed at the angle of the line or it can be placed horizontal to 
the view with a leader line as a flag. Program will process line or line strings in complex strings. 
Graphics are placed at the current active level, symbology & text parameters.  
The most efficient use of this tool is in conjunction with the Text Styles Plus vba program which 
will set the active level, symbology & text parameters. A command button is provided to access 
this program. 
A command button is provided to Identify Element on the dialog to restart the command after the 
initial start of the program. The Place Label command button is provided so that the user can 
restart the label placement sequence when it is necessary to use alternate MicroStation 
commands prior to actual placement, such as going to Text Styles Plus to set symbologies.  
Metric application includes both metric & English measurements. 

This program can also be activated from the MicroStation drop down menu  
TDOT > R.O.W.> Label Bearing & Distance 
or by using the keyin  
vba run [DistanceBearingLabel]DistanceBearing.Main 
Special Requirements: 
Set level, symbology and text size for label using Text Styles Plus or manual methods. 
Usage: 
Step 1. In D&C manager activate BearingDistance. The Place Bearing & Distance Label 

dialog appears. When started program immediately prompts user to Identify Element 
for annotation.  

 
Step 2. Data point on the line element or segment of a line string or complex string that you 

wish to annotate with bearing & distance. 
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Step 3. After giving a point to accept the element selected, the dialog is populated with label 
information and the label text appears on the cursor. The user is prompted to Identify 
location for text.  

 

After the text location point is given, the text remains available for additional 
placements as needed. A reset will stop text placement and restart the tool. 

If the dialog is populated with label information but the user does something else such 
as setting symbologies, the Place Label command button can be used to go on and 
place that label afterwards. 

When other tools are accessed, the Identify Element command button can be clicked 
to restart the tool.  

Click option buttons on or off to place bearing or distance labels only.  
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Label placement with Leader line as a Flag: 
Step 1. With the Place Bearing & Distance Label dialog open, click on the option to Place 

Label as Flag and choose the Terminator Type (defaults to small arrow). Following 
prompts, Identify Element for annotation. 

This option is most often used when in tight places or when labeling short elements. 

Step 2. After giving a point to accept the element selected, the dialog is populated with label 
information and the user is prompted to Identify location for End of Leader.  

Data point on or near the element being labeled and you are prompted to Position 
Label . Movement of the cursor allows dynamic control of the leader line to the label 
text. 

 

After the label location point is given, the user is again prompted for the end of the 
leader point allowing for additional placements as needed. A reset will stop label 
placement and restart the tool. 
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Place Arc Radius & Length Label 
D&C location: Drafting Standards > Prop. R.O.W. > RadiusLength 
MicroStation VBA Program: ArcRadiusLengthLabel.mvba 
Description: 
Calculates the radius and length from an arc element and sets it up for placement as a label. Text 
can be placed at the angle of the tangent line at the point of identification or it can be placed 
horizontal to the view with a leader line as a flag. Program will process arcs in complex strings. 
Graphics are placed at the current active level, symbology & text parameters.  
The most efficient use of this tool is in conjunction with the Text Styles Plus vba program which 
will set the active level, symbology & text parameters. A command button is provided to access 
this program. 
A command button is provided to Identify Element on the dialog to restart the command after the 
initial start of the program. The Place Label command button is provided so that the user can 
restart the label placement sequence when it is necessary to use alternate MicroStation 
commands prior to actual placement, such as going to Text Styles Plus to set symbologies.  
Metric application includes both metric & English measurements. 

This program can also be activated from the MicroStation drop down menu  
TDOT > R.O.W.> Label Arc Radius & Length 
or by using the keyin  
vba run [ArcRadiusLengthLabel]LabelArc.Main 
Special Requirements: 
Set level, symbology and text size for label using Text Styles Plus or manual methods. 
Usage: 
Step 1. In D&C manager activate RadiusLength. The Place Arc Radius & Length Label 

dialog appears. When started program immediately prompts user to Identify Element 
for annotation.  

 
Step 2. Data point on the arc element or arc segment of a complex chain that you wish to 

annotate with radius & length. 
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Step 3. After giving a point to accept the element selected, the dialog is populated with label 
information and the label text appears on the cursor. The user is prompted to Identify 
location for text.  

 

After the text location point is given, the text remains available for additional 
placements as needed. A reset will stop text placement and restart the tool. 

If the dialog is populated with label information but the user does something else such 
as setting symbologies, the Place Label command button can be used to go on and 
place that label afterwards. 

When other tools are accessed, the Identify Element command button can be clicked 
to restart the tool.  

Click option buttons on or off to place radius or length labels only.  
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Label placement with Leader line as a Flag: 
Step 1. With the Place Arc Radius & Length Label dialog open, click on the option to 

Place Label as Flag and choose the Terminator Type (defaults to small arrow). 
Following prompts, Identify Element for annotation. 

This option is most often used when in tight places or when labeling short elements. 

Step 2. After giving a point to accept the element selected, the dialog is populated with label 
information and the user is prompted to Identify location for End of Leader.  

Data point on or near the element being labeled and you are prompted to Position 
Label . Movement of the cursor allows dynamic control of the leader line to the label 
text. 

 

After the label location point is given, the user is again prompted for the end of the 
leader point allowing for additional placements as needed. A reset will stop label 
placement and restart the tool. 
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Prop. Easements 
Pattern Slope Esmt. Area 
D&C location: Drafting Standards > Prop. Easements > Slope Esmt Area 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a prop. slope 
easement area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns  
or by using the keyin  
vba run [AreaPatterns]SlopeEasement.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Slope Esmt Area. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Pattern Drainage Esmt. Area 
D&C location: Drafting Standards > Prop. Easements > Drain Esmt Area 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a prop. 
drainage easement area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns  
or by using the keyin  
vba run [AreaPatterns]DrainEasement.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Drain Esmt Area. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 

 

 106



 

Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Points. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Points, the user is prompted to Enter shape vertex. 
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Step 4. The user continues to be prompted to Enter shape vertex until the minimum of 3 
points have been given. After that, you are prompted to Enter point or RESET to 
complete.  

 

After giving the reset to complete, the area is patterned. 
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Pattern Construction Esmt. Area 
D&C location: Drafting Standards > Prop. Easements > Const Esmt Area 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a prop. 
construction easement area and starts MicroStation's Pattern Area tool.  

This patterning is not required for construction easement for the purpose of slope 
construction. 

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns  
or by using the keyin  
vba run [AreaPatterns]ConstructionEasement.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Const Esmt Area. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Points. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Points, the user is prompted to Enter shape vertex. 
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Step 4. The user continues to be prompted to Enter shape vertex until the minimum of 3 
points have been given. After that, you are prompted to Enter point or RESET to 
complete.  

 

After giving the reset to complete, the area is patterned. 
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 Roadway Linework 
Draw Handicap Ramp 
D&C location: Drafting Standards > Roadway Linework > HC Ramp 
MicroStation VBA Program: DrawHandicapRamp.mvba  
Description:  
This program draws proposed handicap ramps in the plan view based on standard roadway 
drawings RP-H-3 to RP-H-9 and RP-R-2. Options in the dialog for type, location, ramp width, 
landing length, sidewalk width, grass separator width and roadway curb width are given to 
determine the handicap ramp dimensions. Additional check box controls are offered to match 
parallel ramps to the sidewalk width when greater than minimum, set perpendicular ramp landing 
beginning to the sidewalk when the grass separator width plus the curb width is greater than 
minimum of 8 feet and to place a leader line with text labels. As different types and locations are 
chosen, the default values and information on the dialog face are changed. If a control is not used 
for a given type or location then it is specified as N/A or non-applicable. 
The outer limits of all ramps are created as a shape using the handicap ramp line style so that 
later area calculations can be done with Geopak's D&C Manger quantity calculation tools. All 
handicap ramp graphics are combined into a graphic group. 
All English values have been converted so that this tool can also be used on metric projects. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Handicap Ramps  
or by using the keyin  
vba run [DrawHandicapRamp]HCRamp.main 
Special Requirements:  
Curb lines must be present in the DGN file. The center of the handicap ramp at the curb line 
must be located and marked for any locations that cannot be snapped to on the curb line. These 
locations would be such as within the radius but not at the radius midpoint or ends, along the 
roadway, concrete islands, concrete medians, splitter islands or bicycle ramps.   
Usage:  General Start 

Step 1. In D&C manager activate HC Ramp. The Draw Handicap Ramp dialog appears. 

 

Step 2. Adjust the values for Sidewalk Width, Grass Separator Width and Roadway Curb 
Width to match what is proposed in the area where you plan to place the proposed 
handicap ramp. The Sidewalk Width & Grass Separator Width should not include the 
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width of the curb. The Sidewalk Width & Grass Separator Width values are not used 
with concrete islands, concrete medians, splitter islands or bicycle ramps. 

By default, the option to Match Parallel Ramps to Sidewalk Width is turned on. If 
you are placing a parallel ramp and your sidewalk is 9’ wide or greater then you may 
wish to turn off this option. This will let the ramp be placed at the minimum distance 
of 5’ across the sidewalk.  

By default, the option to Set Perp. Landing Beginning to SW if > Min. is turned on. 
If you are placing a perpendicular ramp where the grass separator width plus the curb 
width is greater than the minimum of 8 feet for the slope up the ramp, this option will 
force the ramp landing beginning to start at the edge of the sidewalk.  

If it is crowded in the area where you will be placing the ramp’s type text label then 
you may wish to turn on the Include Leader Line with Text Label option. 

Depending on the handicap ramp type and location, the default values for Ramp Width & 
Ramp Landing Width as well as the steps required for placement will vary. Listed below are 
the additional steps the user goes through to place the various types\locations of proposed 
handicap ramps.  

Usage:  Perpendicular or Parallel at radius midpoint 
Step 3. Make your final settings on the dialog. Set the Ramp Type to Perpendicular or 

Parallel and the Ramp Location to Radius Midpoint.  

Adjust the values for Ramp Width & Ramp Landing Length as needed. Minimum 
values from the standard roadway drawings are specified by default. A notation of 
N/A indicates that the value is non-applicable for that ramp type. 

Step 4.  Click on the Draw Handicap Ramp command button. The user is prompted to 
Identify curb arc. Data point anywhere on the radius curb arc. Once identified, data 
point to accept. 
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When placing a handicap ramp at the radius midpoint, the program gets everything it 
needs for placement from the arc which was identified and the ramp is immediately 
drawn in.  

If a perpendicular handicap ramp is placed which goes beyond the back edge of the 
sidewalk then the following warning message is given. When this situation occurs, 
the program adds sidewalk lines at the back of the ramp for use in adjusting the 
sidewalk. To prevent this message from coming up every time you place a ramp, click 
on the option to disable it during the current session. 

 
Step 5.  The user is then prompted to Identify Location for placement of the handicap ramp 

type text label. Data point to place the label. If the option for a leader line was turned 
on then the user is also prompted to identify the begin and end locations for the 
leader. 

 
Step 6.  The final step for perpendicular handicap ramps would be to clean up the sidewalk 

lines on the inside if a grass separator is specified and on the outside if the ramp 
extends past the back of sidewalk.  Use regular MicroStation graphics commands to 
make these adjustments. 

             
  Narrow Sidewalk Example         Wide Sidewalk Example 
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Usage:  Perpendicular or Parallel within radius 
Step 3. Make your final settings on the dialog. Set the Ramp Type to Perpendicular or 

Parallel and the Ramp Location to Within Radius.   

This location option is for use on any radius where the preferred midpoint or radius 
end locations are not workable. You will need to locate the handicap ramp’s center 
point at the curb line prior to placing the ramp. 
Adjust the values for Ramp Width & Ramp Landing Length as needed. Minimum 
values from the standard roadway drawings are specified by default. A notation of 
N/A indicates that the value is non-applicable for that ramp type. 

Step 4.  Click on the Draw Handicap Ramp command button. The user is prompted to 
Identify curb arc. Data point anywhere on the radius curb arc. Once identified, data 
point to accept. 

 

Step 5.  The user is then prompted to Identify Point at Curb for Ramp Center. Snap and 
data point at the center location for the handicap ramp.  
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When the ramp center point is given, the handicap ramp is drawn in.  

 

If a perpendicular handicap ramp is placed which goes beyond the back edge of the 
sidewalk then a warning message is given. When this situation occurs, the program 
adds sidewalk lines at the back of the ramp for use in adjusting the sidewalk. To 
prevent this message from coming up every time you place a ramp, click on the 
option to disable it during the current session. 

Step 6.  The user is then prompted to Identify Location for placement of the handicap ramp 
type text label. Data point to place the label. If the option for a leader line was turned 
on then the user is also prompted to identify the begin and end locations for the 
leader. 

 

Step 7.  The final step for perpendicular handicap ramps would be to clean up the sidewalk 
lines on the inside if a grass separator is specified and on the outside if the ramp 
extends past the back of sidewalk.  Use regular MicroStation graphics commands to 
make these adjustments. 
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Usage:  Perpendicular or Parallel at radius end 
Step 3. Make your final settings on the dialog. Set the Ramp Type to Perpendicular or 

Parallel and the Ramp Location to Radius End.   

Adjust the values for Ramp Width & Ramp Landing Length as needed. Minimum 
values from the standard roadway drawings are specified by default. A notation of 
N/A indicates that the value is non-applicable for that ramp type. 

Step 4.  Click on the Draw Handicap Ramp command button. The user is prompted to 
Identify curb arc. Data point anywhere on the radius curb arc. Once identified, data 
point to accept. 

 

Step 5.  The user is then prompted to Identify curb element outside radius. Data point on 
the curb past the end of the radius arc. Once identified, data point to accept. 
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Step 6.  After identifying the curbs, the user is prompted to Snap to end of curb radius. Snap 
and data point at the radius end location for the handicap ramp.  

 

When the radius end point is given, the handicap ramp is drawn in.  

If a perpendicular handicap ramp is placed which goes beyond the back edge of the 
sidewalk then a warning message is given. When this situation occurs, the program 
adds sidewalk lines at the back of the ramp for use in adjusting the sidewalk. To 
prevent this message from coming up every time you place a ramp, click on the 
option to disable it during the current session. 

Step 7.  The user is then prompted to Identify Location for placement of the handicap ramp 
type text label. Data point to place the label. If the option for a leader line was turned 
on then the user is also prompted to identify the begin and end locations for the 
leader. 

 

Step 8.  The final step for perpendicular handicap ramps would be to clean up the sidewalk 
lines on the inside if a grass separator is specified and on the outside if the ramp 
extends past the back of sidewalk.  Use regular MicroStation graphics commands to 
make these adjustments. 
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Usage:  Perpendicular or Parallel along roadway 
Step 3. Make your final settings on the dialog. Set the Ramp Type to Perpendicular or 

Parallel and the Ramp Location to Along Roadway.   

This location option is for use at places such as “T” intersections where a handicap 
ramp needs to be placed along the roadway where no radius is present. You will need 
to locate the handicap ramp’s center point at the curb line prior to placing the 
ramp. 
Adjust the values for Ramp Width & Ramp Landing Length as needed. Minimum 
values from the standard roadway drawings are specified by default. A notation of 
N/A indicates that the value is non-applicable for that ramp type. 

Step 4.  Click on the Draw Handicap Ramp command button. The user is prompted to 
Identify curb element. Data point on the curb element near the location for the 
handicap ramp. Once identified, data point to accept. 

 

Step 5.  The user is then prompted to Identify Point at Curb for Ramp Center. Snap and 
data point at the center location for the handicap ramp.  
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Step 6.  After identifying the center point, the user is prompted to Identify side for 
placement. The handicap ramp is shown dynamically to help the user set the side 
where it should be placed. Data point to set the location.  

 

When the side point is given, the handicap ramp is drawn in.  

If a perpendicular handicap ramp is placed which goes beyond the back edge of the 
sidewalk then a warning message is given. When this situation occurs, the program 
adds sidewalk lines at the back of the ramp for use in adjusting the sidewalk. To 
prevent this message from coming up every time you place a ramp, click on the 
option to disable it during the current session. 

Step 7.  The user is then prompted to Identify Location for placement of the handicap ramp 
type text label. Data point to place the label. If the option for a leader line was turned 
on then the user is also prompted to identify the begin and end locations for the 
leader. 

 

Step 8.  The final step for perpendicular handicap ramps would be to clean up the sidewalk 
lines on the inside if a grass separator is specified and on the outside if the ramp 
extends past the back of sidewalk.  Use regular MicroStation graphics commands to 
make these adjustments. 
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Usage:  Concrete Island   
Step 3. Make your final settings on the dialog. Set the Ramp Location to Concrete Island. 

The Ramp Type setting is not applicable for this kind of handicap ramp and is noted 
as N/A.  

You will need to locate the handicap ramp’s center point at the curb line prior to 
placing the ramp. 
Adjust the value for Ramp Width as needed. Minimum values from the standard 
roadway drawings are specified by default.  

Step 4.  Click on the Draw Handicap Ramp command button. The user is prompted to 
Identify curb element. Data point on the curb element near the location for the 
handicap ramp. Once identified, data point to accept. 

 

Step 5.  The user is then prompted to Identify Point at Curb for Ramp Center. Snap and 
data point at the center location for the handicap ramp.  
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Step 6.  After identifying the center point, the user is prompted to Identify side for 
placement. The handicap ramp is shown dynamically to help the user set the side 
where it should be placed. Data point to set the location.  

 

When the side point is given, the handicap ramp is drawn in.  

 

This handicap ramp does not have a defined type number so no text labeling is 
needed. The image below shows the concrete island completed with all needed 
handicap ramps. 
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Usage:  Concrete Median  
Step 3. Make your final settings on the dialog. Set the Ramp Location to Concrete Median. 

The Ramp Type setting is not applicable for this kind of handicap ramp and is noted 
as N/A.   

You will need to locate the handicap ramp’s center points at the median curb 
lines prior to placing the ramp. 
Adjust the value for Ramp Width as needed. Minimum values from the standard 
roadway drawings are specified by default.  

Step 4.  Click on the Draw Handicap Ramp command button. The user is prompted to 
Identify median curb on one side. Data point on the median curb at either side of 
the median. Once identified, data point to accept. 

 

Step 5.  The user is then prompted to Identify median curb on other side. Data point on the 
median curb on the other side of the median. Once identified, data point to accept. 
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Step 6.  After identifying the curbs, the user is prompted to Identify Point at Curb for Ramp 
Begin. Snap and data point at the center location for the handicap ramp on the 
beginning side.  

 

Step 7.  The user is then prompted to Identify Point at Curb for Ramp End. Snap and data 
point at the center location for the handicap ramp on the ending side.  The handicap 
ramp is shown dynamically to aide in placement. 

 

When the end center point is given, the handicap ramp is drawn in. This handicap 
ramp does not have a defined type number so no text labeling is needed. 
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Usage:  Splitter Island (Pedestrian Refuge Area)  
Step 3. Make your final settings on the dialog. Set the Ramp Location to Splitter Island. The 

Ramp Type setting is not applicable for this kind of handicap ramp and is noted as 
N/A.   

You will need to locate the pedestrian refuge area’s center points at the splitter 
island curb lines prior to placing the ramp.  There is a minimum offset of 20’ 
from the roundabout to the edge of the crossing location. The minimum width of 
the ramp is 10’ so the ramp center must be at least 25’ from the roundabout. 
Adjust the value for Ramp Width as needed. Minimum values from the standard 
roadway drawings are specified by default.  

Step 4.  Click on the Draw Handicap Ramp command button. The user is prompted to ID 
splitter island curb on one side. Data point on the curb at either side of the island. 
Once identified, data point to accept. 

 

Step 5.  The user is then prompted to ID splitter island curb on other side. Data point on the 
curb on the other side of the island. Once identified, data point to accept. 
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Step 6.  After identifying the curbs, the user is prompted to Identify Point at Curb for Ramp 
Begin. Snap and data point at the center location for the ramp on the beginning side.  

 

Step 7.  The user is then prompted to Identify Point at Curb for Ramp End. Snap and data 
point at the center location for the ramp on the ending side.  The handicap ramp is 
shown dynamically to aide in placement. 

 

When the end center point is given, the handicap ramp is drawn in. This handicap 
ramp does not have a defined type number so no text labeling is needed. 
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Usage:  Bicycle Ramp  
Step 3. Make your final settings on the dialog. Set the Ramp Location to Bicycle Ramp. The 

Ramp Type setting is not applicable for this kind of ramp and is noted as N/A.   

You will need to locate the bicycle ramp’s center points at the roadway curb line 
and the sidewalk prior to placing the ramp. 
Adjust the value for Ramp Width as needed. Minimum values from the standard 
roadway drawings are specified by default.  

Step 4.  Click on the Draw Handicap Ramp command button. The user is prompted to 
Identify curb at roadway. Data point on the curb near the beginning of the bicycle 
ramp. Once identified, data point to accept. 

 

Step 5.  The user is then prompted to Identify sidewalk. Data point on the edge of the 
sidewalk near the end of the bicycle ramp. Once identified, data point to accept. 
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Step 6.  The user is prompted to Identify Point at Curb for Ramp Begin. Snap and data 
point at the center location for the bicycle ramp beginning at the curb.  

 

Step 7.  The user is then prompted to ID Point at Sidewalk for Ramp End & Angle. Snap 
and data point at the center location for the bicycle ramp ending at the sidewalk.  The 
ramp center portion is shown dynamically to aide in placement. 
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Step 8.  The user is last prompted to ID flare side, Entry (LT) or Exit (RT). This ramp type 
includes a concrete flare to the inside for transitioning to the sidewalk. The outside 
has a tapering curb to transition into the sidewalk. As indicated in the prompts, entry 
bicycle ramps will have the flare to the left while on exit ramps the flare should be 
placed to the right.  The ramp is shown dynamically to aide in setting the flare side. 

 

When the flare side point is given, the bicycle ramp is drawn in. This ramp does not 
have a defined type number so no text labeling is needed. 

  

Entry Bicycle Ramp          Exit Bicycle Ramp. 
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Pattern Scarified Pvmt. Area 
D&C location: Drafting Standards > Roadway Linework > Scarify Pvmt 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern an exist. 
pavement scarify area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns  
or by using the keyin  
vba run [AreaPatterns]Scarify.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Scarify Pvmt. The Pattern Area tool is activated with the 
appropriate settings.  The active level is set as well. 

 
Or from the drop down menu in the Design Area Patterns dialog … 
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Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Pattern Reinforced Concrete Area 
D&C location: Drafting Standards > Roadway Linework > Reinf Concrete 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a reinforced 
concrete area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns  
or by using the keyin  
vba run [AreaPatterns]ReinforcedConcrete.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Reinf Concrete. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Pattern Crown Vetch Area 
D&C location: Drafting Standards > Roadway Linework > Crown Vetch 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a crown vetch 
slope area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns  
or by using the keyin  
vba run [AreaPatterns]CrownVetch.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Crown Vetch. The Pattern Area tool is activated with the 
appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Traffic Flow Diagrams 
D&C location: Drafting Standards > Roadway Linework > Traffic Flow Dg 
MicroStation VBA Program: TrafficFlowDiagramCells.mvba 
Description: 

This program provides access to TDOT Design Division traffic flow diagram cells. 

Command buttons are provided to access MicroStation commands Auto Fill in Enter_Data Fields 
and Fill in Single Enter_Data Field. 

A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Traffic Flow Diagrams 
or by using the keyin  
vba run [TrafficFlowDiagramCells]TrafficFlowcells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Traffic Flow Dg. The Traffic Flow Diagrams dialog 

appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
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bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 

Any of these cell placement options can also be used in conjunction with Geopak’s 
DP Station/Offset tool to place the cell at a specific station and offset along the 
horizontal alignment. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Private Drives 
Pattern Pvt. Dr. Shading 
D&C location: Drafting Standards > Private Drives > Pvt Dr Shading 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to shade in private 
drives and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns  
or by using the keyin  
vba run [AreaPatterns]PvtDriveShading.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Pvt Dr Shading. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Place Horizontal Alignment Points  
D&C location: Drafting Standards > Private Drives > HA Driveway Pts 
MicroStation VBA Program: HApoints.mvba 
Description: 
This program places the required point text symbols for all keypoints of any horizontal 
alignment/chain stored in the project GPK file in the plan view. The PI symbol (triangle) with 
short sub tangents are placed for all spiral-curve combinations or simple curves. The point on 
chain symbol (circle) is placed at the begin & end and at all on chain curve points. The PI 
symbol (triangle) by itself is placed at any break in tangent direction without a curve along the 
horizontal alignment. This is applicable to the following horizontal alignment types: Proposed 
Roadway Centerline, Preliminary Roadway Centerline, Existing Roadway Centerline, Proposed 
Special Ditch Centerline, Existing Stream Baseline, Functional Roadway Centerline, Proposed 
Private Drive Centerline. 
All graphics are placed in a single graphic group for easy deletion as needed. 
This tool stores the current location of the dialog, GPK job number, chain name and horizontal 
alignment type in the file C:\Temp\MVBA_FormStorage.log when the dialog is closed. When 
opened later it uses this information if applicable to bring up the dialog as you last used it. 
This tool is only used on more complex or critically located private drives which are 
developed using roadway tools. 
This program can also be activated from the MicroStation drop down menu at  
TDOT > Centerlines > Place Horizontal Alignment Points  
or by using the keyin  
vba run [HApoints]HApointsStart.main   
Special Requirements: 

Chains that are to be processed must be stored in a Geopak GPK file in the folder where the 
MicroStation DGN file resides.  

The ID Chain function uses a special VBA reference to program GetCogoElement.mvba which 
was provided by Bentley and must be present with the program for it to function. 

Usage: 

Step 1. In D&C manager activate HA Driveway Pts. The Place Horizontal Alignment 
Points dialog is displayed. 

All Geopak jobs found within the current active folder are listed in the Job drop down 
box.  If this tool was used previously for that job, the last chain processed is set as 
well as the last horizontal alignment type which was used.  Scale defaults to active 
scale set in the MicroStation DGN file. 
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Step 2. After selecting the Geopak Job number as needed, the Chain drop down is populated 
with all chains stored in the job.  Select the chain to place point symbols for.  If you 
do not know the chain name but have chain graphics, the ID button can be used to 
select the chain.  

Step 3. Set the Type to Proposed Private Drive Centerline by clicking that option in the 
drop down list provided. This setting controls the level, symbology, etc. for the point 
symbols which are to be placed. 

 

If this tool was used previously, the last horizontal alignment type which was used is 
set automatically when the tool is activated. 

Step 4. Reset the Scale if needed and click the Place Points command button. Point symbols 
are displayed for the specified chain. 

Step 5. If you need to place point symbols for other chains, reset the chain name and click the 
Place Points command button for each one.  
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Label Vertical Alignment 
D&C location: Drafting Standards > Private Drives > VA Labeler 
MicroStation/Geopak VBA Program: VA_Labeler.mvba 
Description: 
This program was designed to label pertinent vertical alignment information on the profile. The 
user has the ability to choose the options they would like to label by selecting the check box 
corresponding to the label.  Chain, reference datum, and scale information is attained when the 
user selects the Geopak profile cell.   
Only profiles applicable to the identified Geopak profile cell are offered for labeling.  
Type option allows for application for roadways, private drives or special ditches. The type 
controls text sizes, orientation and symbology. 
Program is set up for use on English or Metric projects. 
This is only used on more complex or critically located private drives which are developed 
using roadway tools. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Profiles >  Vertical Alignment Labeler 
or by using the keyin  
vba run [VA_Labeler]modStartUp.label_VApts 
Special Requirements: 
A Geopak profile cell must be present.  
K value text file, VALabel_Speed_kvl.txt must be present in TDOT Design Division’s 
GeopakStandards folder at  C:\Program Files\GeopakStandards\.  

Usage: 

Step 1. In D&C manager activate VA Labeler. The 
Label Vertical Alignment dialog is opened. By 
default the type is set to Roadway. Reset Type 
to Private Drive. 
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Step 2. Click on the Identify Profile Cell command button and data point on the Geopak 
profile cell for the profile. The window shade button on the upper right of the dialog 
can be used to get the dialog out of the way as you identify the profile cell.  Just click 
it again to re-expand the dialog after identifying the cell. 

Note: 
After reading the profile cell and populating the Profile Settings at the top of the 
dialog, the GPK file is read for all profiles/vertical alignments applicable for display 
on this profile and fills the profile list box 

Step 3. Scroll through the Profile list and choose the vertical alignment that you wish to 
annotate. 

Step 4. Set the Scale value as needed. The current active scale is read when the program is 
started to fill in this field automatically. Scale controls text sizes & label offsets. 

Step 5. Finally the label options can be adjusted as needed. The type of profile to be labeled 
determines which default options are turned on.  
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Step 5. Now that all control values are set, click on the Place Labels command button and 
the vertical alignment is annotated. Review the annotation graphics and click the red 
X to close the dialog. 
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Vertical Curve Design Tool 
D&C location: Drafting Standards > Private Drives > VC Design Tool 
MicroStation/Geopak VBA Program: VerticalCurveDesign.mvba 
Description: 
This program is set up to be used to design or check  vertical curves for roadways. Entrance and 
exit grades for the vertical curve can be keyed in or identified graphically. They must be 
identified graphically for visual vertical curve displays. Command buttons are provided to 
identify these lines together or individually as needed. After the grades are set, one of 3 Design 
Controls must be set, length, K value or design speed. Then click on the Calculate Curve 
command button and the unknown design values are computed, shown in the dialog and the 
curve is temporarily visualized in graphics.  
If desired, the curve can be drawn in permanently by clicking the Draw Curve command button. 
Curve graphics include the curve and circle point text symbols at the VPC, VPI & VPT. All 
graphics are joined as a graphic group. Current active level and element symbology are used for 
permanent curve displays. The current active scale controls the size of the point symbols. 
Options are provided for the use of either RD or RD01 vertical curve design standards which are 
read from the text file VALabel_Speed_kvl.txt. 
 A key in field is provided to enter the profile vertical exaggeration factor. This value defaults to 
the standard 10 times exaggeration but can be reset as needed. This controls grade values that are 
computed from graphics and how the vertical curve will appear on the profile. 
Program is set up for use on English or Metric projects 

This program can also be activated from the MicroStation drop down menu  
TDOT > Profiles >  Vertical Curve Design Tool 
or by using the keyin  
vba run [VerticalCurveDesign]VCDesign.main 
Special Requirements: 
K value text file, VALabel_Speed_kvl.txt must be present in TDOT Design Division’s 
GeopakStandards folder at  C:\Program Files\GeopakStandards\.  

Usage: 
This tool has been described previously under Drafting Standards > Roadway Vertical 
Alignments. See the description of usage at that location.  
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Exist. Drainage 
Place Horizontal Alignment Points 
D&C location: Drafting Standards > Exist. Drainage > HA Stream Pts 
MicroStation VBA Program: HApoints.mvba 
Description: 
This program places the required point text symbols for all keypoints of any horizontal 
alignment/chain stored in the project GPK file in the plan view. The PI symbol (triangle) with 
short sub tangents are placed for all spiral-curve combinations or simple curves. The point on 
chain symbol (circle) is placed at the begin & end and at all on chain curve points. The PI 
symbol (triangle) by itself is placed at any break in tangent direction without a curve along the 
horizontal alignment. This is applicable to the following horizontal alignment types: Proposed 
Roadway Centerline, Preliminary Roadway Centerline, Existing Roadway Centerline, Proposed 
Special Ditch Centerline, Existing Stream Baseline, Functional Roadway Centerline, Proposed 
Private Drive Centerline. 
All graphics are placed in a single graphic group for easy deletion as needed. 
This tool stores the current location of the dialog, GPK job number, chain name and horizontal 
alignment type in the file C:\Temp\MVBA_FormStorage.log when the dialog is closed. When 
opened later it uses this information if applicable to bring up the dialog as you last used it. 
This program can also be activated from the MicroStation drop down menu at  
TDOT > Centerlines > Place Horizontal Alignment Points  
or by using the keyin  
vba run [HApoints]HApointsStart.main   
Special Requirements: 

Chains that are to be processed must be stored in a Geopak GPK file in the folder where the 
MicroStation DGN file resides.  

The ID Chain function uses a special VBA reference to program GetCogoElement.mvba which 
was provided by Bentley and must be present with the program for it to function. 

Usage: 

Step 1. In D&C manager activate HA Stream Pts. The Place Horizontal Alignment Points 
dialog is displayed. 

All Geopak jobs found within the current active folder are listed in the Job drop down 
box.  If this tool was used previously for that job, the last chain processed is set as 
well as the last horizontal alignment type which was used.  Scale defaults to active 
scale set in the MicroStation DGN file. 
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Step 2. After selecting the Geopak Job number as needed, the Chain drop down is populated 
with all chains stored in the job.  Select the chain to place point symbols for.  If you 
do not know the chain name but have chain graphics, the ID button can be used to 
select the chain.  

Step 3. Set the Type to Existing Stream Baseline by clicking that option in the drop down 
list provided. This setting controls the level, symbology, etc. for the point symbols 
which are to be placed. 

 

If this tool was used previously, the last horizontal alignment type which was used is 
set automatically when the tool is activated. 

Step 4. Reset the Scale if needed and click the Place Points command button. Point symbols 
are displayed for the specified chain. 

Step 5. If you need to place point symbols for other chains, reset the chain name and click the 
Place Points command button for each one.  
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Prop. Drainage  
Draw Prop. Box Culvert or Bridge in Plan by 2 Points 
D&C location: Drafting Standards >Prop. Drainage > Structures in Plan > Plan Box 
MicroStation Basic Program: drawboxplan.ba 
Description: 
This application is used to draw a proposed box culvert or bridge in the plan view.  
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Plan) > Draw Box Culvert or Br.  
or by using the keyin  
macro drawboxplan.  
Special Requirements: 
The centerline of the structure must be established prior to running the application.  

Usage: 

Step 1. Establish the centerline of the structure. This may have been done during the design 
process using Geopak Drainage or with MicroStation tools but here we will illustrate 
the use of Geopak's  Draw Pattern tool to get this done.  

From Project Manager or the Geopak tool box activate the Draw Pattern tool.  
Set the job number and chain name for the roadway.  
Change the placement control at the bottom for placement Once and change 
symbology settings as desired. 
Only the Beginning side of the dialog should be active now and there you now can set 
the Offset LT, Station & Offset RT. 
If the structure is at 90 degrees (0 degrees on dialog) you can go ahead and hit Apply 
to draw the structure. If the structure is skewed click on the Skew option.  
Skew values in this dialog are measured from a normal 90 degree line not the 
centerline as we normally consider them. So to get the skew value to enter in the 
dialog. subtract  the skew from 90. Skews to the left should be entered as positive and 
skews to the right as negative. (Example: 60 degree skew left  90-60=30) 
In this example our box bridge is 45 degrees right so we enter a -45 for the skew 
value. Hit Apply to draw the structure centerline. 
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Step 2. In D&C manager activate Plan Box. The Draw Prop. Box Culvert or Bridge in 
Plan by 2 Points dialog opens. Defaults which are displayed . . . Number of Barrels 
1, Skew Angle 90, Skew Direction None & Label Scale (Current Active Scale). 
Note that skew angles in degrees minutes & seconds are supported and wing walls are 
optional. 

 

Step 3. Make settings in the dialog as needed for the structure you need to draw. In our 
example we are placing a 3 @ 10X8 structure at a 45 degree skew right. From 
standard structure drawing STD-15-111 we get the short wingwall (WS) length of 9' 
and a long wingwall (WL) length of 20.25'.  Once settings are made click on the 
Draw Structure button. 
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Step 4. You are then prompted to Identify Left End of Structure. Snap and Data point at 
that end of the structure centerline. 

 

Step 5. You are then prompted to Identify Right End of Structure. Snap and Data point at 
that end of the structure centerline. 
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Step 6. The structure is drawn and the user is prompted to Identify location for label. A 
Reset can be given to skip placement or Data point at location for label to be placed. 

 

Step 7. Finally if the label was placed you are prompted to Identify location for leader line. 
Data point at structure where you wish the leader line to end. 
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Step 8. The structure with label is now complete. Note that centerline length of structure is 
checked to determine whether label should specify bridge or culvert. 
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Draw Prop. Type "A" Pipe Endwall  in Plan 
D&C location: Drafting Standards > Prop. Drainage > Structures in Plan > A Endwall 
MicroStation Basic Program: drawAEWplan.ba 
Description: 
This application used draw a proposed type A endwall on a pipe end in the plan view. All control 
values in dialog are based on data in standard roadway drawing D-PE-1. 
Endwall information used for placement and associated quantities are added to CSV file 
EndwallTabulation.csv. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Plan) > Draw Type A Endwall  
or by using the keyin  
macro drawAEWplan.  
Special Requirements: 
The proposed pipe must be drawn in the plan view.  

Usage: 

Step 1. Draw the proposed pipe in the plan view. This may have been done during the design 
process using Geopak Drainage, with MicroStation tools or by using Geopak's  Draw 
Pattern tool with D&C Manager's Place Influence on to set the appropriate 
symbology for the desired pipe size. See Step 1 of the Plan Box program description 
above for an explanation of using the Draw Pattern tool for this. 

Step 2. In D&C manager activate A Endwall. The Draw Prop. Type "A" Pipe Endwall  in 
Plan dialog opens. Defaults which are displayed . . . Pipe Size 36", Pipe Type Cross 
Drain, Skew Angle 90 & Skew Direction None. Also note that skew angles in 
degrees minutes & seconds are supported. 

 

Step 3. Make settings in the dialog as needed for the pipe endwall you need to draw. In our 
example we are placing an endwall on a 48" pipe cross drain at a 60 degree skew left. 
The Pipe Type setting controls the level for placement. Once settings are made click 
on the Draw Structure button. 
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Step 4. You are then prompted to Identify Point at Endwall. Snap and Data point at the 
end of the pipe where endwall should be drawn. 

 

Step 5. You are then prompted to Identify other end of pipe. Snap and Data point at the 
other end of the pipe. 
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Step 6. The endwall is drawn and the dialog re-appears.  You can click on Draw Structure 
to place another endwall of the same type at the other end or click on Cancel to exit 
the program. 

 

Step 7. When endwalls are placed in graphics, information used for placement and associated 
quantities are added to CSV file EndwallTabulation.csv in your project directory. 
Data from this file can later be imported into Excel and used to tabulate final 
quantities for endwalls. 
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Draw Prop. Type "U" Pipe Endwall in Plan 
D&C location: Drafting Standards > Prop. Drainage > Structures in Plan > U Endwall 
MicroStation VBA Program: DrawTypeUEndwall.mvba 
Description: 
This application is used draw a proposed type U endwall on a pipe end in the plan view. Endwall 
can be placed with safety grate if required. All control values in dialog are based on data in 
standard roadway drawings D-PE-3B, D-PE-4, D-PE-4B & D-PE-6B. 
Endwall information used for placement and associated quantities are added to CSV file 
EndwallTabulation.csv. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Plan) > Draw Type U Endwall  
or by using the keyin  
vba run [DrawTypeUEndwall]EW.Main  
Special Requirements: 
The proposed pipe must be drawn in the plan view.  

Usage: 

Step 1. Draw the proposed pipe in the plan view. This may have been done during the design 
process using Geopak Drainage, with MicroStation tools or by using Geopak's  Draw 
Pattern tool with D&C Manager's Place Influence on to set the appropriate 
symbology for the desired pipe size. See Step 1 of the Plan Box program description 
above for an explanation of using the Draw Pattern tool for this. 

Step 2. In D&C manager activate U Endwall. The Draw Prop. Type "U" Pipe Endwall  in 
Plan dialog opens. Defaults which are displayed . . . Pipe Size 18", Pipe Type Cross 
Drain, Number of Pipes 1, Side Slope 6:1, Endwall Type w/grate, Skew Angle 90 
& Skew Direction None(90 Deg).  Note that multiple pipes and 2:1 or 1.5:1 slopes 
are only allowed with pipe sizes 18"-30" and if a grate is specified but not required 
the endwall is drawn without the grate. 

 

Step 3. Make settings in the dialog as needed for the pipe endwall you need to draw. The 
Pipe Type setting controls the level for placement. Once settings are made click on 
the Draw Endwall button. 
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Step 4. You are then prompted to Identify Point at Endwall. Snap and Data point at the 
end of the pipe where endwall should be drawn. 

Step 5. The endwall is dynamically shown and you are then prompted to Identify other end 
of pipe. Snap and Data point at the other end of the pipe. 

 

Step 6. The endwall is drawn into the file.  You can click on Draw Endwall to place another 
endwall of the same type at the other end or click on Cancel to exit the program. 

 

Step 7. When endwalls are placed in graphics, information used for placement and associated 
quantities are added to CSV file EndwallTabulation.csv in your project directory. 
Data from this file can later be imported into Excel and used to tabulate final 
quantities for endwalls. 
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Draw Prop. Type "SD" Pipe Endwall  in Plan 
D&C location: Drafting Standards > Prop. Drainage > Structures in Plan > SD Endwall 
MicroStation Basic Program: drawSDEWplan.ba 
Description: 
This application used draw a proposed type SD endwall on a pipe end in the plan view. All 
control values in dialog are based on data in standard roadway drawings D-SEW-6DA & D-
SEW-12D. 
Endwall information used for placement and associated quantities are added to CSV file 
EndwallTabulation.csv. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Plan) > Draw Type SD Endwall  
or by using the keyin  
macro drawSDEWplan  
Special Requirements: 
The proposed pipe must be drawn in the plan view.  

Usage: 

Step 1. Draw the proposed pipe in the plan view. This may have been done during the design 
process using Geopak Drainage, with MicroStation tools or by using Geopak's  Draw 
Pattern tool with D&C Manager's Place Influence on to set the appropriate 
symbology for the desired pipe size. See Step 1 of the Plan Box program description 
above for an explanation of using the Draw Pattern tool for this. 

Step 2. In D&C manager activate SD Endwall. The Draw Prop. Type "SD" Pipe Endwall  
in Plan dialog opens. Defaults which are displayed . . . Pipe Size 15" & Side Slope 
6:1.  Note that 12:1 side slopes are only allowed with pipe sizes 15"-18". 

 

Step 3. Make settings in the dialog as needed for the pipe endwall you need to draw. Once 
settings are made click on the Draw Structure button. 

Step 4. You are then prompted to Identify Point at Endwall. Snap and Data point at the 
end of the pipe where endwall should be drawn. 

Step 5. You are then prompted to Identify other end of pipe. Snap and Data point at the 
other end of the pipe. 
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Step 6. The endwall is drawn and the dialog re-appears.  You can click on Draw Structure 
to place another endwall of the same type at the other end or click on Cancel to exit 
the program. 

 

Step 7. When endwalls are placed in graphics, information used for placement and associated 
quantities are added to CSV file EndwallTabulation.csv in your project directory. 
Data from this file can later be imported into Excel and used to tabulate final 
quantities for endwalls. 
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Draw Prop. Type Straight Pipe Endwall  in Plan 
D&C location: Drafting Standards > Prop. Drainage > Structures in Plan > ST Endwall 
MicroStation Basic Program: drawSTEWplan.ba 
Description: 
This application used draw a proposed type ST/straight endwall on a pipe end in the plan view. 
All control values in dialog are based on data in standard roadway drawing D-PE-4. 
Endwall information used for placement and associated quantities are added to CSV file 
EndwallTabulation.csv. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Plan) > Draw Type ST Endwall  
or by using the keyin  
macro drawSTEWplan.  
Special Requirements: 
The proposed pipe must be drawn in the plan view.  

Usage: 

Step 1. Draw the proposed pipe in the plan view. This may have been done during the design 
process using Geopak Drainage, with MicroStation tools or by using Geopak's  Draw 
Pattern tool with D&C Manager's Place Influence on to set the appropriate 
symbology for the desired pipe size. See Step 1 of the Plan Box program description 
above for an explanation of using the Draw Pattern tool for this. 

Step 2. In D&C manager activate ST Endwall. The Draw Prop. Type Straight Pipe 
Endwall  in Plan dialog opens. Defaults which are displayed . . . Pipe Size 18", Pipe 
Type Cross Drain, Number of Pipes 1, Skew Angle 90 & Skew Direction None. 
Note that skew angles in degrees minutes & seconds are supported.   

 

Step 3. Make settings in the dialog as needed for the pipe endwall you need to draw. The 
Pipe Type setting controls the level for placement. Once settings are made click on 
the Draw Structure button. 

Step 4. You are then prompted to Identify Point at Endwall. Snap and Data point at the 
end of the pipe where endwall should be drawn. 

Step 5. You are then prompted to Identify other end of pipe. Snap and Data point at the 
other end of the pipe. 
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Step 6. The endwall is drawn and the dialog re-appears.  You can click on Draw Structure 
to place another endwall of the same type at the other end or click on Cancel to exit 
the program. 

 

Step 7. When endwalls are placed in graphics, information used for placement and associated 
quantities are added to CSV file EndwallTabulation.csv in your project directory. 
Data from this file can later be imported into Excel and used to tabulate final 
quantities for endwalls. 

 165



Draw Prop. Type L Pipe Endwall  in Plan 
D&C location: Drafting Standards > Prop. Drainage > Structures in Plan > L Endwall 
MicroStation Basic Program: drawLEWplan.ba 
Description: 
This application used draw a proposed type L endwall on a pipe end in the plan view. All control 
values in dialog are based on data in standard roadway drawing D-PE-4. 
Endwall information used for placement and associated quantities are added to CSV file 
EndwallTabulation.csv. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Plan) > Draw Type L Endwall  
or by using the keyin  
macro drawLEWplan.  
Special Requirements: 
The proposed pipe must be drawn in the plan view.  

Usage: 

Step 1. Draw the proposed pipe in the plan view. This may have been done during the design 
process using Geopak Drainage, with MicroStation tools or by using Geopak's  Draw 
Pattern tool with D&C Manager's Place Influence on to set the appropriate 
symbology for the desired pipe size. See Step 1 of the Plan Box program description 
above for an explanation of using the Draw Pattern tool for this. 

Step 2. In D&C manager activate L Endwall. The Draw Prop. Type L Pipe Endwall  in 
Plan dialog opens. Defaults which are displayed . . . Pipe Size 18", Pipe Type Cross 
Drain, Number of Pipes 1, Side for Wingwall Left, Skew Angle 90 & Skew 
Direction None. Note that skew angles in degrees minutes & seconds are supported.   

 

Step 3. Make settings in the dialog as needed for the pipe endwall you need to draw. The 
Pipe Type setting controls the level for placement.  Side for wingwall is as seen 
looking out away from roadway. Once settings are made click on the Draw 
Structure button. 

Step 4. You are then prompted to Identify Point at Endwall. Snap and Data point at the 
end of the pipe where endwall should be drawn. 

Step 5. You are then prompted to Identify other end of pipe. Snap and Data point at the 
other end of the pipe. 
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Step 6. The endwall is drawn and the dialog re-appears.  You can click on Draw Structure 
to place another endwall of the same type at the other end or click on Cancel to exit 
the program. 

 

Step 7. When endwalls are placed in graphics, information used for placement and associated 
quantities are added to CSV file EndwallTabulation.csv in your project directory. 
Data from this file can later be imported into Excel and used to tabulate final 
quantities for endwalls. 

 167



Draw Permanent Slope Drain 
D&C location:  
Drafting Standards > Prop. Drainage > Structures in Plan > Perm Slope Drain 
MicroStation VBA Program: DrawPermSlopeDrain.mvba 
Description: 
This program draws in a permanent slope drain with inlet symbol and rip-rap pad at the outlet 
end. The pipe is drawn in with the appropriate custom line style. Geopak Adhoc data for pay 
item number, description, unit and roadway side slope is added to the pipe line element so that 
quantities can be calculated later by Geopak's D&C Manager. The pipe size and side slope value 
are used to calculate the 45 degree bend location in the slope drain pipe. During final quantity 
calculations the side slope is used to adjust the measured horizontal length of pipe since these 
pipes follow the roadway slope. 
On the Draw Permanent Slope Drain dialog is a command button for Pay Item Info. When the 
user clicks on this option, the User Specified Pay Item Values dialog opens. This dialog contains 
fields for entering pay item number, description, unit and roadway side slope information. A 
Modify Pay Item Values command button is provided to change data assigned to previously 
placed graphics. The Read Element command button on the dialog is provided to check the pay 
item values from slope drains placed previously. For both of these functions, once activated, 
identify any slope drain and its values are changed or read and used to populate the dialog. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Plan) > Permanent Slope Drains  
or by using the keyin  
vba run [DrawPermSlopeDrain]PermSlopeDrain.main  
Special Requirements: 
The slope lines and ditch line must be drawn/located in the plan view.  

Usage: 

Step 1. In D&C manager activate Perm Slope Drain. The Draw Permanent Slope Drain 
dialog opens.  

Defaults are set to Pipe Size: 18 in/450 mm and Side Slope: 4:1.  Scale defaults to 
active scale set in the MicroStation DGN file. 

 

Step 2. Make settings in the dialog as needed for the slope drain you need to draw. Once 
settings are made click on the Draw Slope Drain button. 

Step 3. You are then prompted to Identify Point at Inlet. Snap and Data point at the slope 
line location where the inlet is to be placed. 
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Step 4. After the initial data point, the inlet and pipe are shown dynamically and the user is 
prompted to ID Point Perpendicular at Ditch. Snap and Data point at the ditch line 
location where the pipe is perpendicular to the ditch. 

 

The program then uses the settings given for side slope & pipe size to calculate the 45 
degree bend location in the pipe back from the ditch. 

Step 5. The completed slope drain pipe with rip-rap outlet pad is shown dynamically and the 
user is prompted to ID Side\Direction for Outlet. Data point to indicate the 
direction of flow in the ditch. 
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Step 6. After giving this last point, all slope drain graphics are placed in the file.   

 

Step 7. You can adjust settings if needed and continue to place additional slope drains. 

Usage:  Pay Item Info 

Step 1. If you wish to assign, modify or just check the pay item values which are assigned to 
a slope drain, click on the Pay Item Info command button on the Draw Permanent 
Slope Drain dialog. The User Specified Pay Item Values dialog opens. This dialog 
contains fields for entering pay item number, description, unit and roadway side slope 
information.  
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Step 2. To assign or modify the pay item values for a slope drain, first enter the information 
in the data entry fields provided. Any standard item number for slope drain pipe will 
automatically update the description field. When data has been entered, click on the 
Modify Pay Item Values command button and you are prompted to Data point on 
slope drain pipe. Data point on the slope drain pipe.   

 
Once identified, Data point again to accept and assign the pay item values. This 
function can be used to assign pay item values to slope drains that were placed prior 
to the implementation of this tool. 

Step 3. To check the pay item values assigned to a slope drain that has been placed 
previously, then click the Read Element command button on the User Specified Pay 
Item Values dialog. The user is prompted to Data point on slope drain pipe. Once 
accepted, the pay item values are read from the pipe element and are used to populate 
the dialog.  

 

 171



Draw Prop. Pipe(s) on Profile by Center Flow Point 
D&C location: Drafting Standards > Prop. Drainage > Structures on Profiles > Profile Pipe 
MicroStation Basic Program: drawpipeprofile.ba 
Description: 
This application is used to draw a proposed pipe(s) on a profile.  
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Profiles\Culv. Sections) > Draw Pipe  
or by using the keyin  
macro drawpipeprofile.  
Special Requirements: 
The center flow line point of the pipe(s) must be located in graphics prior to running the 
application.  
Usage: 
Step 1. Establish the center flow line point of the pipe(s). This may be located with 

MicroStation tools or with Geopak's  Vertical Alignment Generator and it's Issue 
Data Point tool.  

Step 2. In D&C manager activate Profile Pipe. The Draw Prop. Pipe(s) on Profile by 
Center Flow Point dialog opens. Defaults which are displayed . .Number of Pipes 1, 
Space between Pipes 12 inches, Skew Angle 90, Vertical Exaggeration 10, Label 
Control - Scale (Current Active Scale) & Label Control - Type Cross Drain. Note 
that skew angles in degrees minutes & seconds are supported. 

 
Pipe Size - Width is optional and is provided so that horizontal & vertical oval pipes 
can be drawn as needed. 
Vertical Exaggeration should usually be 10 for profiles … 
(Example: 50 scale horiz. / 5 scale vert. = 10)  
It is provided for special profile cases and for the occasional need to draw on culvert 
sections which would use an exaggeration value of 1. 
Label Control - Type controls the format of labeling provided.  
Cross Drain - Profile Drainage Data Cell 
Storm Sewer - EW storm sewer drainage code cell with leader line 
Side Drain - Text label: __' OF pipe size" S.D. REQD. 
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Step 3. Make settings in the dialog as needed for the pipe(s) you need to draw. In our 
example we are placing a 48" cross drain at a 90 degree skew. Once settings are made 
click on the Draw Structure button. 

 

Step 4. You are then prompted to Identify Flow Line Location at Center. Snap and Data 
point at the flow line point. 
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Step 6. The pipe is drawn and the user is prompted to Identify location for Drainage Data. 
A Reset can be given to skip placement or Data point at location for the data cell to 
be placed.  

 

Since it is difficult to see small pipes on profiles when drawn at actual size, this 
program plots pipes at a minimum width of  42"(3.5') when the Vertical 
Exaggeration is greater than 1. The pipe height is always shown at actual size times 
the Vertical Exaggeration value. 
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Step 8. The data cell is placed and size, type & skew data is added.  

 
Storm Sewer label example: 

 

Side Drain label example: 
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Draw Prop. Box Culvert or Bridge on Profile by Flow Point 
D&C location: Drafting Standards > Prop. Drainage > Structures on Profiles > Profile Box 
MicroStation Basic Program: drawboxprofile.ba 
Description: 
This application is used to draw a proposed box culvert or bridge on a profile.  
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Profiles\Culv. Sections) > Draw Box Culvert or Br.  
or by using the keyin  
macro drawboxprofile.  
Special Requirements: 
The center flow line point of the structure must be located in graphics prior to running the 
application.  

Usage: 

Step 1. Establish the center flow line point of the structure. This may be located with 
MicroStation tools or with Geopak's  Vertical Alignment Generator and it's Issue 
Data Point tool.  

Step 2. In D&C manager activate Profile Box. The Draw Prop. Box Culvert or Bridge on 
Profile by Flow Point dialog opens. Defaults which are displayed . . . Number of 
Barrels 1, Outside Wall 8 inches, Inside Wall 8 inches, Top Slab 12 inches, 
Bottom slab 12 inches, Skew Angle 90, Label Scale (Current Active Scale) & 
Vertical Exaggeration 10. Note that skew angles in degrees minutes & seconds are 
supported. 

 

Vertical Exaggeration should usually be 10 for profiles … 
(Example: 50 scale horiz. / 5 scale vert. = 10)  
It is provided for special profile cases and for the occasional need to draw on culvert 
sections which would use an exaggeration value of 1. 
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Step 3. Make settings in the dialog as needed for the structure you need to draw. In our 
example we are placing a 3 @ 10X8 structure with a 3' fill height at a 90 degree 
skew. From standard structure drawing STD-15-79 we get the outside wall (WT) 
thickness of 8" and an inside wall (IT) thickness of 8" so we can use the defaults. The 
top slab (ST) thickness is 9" and the bottom slab (SB) thickness is 8" so we enter 
those.  Once settings are made click on the Draw Structure button. 

 

Step 4. You are then prompted to Identify Flow Line Location at Center. Snap and Data 
point at the flow line point. 
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Step 6. The structure is drawn and the user is prompted to Identify location for Drainage 
Data. A Reset can be given to skip placement or Data point at location for the data 
cell to be placed. 

 

Step 8. The data cell is placed and size, type & skew data is added. Note that centerline 
length of structure is checked to determine whether text should specify bridge or 
culvert. 
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Draw Prop. Slab Culvert or Bridge on Profile by Flow Point 
D&C location: Drafting Standards > Prop. Drainage > Structures on Profiles > Profile Slab 
MicroStation Basic Program: drawslabprofile.ba 
Description: 
This application is used to draw a proposed slab culvert or bridge on a profile.  
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Profiles\Culv. Sections) > Draw Slab Culvert or Br.  
or by using the keyin  
macro drawslabprofile.  
Special Requirements: 
The center flow line point of the structure must be located in graphics prior to running the 
application.  
Usage: 
Step 1. Establish the center flow line point of the structure. This may be located with 

MicroStation tools or with Geopak's  Vertical Alignment Generator and it's Issue 
Data Point tool.  

Step 2. In D&C manager activate Profile Slab. The Draw Prop. Slab Culvert or Bridge on 
Profile by Flow Point dialog opens. Defaults which are displayed . . . Number of 
Barrels 1, Outside Wall 8 inches, Inside Wall 8 inches, Top Slab 12 inches, 
Footing slab 18 inches, Skew Angle 90, Label Scale (Current Active Scale) & 
Vertical Exaggeration 10. Note that skew angles in degrees minutes & seconds are 
supported. 

 
Vertical Exaggeration should usually be 10 for profiles … 
(Example: 50 scale horiz. / 5 scale vert. = 10)  
It is provided for special profile cases and for the occasional need to draw on culvert 
sections which would use an exaggeration value of 1. 
Footing Slab thickness should be 18" for most standard slab culvert and bridge 
structures but is provided for special cases where it may not be. 
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Step 3. Make settings in the dialog as needed for the structure you need to draw. In our 
example we are placing a 2 @ 14X7 structure with a 6' fill height at a 45 degree 
skew. From standard structure drawing STD-15-122 we get the outside wall (WT) 
thickness of 8", an inside wall (IT) thickness of 8" and a footing slab thickness of 18" 
so we can use the defaults. The top slab (ST) thickness is 11" so we enter that.  Once 
settings are made click on the Draw Structure button. 

 

Step 4. You are then prompted to Identify Flow Line Location at Center. Snap and Data 
point at the flow line point. 
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Step 6. The structure is drawn and the user is prompted to Identify location for Drainage 
Data. A Reset can be given to skip placement or Data point at location for the data 
cell to be placed. Due to the 45 degree skew, structure widths are adjusted. 

 

Step 8. The data cell is placed and size, type & skew data is added. Note that centerline 
length of structure is checked to determine whether text should specify bridge or 
culvert.  
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 Place Horizontal Alignment Points 
D&C location: Drafting Standards > Prop. Drainage > Special Ditches > HA Ditch Pts 
MicroStation VBA Program: HApoints.mvba 
Description: 

This program places the required point text symbols for all keypoints of any horizontal 
alignment/chain stored in the project GPK file in the plan view. The PI symbol (triangle) with 
short sub tangents are placed for all spiral-curve combinations or simple curves. The point on 
chain symbol (circle) is placed at the begin & end and at all on chain curve points. The PI 
symbol (triangle) by itself is placed at any break in tangent direction without a curve along the 
horizontal alignment. This is applicable to the following horizontal alignment types: Proposed 
Roadway Centerline, Preliminary Roadway Centerline, Existing Roadway Centerline, Proposed 
Special Ditch Centerline, Existing Stream Baseline, Functional Roadway Centerline, Proposed 
Private Drive Centerline. 

All graphics are placed in a single graphic group for easy deletion as needed. 

This tool stores the current location of the dialog, GPK job number, chain name and horizontal 
alignment type in the file C:\Temp\MVBA_FormStorage.log when the dialog is closed. When 
opened later it uses this information if applicable to bring up the dialog as you last used it. 
This program can also be activated from the MicroStation drop down menu at  
TDOT > Centerlines > Place Horizontal Alignment Points  
or by using the keyin  
vba run [HApoints]HApointsStart.main   
Special Requirements: 

Chains that are to be processed must be stored in a Geopak GPK file in the folder where the 
MicroStation DGN file resides.  

The ID Chain function uses a special VBA reference to program GetCogoElement.mvba which 
was provided by Bentley and must be present with the program for it to function. 

Usage: 

Step 1. In D&C manager activate HA Ditch Pts. The Place Horizontal Alignment Points 
dialog is displayed. 

All Geopak jobs found within the current active folder are listed in the Job drop down 
box.  If this tool was used previously for that job, the last chain processed is set as 
well as the last horizontal alignment type which was used.  Scale defaults to active 
scale set in the MicroStation DGN file. 
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Step 2. After selecting the Geopak Job number as needed, the Chain drop down is populated 
with all chains stored in the job.  Select the chain to place point symbols for.  If you 
do not know the chain name but have chain graphics, the ID button can be used to 
select the chain.  

Step 3. Set the Type to Proposed Special Ditch Centerline by clicking that option in the 
drop down list provided. This setting controls the level, symbology, etc. for the point 
symbols which are to be placed. 

 

If this tool was used previously, the last horizontal alignment type which was used is 
set automatically when the tool is activated. 

Step 4. Reset the Scale if needed and click the Place Points command button. Point symbols 
are displayed for the specified chain. 

Step 5. If you need to place point symbols for other chains, reset the chain name and click the 
Place Points command button for each one.  
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Label Vertical Alignment 
D&C location: Drafting Standards Prop. Drainage > Special Ditches > VA Labeler 
MicroStation/Geopak VBA Program: VA_Labeler.mvba 
Description: 
This program was designed to label pertinent vertical alignment information on the profile. The 
user has the ability to choose the options they would like to label by selecting the check box 
corresponding to the label.  Chain, reference datum, and scale information is attained when the 
user selects the Geopak profile cell.   
Only profiles applicable to the identified Geopak profile cell are offered for labeling.  
Type option allows for application for roadways, private drives or special ditches. The type 
controls text sizes, orientation and symbology. 
Program is set up for use on English or Metric projects 

This program can also be activated from the MicroStation drop down menu  
TDOT > Profiles >  Vertical Alignment Labeler 
or by using the keyin  
vba run [VA_Labeler]modStartUp.label_VApts 
Special Requirements: 
A Geopak profile cell must be present.  

Usage: 

Step 1. In D&C manager activate VA Labeler. The 
Label Vertical Alignment dialog is opened. By 
default the type is set to Roadway. Reset Type 
to Special Ditch. 
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Step 2. Click on the Identify Profile Cell command button and data point on the Geopak 
profile cell for the profile. The window shade button on the upper right of the dialog 
can be used to get the dialog out of the way as you identify the profile cell.  Just click 
it again to re-expand the dialog after identifying the cell. 

Note: 
After reading the profile cell and populating the Profile Settings at the top of the 
dialog, the GPK file is read for all profiles/vertical alignments applicable for display 
on this profile and fills the profile list box 

Step 3. Scroll through the Profile list and choose the vertical alignment that you wish to 
annotate. 

Step 4. Set the Scale value as needed. The current active scale is read when the program is 
started to fill in this field automatically. Scale controls text sizes & label offsets. 

Step 5. Finally the label options can be adjusted as needed. The type of profile to be labeled 
determines which default options are turned on.  
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Step 5. Now that all control values are set, click on the Place Labels command button and 
the vertical alignment is annotated. Review the annotation graphics and click the red 
X to close the dialog. 

 
 

 186



Drainage Plan Cells 
D&C location: Drafting Standards > Prop. Drainage > Plan Cells 
MicroStation VBA Program: DrainagePlanCells.mvba 
Description: 
This program provides access to TDOT Design Division drainage plan view cells. 
Command buttons are provided to access TDOT Design Division MicroStation Basic macros 
which are used to draw box culverts/bridges, A, ST, L, SD or U endwalls and drainage flow 
direction plan view graphics. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Plan) > Cells 
or by using the keyin  
vba run [DrainagePlanCells]DrainPLancells.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Plan Cells. The Drainage Plan Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  
This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 
The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Drainage Profile & Culvert Section Cells 
D&C location: Drafting Standards > Prop. Drainage > Profile Cells 
MicroStation VBA Program: DrainageProfileCells.mvba 
Description: 
This program provides access to TDOT Design Division drainage profile and culvert cross 
section cells. 
Command buttons are provided to access TDOT Design Division MicroStation Basic macros 
which are used to draw box culverts/bridges, slab culverts/bridges and pipe profile graphics. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Profile\Culv. Sections) > Cells 
or by using the keyin  
vba run [DrainageProfileCells]DrainProfilecells.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Profile Cells. The Drainage Profile & Culvert Section 

Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  
This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 
The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Pattern Rip-Rap Area 
D&C location: Drafting Standards > Prop. Drainage > Rip-Rap Area 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a rip-rap area 
and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns  
or by using the keyin  
vba run [AreaPatterns]RipRap.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Rip-Rap Area. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Element. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Element, the user is prompted to Identify Element. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Draw Drainage Flow Direction by 2 Points 
D&C location: Drafting Standards > Prop. Drainage > Flow Direction 
MicroStation VBA Program: DrawFlowDirection.mvba 
Description: 
This program is set up for use in placing drainage flow direction graphics for drainage maps, 
creeks, streams or rivers. To use, first check the scale and adjust as needed for the final plot 
scale. Then click the Draw Flow command button to start placement. The user is first promptesd 
for a point for the arrowhead. Once this point is given,the arrowhead and leader line are shown 
dynamically and the user is prompted for a second point to set the end of the leader line. All 
graphics are combined in a graphic group. 
Scale controls the arrowhead size. The standard small drainage arrowhead is placed by this 
program. If the given scale value is reset, it will be necessary to re-start the command by clicking 
on the Draw Flow command button again. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > Drainage (Plan) > Draw Flow Direction 
or by using the keyin  
vba run [DrawFlowDirection]DrawDrainageFlow.main   

Special Requirements: 
None 

Usage: 

Step 1. In D&C manager activate Flow Direction. The Draw Drainage Flow Direction by 2 
Points dialog opens. The only entry field is Scale which reflects the current active 
scale. Reset this value if needed and click on the Draw Flow button. 

 

Step 2. You are then prompted to Identify Point for Arrowhead. Data point at the location 
for the arrowhead. 
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Step 3. You are then prompted to Identify End of Leader Line. Data point at the location 
for the other end of the leader line. 

 
The leader line and the arrowhead are drawn in the file. You can continue to place 
additional flow direction indicators if desired. These graphics are a graphic group so they 
can easily be moved if needed.  

 

This application can also be used to develop flow patterns for a drainage map. 
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Place Proposed Storm Drainage Pipe Label 
D&C location: Drafting Standards > Prop. Drainage > Label ST Pipe 
MicroStation VBA Program: StormDrainagePipeLabel.mvba 
Description: 
This program places proposed storm drainage pipe labels. It is intended for use on short pipes 
which canot display the size portion of the storm drainage pipe custom line style. It includes an 
option to identify the pipe to automatically set up the desired label text. An option to place the 
label as a flag with terminator is provided. The current active scale is shown with a keyin field to 
reset as needed. Scale is used to control the size of label text and terminator. 

If the initial scale given was in error, it is necessary to re-start the command by clicking on the 
Place Label command button after reseting the given scale value. The terminator option can be 
reset at any time during label placement.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Drainage (Plan) > Place Storm Drainage Pipe Label  
or by using the keyin  
vba run [StormDrainagePipeLabel]StormDrainagePipe.main   

Special Requirements: 
Storm drainage  pipe must be drawn with the correct level and symbology for the Identify Pipe 
function. 

Usage: 

Step 1. In D&C manager activate Label ST Pipe. The Place Prop. Storm Drainage Pipe 
Label dialog appears. When started program immediately prompts user to Identify 
Element for annotation.  
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Step 2. Adjust the Scale shown on the dialog if needed and then Data point on the pipe line 
element that you wish to label. As an alternative, the user can enter the label text in its 
keyin field manually. 

 

Step 3. After giving a point to accept the element selected, the dialog is populated with label 
information and the label text appears on the cursor. The user is prompted to Identify 
location for text.  

 

After the text location point is given, the text remains available for additional 
placements as needed. A reset will stop text placement and restart the tool to identify 
another pipe. 
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If the dialog is populated with label information but the user does something else such 
as setting symbologies, the Place Label command button can be used to go on and 
place that label afterwards. 

When other tools are accessed, the Identify Pipe command button can be clicked to 
restart the tool.  

Label placement with Leader line as a Flag: 
Step 1. With the Place Prop. Storm Drainage Pipe Label dialog open, click on the option to 

Place Label as Flag and choose the Terminator Type if one is desired. Following 
prompts, Identify Element for annotation. 

This option is most often used when in tight places or when labeling short elements. 

Step 2. After giving a point to accept the element selected, the dialog is populated with label 
information and the user is prompted to Identify location for End of Leader.  

Data point on or near the element being labeled and you are prompted to Position 
Label . Movement of the cursor allows dynamic control of the leader line to the label 
text. 

 

After the label location point is given, the user is again prompted for the end of the 
leader point allowing for additional placements as needed. A reset will stop label 
placement and restart the tool. 
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 Guardrail  
Draw Vehicle Trajectory Path 
D&C location: Drafting Standards > Guardrail > Vehicle Path 
MicroStation Basic Program: traject.ba 
Description: 
This application used draw a vehicle trajectory path to help determine the point of need for 
guardrail.  

The vehicle path is placed at a user defined angle from the edge of the traveled way in tangent 
sections and in curves a tangent is generated from the curve element. 

This macro can also be activated by using the keyin  
macro traject.   

Special Requirements: 
The edge of traveled way linework (prop. edge of pavement and/or centerline) and hazard 
location must be drawn in the file.  

When placement is near the end of tangent sections then the path should be checked since it may 
start beyond the end of the tangent. 

When the path falls within a spiral or curve then good engineering judgment should be used to 
ensure adequate protection from the hazard.  

In spirals you may wish to use a path located by divergent angle based on the tangent near the 
beginning of the spiral and a tangent line from the spiral as it nears the curve. Since Geopak uses 
curve strings to plot in spirals then only tangent paths can be placed from spirals using this 
program. 

Usage: 

Step 1. Locate hazard locations and display centerline and edge of proposed pavements. 

Step 2. In D&C manager activate Vehicle Path. The Draw Vehicle Trajectory Path dialog 
opens. It contains the following settings to control the program's function: 
 
Alignment Orientation : Tangent Section or Curve Section 
 For tangent sections a line is drawn at the given angle from the edge of the 
 traveled way to the hazard.  For curve sections a line tangent to the curve is drawn 
 from the edge of the traveled way to the hazard. 
 
Path to Hazard Location: Begin or End & Left or Right. 
 This is the general location of where the path originates in relation to the hazard 
 going forward along the centerline. 
 
Tangent Trajectory Angle: numeric value. 
 This is the angle which will be used to draw trajectory paths from tangents. 
 Default value of 15 degrees is given. 
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Make settings as needed and click on the Draw Trajectory Line button. 

 

Step 3. You are then prompted to Identify edge of travel way. Data point on the edge of 
pavement or centerline. In this example we are working with a 2 lane roadway in a 
tangent section at the beginning of a bridge on the left so we data point on the 
centerline for that location. 
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Step 4. The trajectory line appears floating along the centerline and you are then prompted to 
Identify Hazard Location. I our example the first hazard is a 2:1 slope prior to the 
bridge so we snap to that slope tie and Data point. The path line is drawn and the 
Draw Vehicle Trajectory Path dialog re-appears. 

 

Step 5. You can click Cancel to quit or make new settings and click Draw Trajectory Line 
to place another trajectory line. In our example we reset it to Begin Right to continue. 
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Step 6. Repeating steps 3 & 4 this time we identify the right edge of pavement and data point 
at the beginning of 2:1 slopes on the right side. 

 

Step 7. In our example the roadway approach at the end of the bridge is in a curve so we reset 
the Alignment Orientation to a Curve Section, the  Path to Hazard Location to End 
Left and click Draw Trajectory Line to continue. 
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Step 8. Repeating steps 3 & 4 this time we identify the left edge of pavement past the bridge 
in the curve and data point at the end of 2:1 slopes on the left side. A curve tangent 
path line is drawn.  After  resetting to End Right we attempt to place a tangent from 
the centerline to the end of 2:1 slopes on the right.  

 

Since a tangent cannot be placed on the inside of a curve the following error message is 
displayed. Good engineering judgment will have to be used in areas such as this one.    

 
 

WARNING:  
Anytime the trajectory path begins within a spiral or curve then good engineering 
judgment should always be used to ensure adequate protection from the hazard. 
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Place Bridge End Guardrail 
D&C location: Drafting Standards > Guardrail > GR Br End Prop. 
Geopak 3PC Program: place_Br_end_GR.x 
Description: 
This application plots the standard length of  bridge end guardrail (26' 10 3/4") with the 
appropriate custom linestyle.  

This 3PC is used to plot the bridge end guardrail  separately when minimum installations of 
guardrail at bridge ends which already include this guardrail section do not provide adequate 
protection.  

Locations for guardrail are plotted by station and offset to directly reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
Bridge end location for beginning of guardrail must be located graphically so that it  can be 
identified when using program. 

Usage: 

Step 1. Locate bridge end location for beginning of guardrail. 

 Step 2. In D&C manager activate GR Br End Prop.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 
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Step 5. You are then prompted for the guardrail location in relation to the bridge end, Begin 
or End and Left or Right (going in the direction of the centerline). Pick the 
appropriate option from the list box and click OK. 

 

Step 6. You are then prompted to Snap & Data end of the bridge Rail where the guardrail 
begins.  Snap and Data Point at that location. 

 

The standard length of bridge end guardrail (26' 10 3/4") is drawn in using the 
appropriate custom linestyle. 
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 Place Type 12 Guardrail Terminal   
D&C location: Drafting Standards > Guardrail > GR TermType 12 
Geopak 3PC Program: place_12_terminal_EQ.x 
Description: 
This application takes input for job number, chain name, location on the guardrail run (begin or 
end) and user supplied data points for the point of need location at the ditch line & location of 
GR at the roadside and then plots the guardrail terminal, the flare taper and 50’ curve to tie to the 
guardrail at the roadside at the appropriate custom linestyle. A type text label is also placed for 
the terminal. After ploting in the terminal and its associated guardrail then the special slope limit 
lines used by cross section criteria to show pads and alter side slopes are also plotted on level 
DESIGN - TRANSPORTATION - GR Special Slope Limit Lines.  

Approach length of the alternate slope area is controlled by values generated from the point of 
need guardrail equation. 

Locations for guardrail and special slope limit lines are plotted by station and offset to directly 
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
Point of need at ditch line and guardrail offset location at roadside must be located graphically so 
that they  can be identified when using program.  
The following numeric values must be known from the point of need guardrail equation  
(see Std Dwg. No. S-GR-21):  
Runout Length (LR from equation) 
Length from point of need to hazard (x from equation)  
Offset distance from edge of travel lane to tangent section of guardrail (L2 from equation). 

Usage: 

Step 1. Locate point of need at ditch line and guardrail offset location at roadside. 

 Step 2. In D&C manager activate GR Term Type 12.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

 204



 

Step 5. You are then prompted for the terminal location in the guardrail run, Begin or End 
and Left or Right (going in the direction of the centerline). Pick the appropriate 
option from the list box and click OK. 

 

Step 5. You are then prompted for the Taper Flare Rate_Speed(mph), 15:1_70, 14:1_60, 
11:1_50, 8:1_40 or 7:1_30. Pick the appropriate value from the list box and click 
OK. 

 

Step 6. You are then prompted to Keyin approach length (Runout length Lr – x). From the 
guardrail equation take the runout length value LR and subtract the calculated 
distance to the point of need x to determine the approach length.  Enter the resulting 
value and click OK. 

 

Step 7. You are then prompted to Keyin Guardrail offset value L2. This is the offset 
distance from the edge of the travel lane to the tangent section of guardrail which is 
variable L2 from the guardrail equation. Usually this will be at the back of the graded 
shoulder and is the shoulder width. Enter the requested value and click OK. 
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Step 6. You are then prompted for the Point of Need at Ditch. Snap to that location and 
Data Point. 

 

 

Step 7. Finally you are prompted to Data on guardrail at roadside.  Snap and Data Point 
on the guardrail anywhere along the roadway. This does not have to be at any critical 
location in the guardrail line. The location where the 13:1 taper starts will be 
calculated and located by the program. 

 

Step 8. All line work is plotted in the file based on the given information. Use MicroStation's 
modify commands to adjust the guardrail run along the roadway to end where curve 
into 15:1 taper begins. 

 

Special slope limit lines are placed on level DESIGN - TRANSPORTATION - GR 
Special Slope Limit Lines. It may be necessary to turn that level on to see them after 
processing. 
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Place Type 13 Guardrail Terminal 
D&C location: Drafting Standards > Guardrail > GR Term Type 13 
Geopak 3PC Program: place_13_terminal.x 
Description: 
This application places a type 13 guardrail terminal cell,  a type text label and a point at the 
terminal location for later use in calculating quantities.  

Special Requirements: 
Terminal location at guardrail along roadside must be located graphically so that it  can be 
identified when using program. 

Usage: 

Step 1. Locate terminal location at guardrail along roadside. For the type 13 terminal this is 
6.25' past the end of hazard location (except for median bridge pier protection 
which requires a minimum distance of 12.5' past the pier). 

 Step 2. In D&C manager activate GR Term Type 13.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

 

Step 5. You are then prompted for the terminal location in the guardrail run, Begin or End 
and Left or Right (going in the direction of the centerline). Pick the appropriate 
option from the list box and click OK. 
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Step 6. Finally you are prompted to Snap & Data terminal location.  Snap and Data Point 
on the guardrail at the terminal location.  

 

All graphics are placed in the file based on the given information. 
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 Place Type 21 Guardrail Terminal 
D&C location: Drafting Standards > Guardrail > GR Term Type 21 
Geopak 3PC Program: place_21_terminal.x 
Description: 
This application plots a type 21 guardrail terminal with the appropriate custom linestyle and 
terminal end cap. A type text label is placed for the terminal. The special slope limit lines used 
by cross section criteria to show pads and alter side slopes are also plotted on level DESIGN - 
TRANSPORTATION - GR Special Slope Limit Lines.  

Locations for guardrail and special slope limit lines are plotted by station and offset to directly 
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
Terminal beginning location at guardrail along roadside must be located graphically so that it  
can be identified when using program. 

Usage: 

Step 1. Locate beginning of terminal location at guardrail along roadside. For the type 21 
terminal this is 12.5' back from the point of need location. 

 Step 2. In D&C manager activate GR Term Type 21.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

 

Step 5. You are then prompted for the terminal location in the guardrail run, Begin or End 
and Left or Right (going in the direction of the centerline). Pick the appropriate 
option from the list box and click OK. 
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Step 6. Finally you are prompted to Snap & Data terminal location. Snap and Data Point 
on the guardrail at the terminal location.  

 

All line work is plotted in the file based on the given information.  

 

 

Special slope limit lines are placed on level DESIGN - TRANSPORTATION - GR 
Special Slope Limit Lines. It may be necessary to turn that level on to see them after 
processing. 
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Place Type 21 GR Terminal - Minimum Installation at Br. End 
D&C location: Drafting Standards > Guardrail > GR Min Inst 21 
Geopak 3PC Program: place_21_min_install.x 
Description: 
This application plots a type 21 guardrail terminal, regular guardrail and bridge end guardrail 
with the appropriate custom linestyles and terminal end cap for a minimum installation at a 
bridge end. A type text label is placed for the terminal. The special slope limit lines used by cross 
section criteria to show pads and alter side slopes are also plotted on level DESIGN - 
TRANSPORTATION - GR Special Slope Limit Lines.  

Locations for guardrail and special slope limit lines are plotted by station and offset to directly 
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
Bridge end location for beginning of guardrail must be located graphically so that it  can be 
identified when using program. 

Usage: 

Step 1. Locate bridge end location for beginning of guardrail. 

 Step 2. In D&C manager activate GR Min Inst 21.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

 

Step 5. You are then prompted for the guardrail location at bridge end, Begin or End and 
Left or Right (going in the direction of the centerline). Pick the appropriate option 
from the list box and click OK. 
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Step 6. Finally you are prompted to Snap & Data GR begin location.  Snap and Data Point 
on the bridge end where guardrail begins.  

 

All line work is plotted in the file based on the given information.  

 

 

Special slope limit lines are placed on level DESIGN - TRANSPORTATION - GR 
Special Slope Limit Lines. It may be necessary to turn that level on to see them after 
processing. 
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Place Type 21 GR Terminal (ADT<=400) - Minimum Installation at Br. End  
D&C location: Drafting Standards > Guardrail > GR Min Inst 400 
Geopak 3PC Program: place_21_400_min_install.x 
Description: 
This application plots a type 21 guardrail terminal and bridge end guardrail with the appropriate 
custom linestyles and terminal end cap for a minimum installation at a bridge end. This tool is set 
up specifically for roadways with ADT<=400. A type text label is placed for the terminal.  

Locations for guardrail lines are plotted by station and offset to directly reflect alignment 
conditions. 

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
Bridge end location for beginning of guardrail must be located graphically so that it  can be 
identified when using program. 

Usage: 

Step 1. Locate bridge end location for beginning of guardrail. 

 Step 2. In D&C manager activate GR Min Inst 400.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 
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Step 5. You are then prompted for the guardrail location at bridge end, Begin or End and 
Left or Right (going in the direction of the centerline). Pick the appropriate option 
from the list box and click OK. 

 

Step 6. Finally you are prompted to Snap & Data GR begin location.  Snap and Data Point 
on the bridge end where guardrail begins.  

 

All line work is plotted in the file based on the given information.  
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Place Type 38 Guardrail Terminal 
D&C location: Drafting Standards > Guardrail > GR Term Type 38 
Geopak 3PC Program: place_38_terminal.x 
Description: 
This application plots a type 38 guardrail terminal with the appropriate custom linestyle and 
terminal end cap. A type text label is placed for the terminal. The special slope limit lines used 
by cross section criteria to show pads and alter side slopes are also plotted on level DESIGN - 
TRANSPORTATION - GR Special Slope Limit Lines.  

Locations for guardrail and special slope limit lines are plotted by station and offset to directly 
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
Terminal beginning location at guardrail along roadside must be located graphically so that it  
can be identified when using program. 

Usage: 

Step 1. Locate beginning of terminal location at guardrail along roadside. For the type 38 
terminal this is 37.5' back from the point of need location. 

 Step 2. In D&C manager activate GR Term Type 38.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

 

Step 5. You are then prompted for the terminal location in the guardrail run, Begin or End 
and Left or Right (going in the direction of the centerline). Pick the appropriate 
option from the list box and click OK. 
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Step 6. Finally you are prompted to Snap & Data terminal location.  Snap and Data Point 
on the guardrail at the terminal location.  

 

All line work is plotted in the file based on the given information.  

 

 

Special slope limit lines are placed on level DESIGN - TRANSPORTATION - GR 
Special Slope Limit Lines. It may be necessary to turn that level on to see them after 
processing. 

 

 216



Place Type 38 GR Terminal - Minimum Installation at Br. End 
D&C location: Drafting Standards > Guardrail > GR Min Inst 38 
Geopak 3PC Program: place_38_min_install.x 
Description: 
This application plots a type 38 guardrail terminal and bridge end guardrail with the appropriate 
custom linestyles and terminal end cap for a minimum installation at a bridge end. A type text 
label is placed for the terminal. The special slope limit lines used by cross section criteria to 
show pads and alter side slopes are also plotted on level DESIGN - TRANSPORTATION - GR 
Special Slope Limit Lines.  

Locations for guardrail and special slope limit lines are plotted by station and offset to directly 
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
Bridge end location for beginning of guardrail must be located graphically so that it  can be 
identified when using program. 

Usage: 
This option functions just the same as Place Type 21 GR Terminal - Minimum Installation at 
Br. End. See the description of it's usage for details. 
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Place Type In-Line Guardrail Terminal  
D&C location: Drafting Standards > Guardrail > GR Term In-Line 
Geopak 3PC Program: place_InLine_terminal.x 
Description: 
This application places a type in-line guardrail terminal cell,  a type text label and a point at the 
terminal location for later use in calculating quantities.  

Special Requirements: 
Guardrail radius location for this terminal must be located graphically so that it  can be identified 
when using program. 

Usage: 

Step 1. Draw guardrail radius along roadway pavement radius. 

 Step 2. In D&C manager activate GR Term In-Line.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

 

Step 5. Finally you are prompted to Snap & Data terminal location.  Snap and Data Point 
at the end of the radius of guardrail for the terminal location.  
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Step 6. All graphics are placed in the file based on the given information. Move text label as 
needed for clarity and if needed add a leader line. 
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Place Median Guardrail - Minimum Installation at Br. End 
D&C location: Drafting Standards > Guardrail > Median GR > GR Min Inst Med  
Geopak 3PC Program: place_median_min_br_end.x 
Description: 
This application plots in the minimum length of guardrail required in the median at tangent non-
skewed bridges with the appropriate custom linestyle and terminal end cap. A type text label is 
placed for the terminal. The special slope limit lines used by cross section criteria to alter median 
slopes are also plotted on level DESIGN - TRANSPORTATION - GR Special Slope Limit 
Lines.  

Locations for guardrail and special slope limit lines are plotted by station and offset to directly 
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
Bridge end location for beginning of guardrail must be located graphically so that it  can be 
identified when using program. 

Usage: 

Step 1. Locate bridge end location for beginning of guardrail.  

 Step 2. In D&C manager activate GR Min Inst Med.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 
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Step 5. You are then prompted for the median width (30'. 36', 48', 60' or 64'). This refers to 
distance between the inside edges of the proposed travel lanes. Pick the appropriate 
width from the list box and click OK. 

 

Step 6. You are then prompted for the guardrail location on the bridge end, Begin (on right 
bridge) or End (on left bridge). Pick the appropriate option from the list box and click 
OK. 

 

Step 7. Finally you are prompted to Snap & Data end of Bridge Rail.  Snap and Data Point 
on the end of the bridge where guardrail begins.  

 

All line work is plotted in the file based on the given information.  
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After completion of graphics the following warning message is given reminding the 
user that this guardrail layout is based on a tangent roadway with 2 non-skewed 
bridges. If either of these are not true for this installation or your design speed is 
greater than 60 miles per hour then the guardrail  should be checked for 
adequate coverage of the hazard. 

 
 

 

Note that in cases where this standard length of rail does not provide adequate coverage 
then additional rail can be added and then Place Median Br. End Guardrail can be used 
to plot in the guardrail from the 50' curve through the terminal. 
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Place Median Br. End Guardrail 
D&C location: Drafting Standards > Guardrail > Median GR > GR Med Br Ends  
Geopak 3PC Program: place_median_br_end_prot.x 
Description: 
This application places guardrail from the beginning of the 50' curve through the taper to the 
terminal in the median at bridge ends. It is intended for use in areas where the minimum 
installation is not adequate due to design speed, curvature or skewed bridges. After setting up the 
bridge end rail and the extra regular rail for additional protection then this program can be 
utilized to plot in the remaining guardrail with terminal using the appropriate custom linestyle 
and terminal end cap. A type text label is placed for the terminal. The special slope limit lines 
used by cross section criteria to alter median slopes are also plotted on level DESIGN - 
TRANSPORTATION - GR Special Slope Limit Lines.  

Locations for guardrail and special slope limit lines are plotted by station and offset to directly 
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
End of guardrail beside shoulder / beginning of 50' guardrail curve location must be located 
graphically so that it  can be identified when using program. 

Usage: 

Step 1. After establishing additional guardrail coverage needed, draw in guardrail beside 
shoulder to location for beginning of 50' guardrail curve.  

 Step 2. In D&C manager activate GR Med Br Ends.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 
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Step 5. You are then prompted for the median width (30'. 36', 48', 60' or 64'). This refers to 
distance between the inside edges of the proposed travel lanes. Pick the appropriate 
width from the list box and click OK. 

 

Step 6. You are then prompted for the guardrail location on the bridge end, Begin (on right 
bridge) or End (on left bridge). Pick the appropriate option from the list box and click 
OK. 

 

Step 7. Finally you are prompted to Snap & Data end of regular GR.  Snap and Data Point 
at the end of the guardrail along the shoulder where the 50' guardrail curve begins.  

 

All line work is plotted in the file based on the given information.  
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Place Median Earth Berm 
D&C location: Drafting Standards > Guardrail > Median GR > GR Med Earth Berm  
Geopak 3PC Program: place_median_earth_berm.x 
Description: 
This application plots in the proposed median earth berm required at the end of bridges. The 
quantity of earth required for the berm in cubic yards is calculated and appended to a CSV file 
named MedianEarthBerms.csv along with the station and chain of the earth berm.  

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
Bridge end locations must be located graphically so that it  can be identified when using 
program. 

Usage: 

Step 1. Locate bridge end locations.  

 Step 2. In D&C manager activate GR Med Earth Berm.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

 

 225



Step 5. You are then prompted for the median width (30'. 36', 48', 60', 64’ or 88'). This 
refers to distance between the inside edges of the proposed travel lanes. Pick the 
appropriate width from the list box and click OK. 

 

Step 6. Next you are prompted to Data at extreme end of BR Rail.  Snap and Data Point at 
the end of the bridge rail of the bridge on left or right that is first encountered moving 
towards the structures from either direction along the roadway centerline.  

 

Step 7. You are then prompted for the median location just given, Begin or End and Left or 
Right (going in the direction of the centerline). Pick the appropriate option from the 
list box and click OK. 

 

All line work is plotted in the file based on the given information.  
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After completion of graphics the quantity of earth required for  the berm in cubic 
yards is calculated and appended to a CSV file named MedianEarthBerms.csv along 
with the station and chain of the earth berm which is indicated to user in the following 
message prompt. 

 

 

Example of berm earthwork data placed in MedianEarthBerms.csv  
(based on 48' median): 

mainline 259+96.23 68
mainline 261+48.57 68
mainline 272+65.15 68
mainline 274+86.06 68
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Place Median Br. Piers Guardrail  
D&C location: Drafting Standards > Guardrail > Median GR > GR Med Br Piers  
Geopak 3PC Program: place_median_br_pier_prot.x 
Description: 
This application places guardrail from the beginning of the 50' curve through the taper to the 
terminal in the median for protection at bridge piers. After setting up the guardrail beside the 
shoulder in front of the bridge piers then this program can be utilized to plot in the remaining 
guardrail with terminal using the appropriate custom linestyle and terminal end cap. A type text 
label is placed for the terminal. The special slope limit lines used by cross section criteria to alter 
median slopes are also plotted on level DESIGN - TRANSPORTATION - GR Special Slope 
Limit Lines.  

Locations for guardrail and special slope limit lines are plotted by station and offset to directly 
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects.  

Special Requirements: 
End of guardrail beside shoulder / beginning of 50' guardrail curve location must be located 
graphically so that it  can be identified when using program. 

Usage: 

Step 1. Draw in guardrail beside shoulder to location for beginning of 50' guardrail curve.  

 Step 2. In D&C manager activate GR Med Br Piers.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 
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Step 5. You are then prompted for the median width (30'. 36', 48', 60' or 64'). This refers to 
distance between the inside edges of the proposed travel lanes. Pick the appropriate 
width from the list box and click OK. 

 

Step 6. You are then prompted for the guardrail location near the bridge pier, Begin (on right 
bridge) or End (on left bridge). Pick the appropriate option from the list box and click 
OK. 

 

Step 7. Finally you are prompted to Snap & Data end of regular GR.  Snap and Data Point 
at the end of the guardrail along the shoulder where the 50' guardrail curve begins.  

 

All line work is plotted in the file based on the given information.  
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After completion of graphics the following warning message is given reminding the 
user that if the roadway is in a curve, the bridges are skewed or if the design 
speed is greater than 60 miles per hour then the guardrail  should be checked for 
adequate coverage of the hazard. 
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 Erosion Control 
Erosion Control Device Cells 
D&C location: Drafting Standards > Erosion Control > EC Device Cells 
MicroStation VBA Program: ErosionControlCells.mvba 
Description: 
This program provides access to TDOT Design Division erosion control device cells. 
Command buttons are provided to access the vba programs used to area pattern dewatering 
structures, erosion control blankets, turf reinforcement mats, slope surface roughening or rip-rap. 
Command buttons are provided to access vba programs Draw Permanent Slope Drains, Draw 
Temporary Slope Drains, Place Filter Assembly by Catch Basin Type, Proposed Trees and Label 
Storm Water Outfalls. 
A command button is provided to access the Erosion Control Legend cell dialog. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Erosion Control > Device Cells 
or by using the keyin  
vba run [ErosionControlCells]ErosionCntrlcells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate EC Device Cells. The Erosion Control Device Cells 

dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 
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Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  
This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 
Any of these cell placement options can also be used in conjunction with Geopak’s 
DP Station/Offset tool to place the cell at a specific station and offset along the 
horizontal alignment. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

Erosion Control Legend Cells 
D&C location: Drafting Standards > Erosion Control > EC Legend Cells 
MicroStation VBA Program: ErosionControlLegendCells.mvba 
Description: 
This program provides access to TDOT Design Division erosion control legend cells. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Erosion Control > Legend Cells 
or by using the keyin  
vba run [ErosionControlLegendCells]ErosionCntrlLegendcells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate EC Legend Cells. The Erosion Control Legend Cells 

dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  
The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Draw Temporary Slope Drain 
D&C location: Drafting Standards > Erosion Control > Tmp Slope Drain 
MicroStation VBA Program: DrawTempSlopeDrain.mvba 
Description: 
This program draws in a temporary slope drain with inlet synmbol and optional rip-rap at the 
outlet end. The pipe is drawn in with the appropriate custom line style. Geopak Adhoc data for 
pay item number, description, unit and roadway side slope is added to the pipe line element so 
that quantities can be calulated later by Geopaks D&C Manager. The side slope value is used 
during final quantity calculations to adjust the measured horizontal length of pipe since these 
pipes follow the roadway slope.  
On the Draw Temporary Slope Drain dialog is a command button for Pay Item Info. When the 
user clicks on this option, the User Specified Pay Item Values dialog opens. This dialog contains 
fields for entering pay item number, description, unit and roadway side slope information. A 
Modify Pay Item Values command button is provided to change data assigned to previously 
placed graphics. The Read Element command button on the dialog is provided to check the pay 
item values from slope drains placed previously. For both of these functions, once activated, 
identify any slope drain and its values are changed or read and used to populate the dialog. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > Erosion Control > Temporary Slope Drains  
or by using the keyin  
vba run [DrawTempSlopeDrain]TempSlopeDrain.main  
Special Requirements: 
The slope lines and earth berm lines must be drawn/located in the plan view.  

Usage: 

Step 1. In D&C manager activate Tmp Slope Drain. The Draw Temporary Slope Drain 
dialog opens.  

Defaults are set to Pipe Size: 12 in/300 mm and Side Slope: 6:1.  Scale defaults to 
active scale set in the MicroStation DGN file. 

 

Step 2. Make settings in the dialog as needed for the slope drain you need to draw. Once 
settings are made click on the Draw Slope Drain button. 

Step 3. You are then prompted to Identify Point at Inlet. Data point at the location where 
the inlet is to be placed. 
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Step 4. After the initial data point, the inlet, pipe are and rip-rap outlet pad are shown 
dynamically and the user is prompted to Identify Outlet point. Data point at the 
location for the outlet. 

 

Step 6. After giving this last point, all slope drain graphics are placed in the file.   

 

Step 7. You can adjust settings if needed and continue to place additional slope drains. 
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Usage:  Pay Item Info 

Step 1. If you wish to assign, modify or just check the pay item values which are assigned to 
a slope drain, click on the Pay Item Info command button on the Draw Temporary 
Slope Drain dialog. The User Specified Pay Item Values dialog opens. This dialog 
contains fields for entering pay item number, description, unit and roadway side slope 
information.  

 

Step 2. To assign or modify the pay item values for a slope drain, first enter the information 
in the data entry fields provided. Any standard item number for slope drain pipe will 
automatically update the description field. When data has been entered, click on the 
Modify Pay Item Values command button and you are prompted to Data point on 
slope drain pipe. Data point on the slope drain pipe.   
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Once identified, Data point again to accept and assign the pay item values. This 
function can be used to assign pay item values to slope drains that were placed prior 
to the implementation of this tool. 

Step 3. To check the pay item values assigned to a slope drain that has been placed 
previously, then click the Read Element command button on the User Specified Pay 
Item Values dialog. The user is prompted to Data point on slope drain pipe. Once 
accepted, the pay item values are read from the pipe element and are used to populate 
the dialog.  
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Place Filter Assembly by CB Type 
D&C location: Drafting Standards > Erosion Control > Place FA by CB 
MicroStation VBA Program: IDCBandPlaceFilterAssembly.mvba 
Description: 
This program places the appropriate erosion control filter assembly cell for any identified catch 
basin cell. The catch basin cells are placed automatically when defined with Geopak Drainage. 
The current active scale is shown with a keyin field to reset as needed. Scale is used to control 
the size of cells. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Erosion Control > Place Filter Assembly by CB Type 
or by using the keyin  
vba run [IDCBandPlaceFilterAssembly]IDandPlaceFA.main 
Special Requirements: 
Previous placement of special catch basin cells which indicate size of sub-structure. 
Usage: 
Step 1. In D&C manager activate Place FA by CB. The Place Filter Assembly by CB Type 

dialog appears. 

 
Step 2. Check the scale and then click on the Identify Catch Basin and Place Filter 

Assembly  command button to start. 

Step 3. The user is first prompted to Identify CB. Data point on the catch basin cell. 
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Step 4. When a data point is given to accept the cell, the program reads the cell name and 
then activates the appropriate filter assembly cell which appears dynamically on the 
cursor point. You are then prompted to Identify Location for placement. Data point 
near the center of catch basin symbol. 

 
Step 5. Once this point is given, the filter assembly cell is put into a spin and you are 

prompted to Identify Point to set Cell Angle. 

 
This final point finishes placement of the filter assembly cell and your are again 
prompted to Identify CB, allowing you to continue placements. 
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Label EPSC Storm Water Outfalls 
D&C location: Drafting Standards > Erosion Control > Label Outfalls 
MicroStation VBA Program: LabelEPSCStormWaterOutfalls.mvba 
Description: 
This program places storm water outfall labels on EPSC sheets. The current active scale is shown 
with a keyin field to reset as needed. Scale is used to control the text size and arrowhead size in 
the label. All graphics are added to a graphic group. An option is provided to increment the 
number in the label after each placement. 
If the initial scale given was in error, it is necessary to re-start the command by clicking on the 
Place Label command button after resetting the given scale value. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > Erosion Control > Label Storm Water Outfalls  
or by using the keyin  
vba run [LabelEPSCStormWaterOutfalls]LabelOutfalls.main  
Special Requirements: 
None  

Usage: 

Step 1. In D&C manager activate Label Outfalls. The Label EPSC Storm Water Outfalls 
dialog opens.  

The Outfall Label Text is set to OUT - 1 by default.  Scale defaults to active scale set 
in the MicroStation DGN file. 

 

Step 2. Make settings in the dialog as needed. Set the beginning outfall number and if desired 
change the prefix text or add a suffix letter. If more than one outfall needs to be 
labeled with that number, turn off the Auto Increment Label Number option. Reset 
the Scale if not correct. Once settings are made, click on the Place Label button. 
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Step 3. The label text in an ellipse shows dynamically on the cursor and you are prompted to 
Identify Location. Data point at the location for the label text. 

 

Step 4. After the initial data point, the leader line with arrowhead is shown dynamically and 
the user is prompted to Place Leader end point. Data point at the location for the 
leader line end. 
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Step 6. After giving this last point, the leader line and arrowhead are placed in the file.   

 

Step 7. If the Auto Increment Label Number option is clicked on, the label text is updated 
to the next number preserving the current prefix and any suffix the text label may 
contain. You can continue to place additional labels. 

If the increment option is off and you need to place additional labels there, update the 
suffix letter and place the label(s).  

Whenever you stop placement temporarily to do other things, the Place Label button 
can be clicked to restart labeling storm water outfalls. 
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Pattern Dewatering Structure 
D&C location: Drafting Standards > Erosion Control > Dewatering Stru 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a dewatering 
structure and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Erosion Control > Dewatering Structure AP 
using the keyin  
vba run [AreaPatterns]DewateringStructure.SetPattern   

Special Requirements: 
This item used with D&C Manager's Place influence mode can be used along with MicroStation 
to define the dewatering structure limit with a shape or other elements prior to applying pattern 
using program. 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Dewatering Stru. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Element. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Element, the user is prompted to Identify Element. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Pattern Slope Surface Roughening Area 
D&C location: Drafting Standards > Erosion Control > Slope Roughen 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a slope 
surface roughening area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Erosion Control > Slope Surface Roughening AP 
or by using the keyin  
vba run [AreaPatterns]SlopeSurfaceRoughening.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Slope Roughen. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Pattern Erosion Control Rip-Rap Area 
D&C location: Drafting Standards > Erosion Control > EC Rip-Rap Area 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern an erosion 
control rip-rap area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Erosion Control > Rip-Rap AP  
or by using the keyin  
vba run [AreaPatterns]RipRapEC.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate EC Rip-Rap Area. The Pattern Area tool is activated 
with the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Element. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Element, the user is prompted to Identify Element. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 

 

 250



Draw Permanent Slope Drain 
D&C location: Drafting Standards > Erosion Control > Perm Slope Drain 
MicroStation VBA Program: DrawPermSlopeDrain.mvba 
Description: 
This program draws in a permanent slope drain with inlet symbol and rip-rap pad at the outlet 
end. The pipe is drawn in with the appropriate custom line style. Geopak Adhoc data for pay 
item number, description, unit and roadway side slope is added to the pipe line element so that 
quantities can be calculated later by Geopak's D&C Manager. The pipe size and side slope value 
are used to calculate the 45 degree bend location in the slope drain pipe. During final quantity 
calculations the side slope is used to adjust the measured horizontal length of pipe since these 
pipes follow the roadway slope. 
On the Draw Permanent Slope Drain dialog is a command button for Pay Item Info. When the 
user clicks on this option, the User Specified Pay Item Values dialog opens. This dialog contains 
fields for entering pay item number, description, unit and roadway side slope information. A 
Modify Pay Item Values command button is provided to change data assigned to previously 
placed graphics. The Read Element command button on the dialog is provided to check the pay 
item values from slope drains placed previously. For both of these functions, once activated, 
identify any slope drain and its values are changed or read and used to populate the dialog. 
This macro can also be activated from the MicroStation drop down menu  
TDOT > Eroasion Control > Permanent Slope Drains  
or by using the keyin  
vba run [DrawPermSlopeDrain]PermSlopeDrain.main  
Special Requirements: 
The slope lines and ditch line must be drawn/located in the plan view.  

Usage: 

Step 1. In D&C manager activate Perm Slope Drain. The Draw Permanent Slope Drain 
dialog opens.  

Defaults are set to Pipe Size: 18 in/450 mm and Side Slope: 4:1.  Scale defaults to 
active scale set in the MicroStation DGN file. 

 

Step 2. Make settings in the dialog as needed for the slope drain you need to draw. Once 
settings are made click on the Draw Slope Drain button. 

Step 3. You are then prompted to Identify Point at Inlet. Snap and Data point at the slope 
line location where the inlet is to be placed. 
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Step 4. After the initial data point, the inlet and pipe are shown dynamically and the user is 
prompted to ID Point Perpendicular at Ditch. Snap and Data point at the ditch line 
location where the pipe is perpendicular to the ditch. 

 

The program then uses the settings given for side slope & pipe size to calculate the 45 
degree bend location in the pipe back from the ditch. 

Step 5. The completed slope drain pipe with rip-rap outlet pad is shown dynamically and the 
user is prompted to ID Side\Direction for Outlet. Data point to indicate the 
direction of flow in the ditch. 
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Step 6. After giving this last point, all slope drain graphics are placed in the file.   

 

Step 7. You can adjust settings if needed and continue to place additional slope drains. 

Usage:  Pay Item Info 

Step 1. If you wish to assign, modify or just check the pay item values which are assigned to 
a slope drain, click on the Pay Item Info command button on the Draw Permanent 
Slope Drain dialog. The User Specified Pay Item Values dialog opens. This dialog 
contains fields for entering pay item number, description, unit and roadway side slope 
information.  
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Step 2. To assign or modify the pay item values for a slope drain, first enter the information 
in the data entry fields provided. Any standard item number for slope drain pipe will 
automatically update the description field. When data has been entered, click on the 
Modify Pay Item Values command button and you are prompted to Data point on 
slope drain pipe. Data point on the slope drain pipe.   

 
Once identified, Data point again to accept and assign the pay item values. This 
function can be used to assign pay item values to slope drains that were placed prior 
to the implementation of this tool. 

Step 3. To check the pay item values assigned to a slope drain that has been placed 
previously, then click the Read Element command button on the User Specified Pay 
Item Values dialog. The user is prompted to Data point on slope drain pipe. Once 
accepted, the pay item values are read from the pipe element and are used to populate 
the dialog.  
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Place Proposed Trees 
D&C location: Drafting Standards > Erosion Control > Place Prop Trees 
MicroStation VBA Program: PlaceProposedTrees.mvba 
Description: 
This program places proposed trees and adds Geopak adhoc data for pay item number, 
description, unit and quantity information to the cell element. This data is used later  by 
Geopak’s D&C Manager to compile final quantities. The size of the tree cell is controlled by the 
current active scale which is shown on the dialog for adjustment as needed. 
At the end of the list on the Place Proposed Tree dialog is an option for a user specified tree. 
When the user clicks on this option, the User Specified Pay Item Values dialog opens. This 
dialog contains fields for entering pay item number, description, unit and quantity information. 
Once data is entered the user must click on the Apply Pay Item Values command button to 
assign the values entered and re-start the Place Tree function. The Read Element command 
button on the dialog is provided in case the user wishes to duplicate the pay item values from a 
tree placed previously. Once activated, identify any tree and its values are used to populate the 
dialog. This can also be used to just check trees already placed. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Erosion Control > Place Proposed Trees 
or by using the keyin  
vba run [PlaceProposedTrees]PropTrees.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Place Prop Trees. The Place Proposed Trees dialog 

appears. 

 

The current active scale is read and populated in the Scale key in field. Adjust the 
scale as needed. 
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Step 2. The Place Proposed Tree dialog includes all standard proposed tree pay items which 
can be chosen for placement. After selection, the Place Tree function is activated so 
that the chosen tree can be placed. Data point when satisfied with the location.  

 

At any time, the user can pick a different tree type for placement. The Place Tree 
command button is provided so that when other MicroStation tools are used, the Place 
Tree function can be re-started. 

Step 3. If proposed trees other than the standard genus species are required then the user can 
pick the last item in the list for user specified trees. The User Specified Pay Item 
Values dialog opens. This dialog contains fields for entering pay item number, 
description, unit and quantity information.  
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Step 4. Once the pay item information is entered, the user must click on the Apply Pay Item 
Values command button to assign the values entered and re-start the Place Tree 
function.  . 

 
Data point when satisfied with the location. 

Step 5. To check the type of a proposed tree that has been placed previously or to re-call the 
pay item information of a user specified tree type, then click the Read Element 
command button on the User Specified Pay Item Values dialog.  

The user is prompted to Data point on cell. Once accepted, the pay item values are 
read from the tree cell and are used to populate the dialog.  
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Pattern Erosion Control Blanket Area 
D&C location: Drafting Standards > Erosion Control > EC Blankets> EC Blanket AP 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern an erosion 
control blanket area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Erosion Control > Erosion Control Blanket AP  
or by using the keyin  
vba run [AreaPatterns]ErosionControlBlanket.SetPattern   

Special Requirements: 
Create a shape element bounding the area to be patterned using the appropriate item from 
Drafting Standards > Erosion Control > EC Blankets to define the erosion control blanket 
type. 

Usage: 

Step 1. In D&C manager activate EC Blanket AP. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Set the method of placing the area pattern to Element. 

Step 3. The user is prompted to Identify Element. Data point on the erosion comtrol blanket 
shape. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Pattern Turf Reinforcement Mat Area 
D&C location: 
Drafting Standards > Erosion Control > Turf Reinforcement Mats > Turf Mat AP 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern an turf 
reinforcement mat area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Erosion Control > Turf Reinforcement Mat AP  
or by using the keyin  
vba run [AreaPatterns]TurfReinforcementMat.SetPattern   

Special Requirements: 
Create a shape element bounding the area to be patterned using the appropriate item from 
Drafting Standards > Erosion Control > Turf Reinforcement Mats to define the turf 
reinforcement mat class. 

Usage: 

Step 1. In D&C manager activate Turf Mat AP. The Pattern Area tool is activated with the 
appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Set the method of placing the area pattern to Element. 

Step 3. The user is prompted to Identify Element. Data point on the turf reinforcement mat 
shape. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Lighting 
Lighting Cells 
D&C location: Drafting Standards > Lighting > Lighting Cells 
MicroStation VBA Program: LightingCells.mvba 
Description: 
This program provides access to TDOT Design Division lighting cells. 
Command buttons are provided to access the vba programs Place Jacked or Bored Conduit, 
Label Conduit and Label Pull Box. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Lighting > Cells 
or by using the keyin  
vba run [LightingCells]Lightngcells.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Lighting Cells. The Lighting Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  
This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 
Any of these cell placement options can also be used in conjunction with Geopak’s 
DP Station/Offset tool to place the cell at a specific station and offset along the 
horizontal alignment. 
The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Label Conduit 
D&C location: Drafting Standards > Lighting > Label Conduit 
MicroStation VBA Program: LabelConduit.mvba 
Description: 
This program places proposed conduit labels with size & type. A toggle option is given for 
lighting or signalization application which controls the level of placement. It also includes an 
option to identify the conduit or fiber optic line to automatically set up the desired label text. A 
terminator option of a regular or small arrowhead or dot is provided. The current active scale is 
shown with a keyin field to reset as needed. Scale is used to control the size of label text and 
terminator. All label graphics are combined in a graphic group for easy movement or deletion. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Lighting > Label Conduit 
or by using the keyin  
vba run [LabelConduit]IDandLabelConduit.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Label Conduit. The Label Conduit dialog appears. 

 
Step 2. First the signalization or lighting toggle should be set as needed. Then the user either 

enters the label text in its keyin field manually or by using the ID Conduit for Label 
command button to identify the conduit to be labeled in order to fill in the keyin field 
automatically. Click on the ID command button and you are prompted to Identify 
Conduit. Data point on the conduit line and another data point to accept the element. 

 
Conduit must be placed with the correct standard symbology for this function to 
recognize it. An error message is generated for invalid elements. 
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Step 3. To place the label, choose the terminator type desired, check the scale and then click 
on the Place Label command button. You are prompted to Identify location for End 
of Leader. Data point on the conduit line. 

 

Step 4. Once this point is given,  the label is shown dynamically and the user is prompted for 
a second point to Position Label. As the label is moved around the leader is adjusted 
to come from either end of the horizontal line in the label. 

 
Data point when satisfied with the location 
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Step 5. Graphics are placed and combined in a graphic group. At this point the program loops 
back to the prompt to identify location for end of leader allowing for additional 
placements of the label. 

 
If the initial scale given was in error, it is necessary to re-start the command by 
clicking on the Place Label command button after resetting the given scale value. The 
terminator option can be reset at any time during label placement. 
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Label Pull Box 
D&C location: Drafting Standards > Lighting > Label Pull Box 
MicroStation VBA Program: LabelPullBox.mvba 
Description: 
This program places proposed pull box labels. A toggle option is given for lighting or 
signalization application which controls the level of placement. It also includes an option to 
identify the pull box to automatically set up the desired label text. A terminator option of an 
arrowhead (medium), small arrowhead or none is available. The current active scale is shown 
with a keyin field to reset as needed. Scale is used to control the size of label text and terminator. 
All label graphics are combined in a graphic group for easy movement or deletion. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Lighting > Label Pull Box 
or by using the keyin  
vba run [LabelPullBox]IDandLabelPullBox.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Label Pull Box. The Label Pull Box dialog appears. 

 
Step 2. First the signalization or lighting toggle should be set as needed. Then the user either 

enters the label text in its keyin field manually or by using the ID Pull Box for Label 
command button to identify the pull box to be labeled in order to fill in the keyin field 
automatically. Click on the ID command button and you are prompted to Identify 
Pull Box. Data point on the pull box cell and another data point to accept the element. 

 
Pull box cells must be placed on the correct level for this function to recognize it. An 
error message is generated for invalid elements. 
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Step 3. To place the label, choose the terminator type desired, check the scale and then click 
on the Place Label command button. You are prompted to Identify location for End 
of Leader. Data point on the pull box. 

 

Step 4. Once this point is given,  the label is shown dynamically and the user is prompted for 
a second point to Position Label. As the label is moved around the leader is adjusted 
to come from either end of the horizontal line in the label. 

 
Data point when satisfied with the location 
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Step 5. Graphics are placed and combined in a graphic group. At this point the program loops 
back to the prompt to identify location for end of leader allowing for additional 
placements of the label. 

 
If the initial scale given was in error, it is necessary to re-start the command by 
clicking on the Place Label command button after resetting the given scale value. The 
terminator option can be reset at any time during label placement. 
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Place Jacked or Bored Conduit 
D&C location: Drafting Standards > Lighting > Place Jacked 
MicroStation VBA Program: PlaceJackedBoredConduit.mvba 
Description: 
This program places jacked/bored conduit under roadways. A toggle option is given for lighting 
or signalization application which controls the level of placement. Choices are given for the pull 
box type (Type A, Type B, Type C, Fiber Optic Type A or Fiber Optic Type B) and conduit size 
(2" or 3"). The current active scale is shown with a keyin field to reset as needed. Scale is used to 
control the size of pull boxes and other symbolization. All graphics are combined in a graphic 
group for easy deletion. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Lighting > Place Jacked/Bored Conduit 
or by using the keyin  
vba run [PlaceJackedBoredConduit]Jacked.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Place Jacked. The Place Jacked/Bored Conduit dialog 

appears. 

 
Step 2. Make the required settings.  

First the Signalization or Lighting toggle should be set as needed. 

Then the user needs to choose the Pull Box Type to be placed at the ends. Note that 
only pull box types A, B or C are valid for Lighting application. All are valid for 
Signalization application except for type C.  

Finally pick the Conduit Size and check the Scale value shown. 
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Step 3. Click on the Place Conduit command button. You are prompted to Identify Pull Box 
Location on Left. Data point on the left side of the roadway or other feature which 
conduit is to be jacked or bored under. 

 

Step 4. Once this point is given,  the graphics are shown dynamically and you are prompted 
to Identify Pull Box Location on Right. Data point at the pull box location on the 
right side. 
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Step 5. Graphics are placed and combined in a graphic group. At this point the program loops 
back to the beginning for additional placements. 

 
Graphics are placed so that D&C Manager can be used later to calculate the quantities 
for pull boxes and jacked or bored conduit line. 
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Pavement Marking 
Pavement Marking Cells 
D&C location: Drafting Standards > Pavement Marking > Pvmt Mk Cells 
MicroStation VBA Program: PavementMarkingCells.mvba 
Description: 
This program provides access to TDOT Design Division pavement marking cells. 
Command buttons are provided to access the Place Stop Bar, Place Crosswalk and Place Yield 
Line vba programs. 
A command button is provided to access MicroStation's Set Angle by 2 Points command so that 
lane lines can be used to set the angle for pavement markings. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Pavement Marking > Cells 
or by using the keyin  
vba run [PavementMarkingCells]PvmtMarkingcells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Pvmt Mk Cells. The Pavement Marking Cells dialog 

appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale in the MicroStation Tool Settings dialog to 1 unless noted otherwise in 
the cell description. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Place Crosswalk 
D&C location: Drafting Standards > Pavement Marking > Cross-walk 
MicroStation VBA Program: PlaceCrosswalk.mvba 
Description: 
This program places standard parallel or longitudinal bar crosswalks. A Width keyin field is 
provided to control the width of the crosswalk. Default for parallel crosswalks is 6' (1.8 meters) 
and longitudinal crosswalks is 10' (3 meters). 
 Additional graphics are placed within longitudinal crosswalk shapes to facilitate quantity 
calculation using Geopak's D&C Manager. Logitudinal crosswalk shapes are automatically 
centered between the begin and end points of the crosswalk. 
All label graphics are combined in a graphic group for easy deletion. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Pavement Marking > Place Crosswalk 
or by using the keyin  
vba run [PlaceCrossWalk]Crosswalk.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Cross-walk. The Place Crosswalk dialog appears. 

 
Step 2. First the Parallel or Longitudinal toggle should be set as needed. Default widths are 

automatically added to the Width keyin field. Adjust the width if needed. 
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Step 3. When started, program immediately prompts user to Identify Beginning . 

 

Step 4. After data pointing for the beginning of the crosswalk, the crosswalk is shown 
dynamically and you are prompted to Identify End. 
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Step 5. When the second point is given, graphics are placed and user is again prompted for 
beginning point of the crosswalk allowing for additional crosswalks to be placed. 

 
Step 6. When clean up of graphics is necessary for longitudinal crosswalks, first make sure 

graphic group lock is off. If any of the filled shapes are deleted or modified you will 
see extra short lines left over. Each filled shape in the crosswalk includes 2 extra lines 
which are used to calculate a linear quantity for the crosswalk. If a shape is deleted, 
delete the 2 lines as well. If the end of a shape is just modified move the line to the 
other end of the shape so that it will not show. This will ensure the correct quantity is 
calculated from the graphics. 

 
Parallel crosswalks are composed of just the 2 parallel lines. The quantity calculated 
for these is simply cut in half to come up with the length of crosswalk  
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Place Stop Bar 
D&C location: Drafting Standards > Pavement Marking > Stop Bar 
MicroStation VBA Program: PlaceStopBar.mvba 
Description: 
This program places stop bar pavement marking.  
An additional line is placed within the stop bar shape to facilitate quantity calculation using 
Geopak's D&C Manager.  
All label graphics are combined in a graphic group for easy deletion. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Pavement Marking > Place Stop Bar 
or by using the keyin  
vba run [PlaceStopBar]StopBar.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Stop Bar. When started, program immediately prompts 

user to Identify Beginning at Left. 

 
Snap and data point on the left lane line of the lane(s) where the stop bar is needed. 
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Step 2. After data pointing for the beginning of the stop bar, the stop bar is shown 
dynamically and you are prompted to Identify End at Right. 

 
Snap and data point on the right lane line of the lane(s) where the stop bar is needed. 

Step 3. When the second point is given, graphics are placed and user is again prompted for 
the beginning point on the left allowing for additional stop bars to be placed. 

 
If it becomes necessary to delete the stop bar, always turn on graphic group lock first 
so that the quantity calculation line behind the fill shape is deleted as well. 
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Place Yield Line 
D&C location: Drafting Standards > Pavement Marking > Yield Line 
MicroStation VBA Program: PlaceYieldLine.mvba 
Description: 
This program places standard yield line pavement marking triangle shapes. These are used at 
locations where lanes merge with other lanes such as at entrances to roundabout intersections or 
where right turn lanes merge with other roadways.  
Base Width and Spacing Width keyin fields are provided to control the placement of the triangle 
shapes. The height is set at 1.5 times the base width as specified by the M.U.T.C.D. manual. 
Defaults for the base and spacing widths are set at the recommended minimum of 12” (300 mm) 
and 3" (75 mm). The recommended ranges of minimum to maximum sizes for these are 
displayed on the dialog for guidance to the user.  
The triangle shapes are created with the yield line custom line style to facilitate quantity 
calculation using Geopak's D&C Manager. Triangle shapes are automatically centered in the 
distance specified by the begin and end points. 
All label graphics are combined in a graphic group for easy deletion. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Pavement Marking > Place Yield Line 
or by using the keyin  
vba run [PlaceYieldLine]YieldLine.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Yield Line. The Place Yield Line dialog appears. 

 
Step 2. Adjust the default values for the Base Width and Spacing Width if something other 

than the minimums is desired. 
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Step 3. When started, program immediately prompts user to Identify Beginning at Left. The 
yield line triangles should point back towards oncoming traffic so the beginning 
should always be identified on the left side of the lane 

 

Step 4. After data pointing for the beginning of the yield line, the yield line triangles are 
shown dynamically and you are prompted to Identify End. 
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Step 5. When the second point is given, graphics are placed and user is again prompted for 
beginning point of the yield line allowing for additional placements as needed. 

 
The Place Yield Line command button can be utilized at any time to restart 
placement after other MicroStation tools are used. 
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Sheets 
Sheet Cells 
D&C location: Drafting Standards > Sheets > Sheet Cells 
MicroStation VBA Program: StandardSheetCells.mvba 
Description: 
This program provides access to TDOT Design Division sheet cells. 
Command buttons are provided to access the Sheet Title Cells and Place North Arrow vba 
programs. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Sheet Cells 
or by using the keyin  
vba run [StandardSheetCells]STDSheetcells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Sheet Cells. The Sheet Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired. 

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Sheet Title Cells 
D&C location: Drafting Standards > Sheets > Sheet Titles 
MicroStation VBA Program: SheetTitleCells.mvba 
Description: 
This program provides access to TDOT Design Division sheet title cells. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Sheet Titles 
or by using the keyin  
vba run [SheetTitleCells]SHTTitlecells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Sheet Titles. The Sheet Title Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired. 

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Permits and Forms 
D&C location: Drafting Standards > Sheets > Permits & Forms 
MicroStation VBA Program: PermitFormsCells.mvba 
Description: 
This program provides access to TDOT Design Division permit and form cells. 
A command button is provided to access MicroStation's Drop Complex Status command (Drop 
Cell for Editing command button on dialog). 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Permits & Forms 
or by using the keyin  
vba run [PermitFormsCells]Permitcells.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Permits & Forms. The Permits and Forms dialog 

appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

Step 4. After the cell has been placed click on the Drop Cell for Editing command button 
and identify the form to drop its complex status. Now graphics can be edited as 
needed for your project. 
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Plan Phase Stamps 
D&C location: Drafting Standards > Sheets > PlanPhase Stmps 
MicroStation VBA Program: PlanPhaseCells.mvba 
Description: 
This program provides access to TDOT Design Division plan phase stamp cells. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Plan Phase Stamps 
or by using the keyin  
vba run [PlanPhaseCells]PlnPhasecells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate PlanPhase Stmps. The Plan Phase Stamps dialog 

appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired. 

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Public Hearing Cells 
D&C location: Drafting Standards > Sheets > Public Hearing 
MicroStation VBA Program: PublicHearingCells.mvba 
Description: 
This program provides access to TDOT Design Division public hearing cells. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Public Hearing Cells 
or by using the keyin  
vba run [PublicHearingCells]PublicHearngcells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Public Hearing. The Public Hearing Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired. 

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Title Sheet Cells 
D&C location: Drafting Standards > Sheets > Title Sht Cells 
MicroStation VBA Program: TitleSheetCells.mvba 
Description: 
This program provides access to TDOT Design Division title sheet cells. 
A command button is provided to access the Place North Arrow vba program. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Title Sheet Cells 
or by using the keyin  
vba run [TitleSheetCells]TitleSHTcells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Title Sht Cells. The Title Sheet Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired. 

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Signalization 
Signalization Device Cells 
D&C location: Drafting Standards > Signalization > Signal Cells 
MicroStation VBA Program: SignalizationDeviceCells.mvba 
Description: 
This program provides access to TDOT Design Division signalization device cells. 
A command button and keyin field are provided to place signal head number annotation. 
Includes options to place signal head number with circle, place mast arm by length and place 
pedestrian signal head with leader. Also includes command buttons to access Signal Head Cells, 
Place Signal Attachment Height Diagram, Place Jack/Bored Conduit, Label Conduit,  Label Pull 
Box, Draw Handicap Ramp, Station Offset Labeler, Geopak's D& C Manager, DP Station & 
Offset and Draw Transition tool. 
A command button is provided to access MicroStation's Set Active Angle by 2 Points command. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Signalization > Device Cells 
or by using the keyin  
vba run [SignalizationDeviceCells]SignalDevicecells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Signal Cells. The Signalization Device Cells dialog 

appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 
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Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Note that some 
“actual size” cells should be placed at scale of 1 as noted in their description. Place 
cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 

Any of these cell placement options can also be used in conjunction with Geopak’s 
DP Station/Offset tool to place the cell at a specific station and offset along the 
horizontal alignment. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

Place Signal Head Number: 
Step 1. In the Signal Head Number keyin field enter the number for a given signal head and 

then click on the Place Signal Head Number command button. 

Step 2. The user is prompted to Identify Location for text label placement. Text is placed 
within a circle for labeling signal heads in the plan view. 

 

Step 3. A data point places the label and the command remains active allowing multiple 
placements of signal head label. To change the number in the label simply change the 
number in the keyin field at any time. A reset will end placement of labels. 

 290



Signal Head Cells 
D&C location: Drafting Standards > Signalization > Signal Hd Cells 
MicroStation VBA Program: SignalHeadCells.mvba 
Description: 
This program provides access to TDOT Design Division signal head cells. 
A command button and keyin field are provided to place signal head number annotation. 
A command button is provided to place left turn signal sign faces with sign name annotation. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Signalization > Device Cells 
or by using the keyin  
vba run [SignalHeadCells]SignlHeadcells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Signal Hd Cells. The Signal Head Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Place Signal Head Numbers: 
Step 1. In the Signal Head Numbers keyin field, enter the numbers for a given signal head 

and then click on the Place Signal Head Numbers command button. 

Step 2. The user is prompted to Identify Location for text label placement. 

 

Step 3. A data point places the text label. 
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Place Left Turn Signal Sign: 
Step 1. First choose the desired left turn sign option, R10-10 (Left Turn Signal) or R10-12 

(Left Turn Yield On Green). Click on the Place Left Turn Signal Sign command 
button. The user is prompted to Identify Location for the sign face. 

 

Step 2. After placing the sign face the sign name annotation is activated and the user is 
prompted to Identify Location for text label placement. 

 

Step 3. A data point places the label. 
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Place Signal Attachment Height Diagram 
D&C location: Drafting Standards > Signalization > AH Diagram 
MicroStation VBA Program: SignalHeightAttachmentDiagram.mvba 
Description: 
This program generates a signal attachment height diagram from proposed signalization plan 
view graphics in a selection set. The diagram scale factor and the current active scale is shown 
with keyin fields to reset as needed. Plot Scale is used to control the text sizes used in the 
diagram.  
All diagram graphics are combined in a graphic group to aide in moving or deleting after initial 
placement. 

This program can also be activated from the MicroStation drop down menu  
 TDOT > Signalization > Place Signal AH Diagram 
or by using the keyin  
vba run [SignalHeightAttachmentDiagram]SignalHeightDiagram.Main 
Special Requirements: 
MicroStation Selection Set including support poles and span wire. Other intersection graphics 
may be in selection set as well but are ignored. 
This program does not currently support suspended box style of signalization design. 
Usage: 
Step 1. In D&C manager activate AH Diagram. The Place Signal Attachment Height 

Diagram dialog appears. 

 
Step 2. Review Diagram Scale Factor and Plot Scale and adjust as needed. 

Step 3. Create a selection set of intersection graphics using MicroStation’s Element 
Selection tool. Specific items do not need to be selected but the selection set should 
include all signal support poles and span wire.  
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Step 4. Click on the Place Signal Height Attachment Diagram command button. The user 
is prompted to Identify Center Point of the intersection. Data point in the general 
location of the middle of the intersection, this point does not have to be exact. 

 

Step 5. The selection set is then read and all signal support poles and span wire graphics are 
picked out and then scaled as specified by the diagram scale factor. Signal heights are 
calculated and generated as text labels. Diagram graphics are dynamically shown and 
then the user is prompted to Identify Diagram Location Point . 

 
Data point when satisfied with the location 

 295



Step 6. After placing the diagram, the title text annotation is activated and the user is 
prompted to Identify Location for text label placement. 

 
Step 6. After placing the title text, the user can start again with step 3 to place additional 

signal attachment height diagrams for any other intersections on the project. 

If the Diagram Scale Factor or Plot Scale given were in error, it will be necessary to 
re-run the program after resetting those values.  

 
Remember to delete or move a diagram, turn on the graphic group lock and then 
perform the needed operation. 

 296



Place Pedestrian Signal Head with Leader 
D&C location: Drafting Standards > Signalization > Ped Signal 
MicroStation VBA Program: SignalizationDeviceCells.mvba 
Description: 
This program places 1 or more pedestrian signal head symbols with a leader line.  
All graphics are combined in a graphic group to aide in moving or deleting after initial 
placement. 

This program can also be activated from the MicroStation drop down menu  
 TDOT > Signalization > Place Pedestrian Signal Head & Leader 
or by using the keyin  
vba run [SignalizationDeviceCells]PlacePedSignalHeadwithLeader.main 
Special Requirements: 
None 
Usage: 
Step 1. In D&C manager activate Ped Signal. 

Step 2. The user is prompted to Place Begin Point for the leader. Snap & data point in the 
center of the pole on which pedestrian signal heads are mounted. 
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Step 3. Leader line is shown dynamically and the user is prompted to Place end point. 

 
Data point when satisfied with the location. 

Step 4. After the end of the leader is given, a pedestrian signal head symbol cell is placed at 
the end in a spin mode and you are prompted to ID Point to set Cell Angle. 

 
Data point when satisfied with the angle. 
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Step 5. After that point is given, another pedestrian signal head is offered at that location 
allowing multiple signal heads to be placed. When finished at that location, a reset 
will loop the program back to the beginning allowing placement of leader line and 
signal heads at another location. 
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Place Mast Arm by Length 
D&C location: Drafting Standards > Signalization > MastArm Length 
MicroStation VBA Program: SignalizationDeviceCells.mvba 
Description: 
This program places a mast arm with user specified length. 
The mast arm cell is built so that at a scale of 1 it is 1' long in English or 1 meter long for metric. 
This allows an odd scale to be specified for the X axis to control the length. The Y axis is applied 
at the normal plot scale. The cell also includes a dotted centerline to aide in placement of signal 
head symbols. Since the cell includes a filled shape for the mast arm it will be necessary to turn 
off fill display to see its centerline. 

This program can also be activated from the MicroStation drop down menu  
 TDOT > Signalization > Place Mast Arm by Length 
or by using the keyin  
vba run [SignalizationDeviceCells]PlaceMastArm.main 
Special Requirements: 
AccuSnap must be turned off for this tool to function correctly. 
Usage: 
Step 1. In D&C manager activate MastArm Length. The Place Mast Arm by Length 

dialog appears. 

 
Step 2. Enter the desired mast arm length in the keyin field. 
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Step 3. Click on the Place Mast Arm command button. The user is prompted to Identify 
Start Point for the mast arm. Snap & data point in the center of the support pole 
which the mast arm extends from. 

 

Step 4. The cell is placed at an angle of 0 and then automatically passed into MicroStation’s 
Rotate Element command. The user is prompted to Identify Point to set Angle . 

 
Data point when satisfied with the angle. 
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Step 5. After giving the point, the mast arm still remains in a rotation mode. If satisfied with 
the angle, reset to stop the rotation of the mast arm or enter another point to reset the 
angle. 
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Label Conduit 
D&C location: Drafting Standards > Signalization > Label Conduit 
MicroStation VBA Program: LabelConduit.mvba 
Description: 
This program places proposed conduit labels with size & type. A toggle option is given for 
lighting or signalization application which controls the level of placement. It also includes an 
option to identify the conduit or fiber optic line to automatically set up the desired label text. A 
terminator option of a regular or small arrowhead or dot is provided. The current active scale is 
shown with a keyin field to reset as needed. Scale is used to control the size of label text and 
terminator. All label graphics are combined in a graphic group for easy movement or deletion. 

This program can also be activated from the MicroStation drop down menu  
 TDOT > Signalization > Label Conduit 
or by using the keyin  
vba run [LabelConduit]IDandLabelConduit.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Label Conduit. The Label Conduit dialog appears. 

 
Step 2. First the signalization or lighting toggle should be set as needed. Then the user either 

enters the label text in its keyin field manually or by using the ID Conduit for Label 
command button to identify the conduit to be labeled in order to fill in the keyin field 
automatically. Click on the ID command button and you are prompted to Identify 
Conduit. Data point on the conduit line and another data point to accept the element. 

 
Conduit must be placed with the correct standard symbology for this function to 
recognize it. An error message is generated for invalid elements. 
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Step 3. To place the label, choose the terminator type desired, check the scale and then click 
on the Place Label command button. You are prompted to Identify location for End 
of Leader. Data point on the conduit line. 

 

Step 4. Once this point is given,  the label is shown dynamically and the user is prompted for 
a second point to Position Label. As the label is moved around the leader is adjusted 
to come from either end of the horizontal line in the label. 

 
Data point when satisfied with the location 
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Step 5. Graphics are placed and combined in a graphic group. At this point the program loops 
back to the prompt to identify location for end of leader allowing for additional 
placements of the label. 

 
If the initial scale given was in error, it is necessary to re-start the command by 
clicking on the Place Label command button after resetting the given scale value. The 
terminator option can be reset at any time during label placement. 
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 Label Pull Box 
D&C location: Drafting Standards > Signalization > Label Pull Box 
MicroStation VBA Program: LabelPullBox.mvba 
Description: 
This program places proposed pull box labels. A toggle option is given for lighting or 
signalization application which controls the level of placement. It also includes an option to 
identify the pull box to automatically set up the desired label text. A terminator option of an 
arrowhead (medium), small arrowhead or none is available. The current active scale is shown 
with a keyin field to reset as needed. Scale is used to control the size of label text and terminator. 
All label graphics are combined in a graphic group for easy movement or deletion. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Signalization > Label Pull Box 
or by using the keyin  
vba run [LabelPullBox]IDandLabelPullBox.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Label Pull Box. The Label Pull Box dialog appears. 

 
Step 2. First the signalization or lighting toggle should be set as needed. Then the user either 

enters the label text in its keyin field manually or by using the ID Pull Box for Label 
command button to identify the pull box to be labeled in order to fill in the keyin field 
automatically. Click on the ID command button and you are prompted to Identify 
Pull Box. Data point on the pull box cell and another data point to accept the element. 

 
Pull box cells must be placed on the correct level for this function to recognize it. An 
error message is generated for invalid elements. 
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Step 3. To place the label, choose the terminator type desired, check the scale and then click 
on the Place Label command button. You are prompted to Identify location for End 
of Leader. Data point on the pull box. 

 

Step 4. Once this point is given,  the label is shown dynamically and the user is prompted for 
a second point to Position Label. As the label is moved around the leader is adjusted 
to come from either end of the horizontal line in the label. 

 
Data point when satisfied with the location 
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Step 5. Graphics are placed and combined in a graphic group. At this point the program loops 
back to the prompt to identify location for end of leader allowing for additional 
placements of the label. 

 
If the initial scale given was in error, it is necessary to re-start the command by 
clicking on the Place Label command button after resetting the given scale value. The 
terminator option can be reset at any time during label placement. 
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Place Jacked or Bored Conduit 
D&C location: Drafting Standards > Signalization > Place Jacked 
MicroStation VBA Program: PlaceJackedBoredConduit.mvba 
Description: 
This program places jacked/bored conduit under roadways. A toggle option is given for lighting 
or signalization application which controls the level of placement. Choices are given for the pull 
box type (Type A, Type B, Type C, Fiber Optic Type A or Fiber Optic Type B) and conduit size 
(2" or 3"). The current active scale is shown with a keyin field to reset as needed. Scale is used to 
control the size of pull boxes and other symbolization. All graphics are combined in a graphic 
group for easy deletion. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Signalization > Place Jacked/Bored Conduit 
or by using the keyin  
vba run [PlaceJackedBoredConduit]Jacked.Main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Place Jacked. The Place Jacked/Bored Conduit dialog 

appears. 

 
Step 2. Make the required settings.  

First the Signalization or Lighting toggle should be set as needed. 

Then the user needs to choose the Pull Box Type to be placed at the ends. Note that 
only pull box types A, B or C are valid for Lighting application. All are valid for 
Signalization application except for type C.  

Finally pick the Conduit Size and check the Scale value shown. 
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Step 3. Click on the Place Conduit command button. You are prompted to Identify Pull Box 
Location on Left. Data point on the left side of the roadway or other feature which 
conduit is to be jacked or bored under. 

 

Step 4. Once this point is given,  the graphics are shown dynamically and you are prompted 
to Identify Pull Box Location on Right. Data point at the pull box location on the 
right side. 
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Step 5. Graphics are placed and combined in a graphic group. At this point the program loops 
back to the beginning for additional placements. 

 
Graphics are placed so that D&C Manager can be used later to calculate the quantities 
for pull boxes and jacked or bored conduit line. 
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Signs 
Blank Signs, Etc. 
D&C location: Drafting Standards > Signs > Blanks,etc. 
MicroStation VBA Program: BlankSignCells.mvba 
Description: 
This program provides access to TDOT Design Division blank sign cells as well as cells used to 
set up new signs. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Signs > Blank Signs, Etc. 
or by using the keyin  
vba run [BlankSignCells]BlnkSigncells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Blanks,etc. The Blank Signs, Etc. dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Construction Sign Cells 
D&C location: Drafting Standards > Signs > Construction 
MicroStation VBA Program: ConstructionSignCells.mvba 
Description: 
This program provides access to TDOT Design Division construction sign face cells. Cell list 
also includes various permanent & temporary sign symbols near the end 
A command button and keyin fields are provided to place sign face with associated optional 
graphics including a text label, leader line and sign symbol (single post & face). Option for 
placement as Permanent or Temporary sign is given which controls the level and text label type 
which is used. As a permanent sign, sign number text is placed with enclosing ellipse and as a 
temporary sign, sign name and optional size is placed. All text values are displayed in keyin 
fields allowing adjustment by the user if needed. When a sign number is placed with permanent 
signs, the value is automatically incremented by one with each placement. All text in keyin fields 
can be altered on the fly during placement. By default these signs are set for placement as 
Temporary signs.  
A command button is provided to place permanent sign # only. 
A command button is provided to access the Warning Sign cell dialog. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 

Since English sign cells are used in metric files, a keyin field is provided which shows the 
desired Metric Plot Scale. This value is used to alter the active scale temporarily so that sign 
faces are placed at the correct size. When the Cancel button is clicked to close the dialog, the 
active scale is reset to match the specified plot scale. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Signs  > Construction 
or by using the keyin  
vba run [ConstructionSignCells]ConstSigncells.main 

Special Requirements: 
None. 
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Usage: 
Step 1. In D&C manager activate Construction. The Construction Sign Cells dialog 

appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

Place Sign Face with…: 
Step 1. Make dialog settings. First set Permanent or Temporary placement.  

Under the optional graphics list on the left side of the dialog, turn on the desired 
graphics to be placed with the sign face. In this example we will place a temporary 
sign with all extra graphics.  

When placing temporary signs the text label includes an option to include the sign 
size. Click on the appropriate size if desired. If needed, edit text in keyin fields. 
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Step 2. Once required values and options are set click on the Place Sign Face with. 
command button. The user is prompted to Identify Location for sign face. 

 
Step 3. After placing the sign face the sign name annotation is activated and the user is 

prompted to Identify Location for text label placement. 
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Step 4. The program then starts placement of the leader line with the initial prompt to Place 
Begin Point. After giving the begin point the user is prompted to Place next 
point…Reset to End. Continue entering additional points for the leader as needed up 
to a maximum of 4 vertices. 

 

Step 5. When leader line is completed, click the reset on your mouse to end the leader. 
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Step 6. In our example we also requested a sign symbol cell. The program prompts to 
Identify location but rather just data pointing to place the symbol we will use the 
Place Cell & Rotate function from Cell Tools. If the Cell Tools toolbar is not open, 
click on the Cell Tools command button and then click on the first icon in the toolbar. 

 

Step 6. Zoom in to the location for the sign and you may wish to click on the dialog window 
shade button to clear the view area. Data point at the location for the sign symbol and 
then data point again to set the cell angle. Geopak’s DP Station/Offset tool could be 
used to place the sign symbol at a specific station and offset. 
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Place Sign # Only: 
If it is necessary to replace the sign number on a permanent sign or to place it at a later time than 
when the sign face was first placed then use the Place Sign # Only command. 
Step 1. First enter the needed sign number in the keyin field provided and then click on the 

Place Sign # Only command button. 

 The user is prompted to Identify Location for sign number placement 

 

Step 2. After placing the label, the sign number is incremented by 1 and offered to place 
additional sign numbers. A reset will end placement of sign numbers. 
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Sign Detail Cells 
D&C location: Drafting Standards > Signs > Details 
MicroStation VBA Program: SignDetailCells.mvba 
Description: 
This program provides access to TDOT Design Division sign detail cells. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Signs > Details 
or by using the keyin  
vba run [SignDetailCells]SGNDetailcells.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Details. The Sign Detail Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Highway Route Sign Cells 
D&C location: Drafting Standards > Signs > Highway Route 
MicroStation VBA Program: HighwayRouteSignCells.mvba 
Description: 
This program provides access to TDOT Design Division highway route sign face cells. Cell list 
also includes various permanent & temporary sign symbols near the end 
A command button and keyin fields are provided to place sign face with associated optional 
graphics including the route number, a text label, leader line and sign symbol (single post & 
face). Option for placement as Permanent or Temporary sign is given which controls the level 
and text label type which is used. As a permanent sign, sign number text is placed with enclosing 
ellipse and as a temporary sign, sign name and optional size is placed. All text values are 
displayed in keyin fields allowing adjustment by the user if needed. When a sign number is 
placed with permanent signs, the value is automatically incremented by one with each 
placement. All text in keyin fields can be altered on the fly during placement. By default these 
signs are set for placement as Permanent signs. 
A command button is provided to place permanent sign # only. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 

Since English sign cells are used in metric files, a keyin field is provided which shows the 
desired Metric Plot Scale. This value is used to alter the active scale temporarily so that sign 
faces are placed at the correct size. When the Cancel button is clicked to close the dialog, the 
active scale is reset to match the specified plot scale. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Signs  > Highway Route 
or by using the keyin  
vba run [HighwayRouteSignCells]HwyRouteSigncells.main 

Special Requirements: 
None. 
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Usage: 
Step 1. In D&C manager activate Highway Route. The Highway Route Sign Cells dialog 

appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

Place Sign Face with…: 
Step 1. Make dialog settings. First set Permanent or Temporary placement.  

Under the optional graphics list on the left side of the dialog, turn on the desired 
graphics to be placed with the sign face. In this example we will place a permanent 
sign with all extra graphics except the sign symbol.  

 321



When placing permanent signs with sign numbers be sure and set the number in the 
keyin field provided. 

When placing highway route signs, an extra option to include the route number on the 
sign face is given. If this option is selected, enter the route number in its keyin field  

Step 2. Once required values and options are set click on the Place Sign Face with. 
command button. The user is prompted to Identify Location for sign face. 

 
Step 3. After placing the sign face the sign number annotation is activated and the user is 

prompted to Identify Location for text label placement. 
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Step 4. The program then starts placement of the leader line with the initial prompt to Place 
Begin Point. After giving the begin point the user is prompted to Place next 
point…Reset to End. Continue entering additional points for the leader as needed up 
to a maximum of 4 vertices. 

 

Step 5. When leader line is completed, click the reset on your mouse to end the leader. 

 

 323



Place Sign # Only: 
If it is necessary to replace the sign number on a permanent sign or to place it at a later time than 
when the sign face was first placed then use the Place Sign # Only command. 
Step 1. First enter the needed sign number in the keyin field provided and then click on the 

Place Sign # Only command button. 

 The user is prompted to Identify Location for sign number placement 

 

Step 2. After placing the label, the sign number is incremented by 1 and offered to place 
additional sign numbers. A reset will end placement of sign numbers. 
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Regulatory Sign Cells 
D&C location: Drafting Standards > Signs > Regulatory 
MicroStation VBA Program: RegulatorySignCells.mvba 
Description: 
This program provides access to TDOT Design Division regulatory sign face cells. Cell list also 
includes various permanent & temporary sign symbols near the end 
A command button and keyin fields are provided to place sign face with associated optional 
graphics including a text label, leader line and sign symbol (single post & face). Option for 
placement as Permanent or Temporary sign is given which controls the level and text label type 
which is used. As a permanent sign, sign number text is placed with enclosing ellipse and as a 
temporary sign, sign name and optional size is placed. All text values are displayed in keyin 
fields allowing adjustment by the user if needed. When a sign number is placed with permanent 
signs, the value is automatically incremented by one with each placement. All text in keyin fields 
can be altered on the fly during placement. By default these signs are set for placement as 
Permanent signs. 
A command button is provided to place permanent sign # only. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 

Since English sign cells are used in metric files, a keyin field is provided which shows the 
desired Metric Plot Scale. This value is used to alter the active scale temporarily so that sign 
faces are placed at the correct size. When the Cancel button is clicked to close the dialog, the 
active scale is reset to match the specified plot scale. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Signs  > Regulatory 
or by using the keyin  
vba run [RegulatorySignCells]RegSigncells.main 

Special Requirements: 
None. 
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Usage: 
Step 1. In D&C manager activate Regulatory. The Regulatory Sign Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

Place Sign Face with… & Place Sign # Only: 
See Construction Sign Cells for temporary sign placements and Highway Route Sign 
Cells for permanent sign placements. 
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School Sign Cells 
D&C location: Drafting Standards > Signs > Schools 
MicroStation VBA Program: SchoolSignCells.mvba 
Description: 
This program provides access to TDOT Design Division school sign face cells. Cell list also 
includes various permanent & temporary sign symbols near the end 
A command button and keyin fields are provided to place sign face with associated optional 
graphics including a text label, leader line and sign symbol (single post & face). Option for 
placement as Permanent or Temporary sign is given which controls the level and text label type 
which is used. As a permanent sign, sign number text is placed with enclosing ellipse and as a 
temporary sign, sign name and optional size is placed. All text values are displayed in keyin 
fields allowing adjustment by the user if needed. When a sign number is placed with permanent 
signs, the value is automatically incremented by one with each placement. All text in keyin fields 
can be altered on the fly during placement. By default these signs are set for placement as 
Permanent signs. 
A command button is provided to place permanent sign # only. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 

Since English sign cells are used in metric files, a keyin field is provided which shows the 
desired Metric Plot Scale. This value is used to alter the active scale temporarily so that sign 
faces are placed at the correct size. When the Cancel button is clicked to close the dialog, the 
active scale is reset to match the specified plot scale. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Signs  > Schools 
or by using the keyin  
vba run [SchoolSignCells]ScoolSigncells.main 

Special Requirements: 
None. 
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Usage: 
Step 1. In D&C manager activate Schools. The School Sign Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

Place Sign Face with… & Place Sign # Only: 
See Construction Sign Cells for temporary sign placements and Highway Route Sign 
Cells for permanent sign placements. 
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Tennessee Sign Cells 
D&C location: Drafting Standards > Signs > Tennessee 
MicroStation VBA Program: TennesseeSignCells.mvba 
Description: 
This program provides access to TDOT Design Division special Tennessee sign face cells. Cell 
list also includes various permanent & temporary sign symbols near the end 
A command button and keyin fields are provided to place sign face with associated optional 
graphics including a text label, leader line and sign symbol (single post & face). Option for 
placement as Permanent or Temporary sign is given which controls the level and text label type 
which is used. As a permanent sign, sign number text is placed with enclosing ellipse and as a 
temporary sign, sign name and optional size is placed. All text values are displayed in keyin 
fields allowing adjustment by the user if needed. When a sign number is placed with permanent 
signs, the value is automatically incremented by one with each placement. All text in keyin fields 
can be altered on the fly during placement. By default these signs are set for placement as 
Permanent signs. 
A command button is provided to place permanent sign # only. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 

Since English sign cells are used in metric files, a keyin field is provided which shows the 
desired Metric Plot Scale. This value is used to alter the active scale temporarily so that sign 
faces are placed at the correct size. When the Cancel button is clicked to close the dialog, the 
active scale is reset to match the specified plot scale. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Signs  > Tennessee 
or by using the keyin  
vba run [TennesseeSignCells]TNSigncells.main 

Special Requirements: 
None. 
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Usage: 
Step 1. In D&C manager activate Tennessee. The Tennessee Sign Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

Place Sign Face with… & Place Sign # Only: 
See Construction Sign Cells for temporary sign placements and Highway Route Sign 
Cells for permanent sign placements. 
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Warning Sign Cells 
D&C location: Drafting Standards > Signs > Warning 
MicroStation VBA Program: WarningSignCells.mvba 
Description: 
This program provides access to TDOT Design Division warning sign face cells. Cell list also 
includes various permanent & temporary sign symbols near the end 
A command button and keyin fields are provided to place sign face with associated optional 
graphics including a text label, leader line and sign symbol (single post & face). Option for 
placement as Permanent or Temporary sign is given which controls the level and text label type 
which is used. As a permanent sign, sign number text is placed with enclosing ellipse and as a 
temporary sign, sign name and optional size is placed. All text values are displayed in keyin 
fields allowing adjustment by the user if needed. When a sign number is placed with permanent 
signs, the value is automatically incremented by one with each placement. All text in keyin fields 
can be altered on the fly during placement. By default these signs are set for placement as 
Permanent signs. 
A command button is provided to place permanent sign # only. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 

Since English sign cells are used in metric files, a keyin field is provided which shows the 
desired Metric Plot Scale. This value is used to alter the active scale temporarily so that sign 
faces are placed at the correct size. When the Cancel button is clicked to close the dialog, the 
active scale is reset to match the specified plot scale. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Signs  > Warning 
or by using the keyin  
vba run [WarningSignCells]WarnngSigncells.main 

Special Requirements: 
None. 
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Usage: 
Step 1. In D&C manager activate Warning. The Warning Sign Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

Place Sign Face with… & Place Sign # Only: 
See Construction Sign Cells for temporary sign placements and Highway Route Sign 
Cells for permanent sign placements. 
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Traffic Control (Temporary) 
Traffic Control Device Cells 
D&C location: Drafting Standards > Traffic Control (Temporary) > TC Device Cells 
MicroStation VBA Program: TrafficControlCells.mvba 
Description: 
This program provides access to TDOT Design Division traffic control device cells. 
A command button is provided to access the MicroStation Basic macro which is used to pattern 
work zone areas. 
Command buttons are provided to access the Traffic Control Legend cell dialog and the 
Construction Sign cell dialog. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Traffic Control > Device Cells 
or by using the keyin  
vba run [TrafficControlCells]TrafficCntrlcells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate TC Device Cells. The Traffic Control Device Cells dialog 

appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

 333



Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  
This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 
Any of these cell placement options can also be used in conjunction with Geopak’s 
DP Station/Offset tool to place the cell at a specific station and offset along the 
horizontal alignment. 

The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

Traffic Control Legend Cells 
D&C location: Drafting Standards > Traffic Control (Temporary) >  TC Legend Cells 
MicroStation VBA Program: TrafficControlLegendCells.mvba 
Description: 
This program provides access to TDOT Design Division traffic control legend cells. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 

This program can also be activated from the MicroStation drop down menu  
TDOT > Traffic Control > Legend Cells 
or by using the keyin  
vba run [TrafficControlLegendCells]TrafficCntrlLegendcells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate TC Legend Cells. The Traffic Control Legend Cells 

dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  
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Pattern Work Zone Area 
D&C location: Drafting Standards >Traffic Control (Temporary) > Work Zone Area 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a work zone 
area and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Traffic Control > Work Zone AP  
or by using the keyin  
vba run [AreaPatterns]TrafficControlWorkZone.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Work Zone Area. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 

 

 336



Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Topo Cells 
Topographic Cells 
D&C location: Drafting Standards > Topo Cells 
MicroStation VBA Program: TopographicCells.mvba 
Description: 
This program provides access to TDOT Design Division topographic cells. 
Command buttons are provided to access the Place North Arrow at True North, Place Coordinate 
Grid Tick and Place Grid Ticks by Range vba programs. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Topographic > Cells 
or by using the keyin  
vba run [TopographicCells]Topocells.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Topo Cells. The Topographic Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  
This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 
Any of these cell placement options can also be used in conjunction with Geopak’s 
DP Station/Offset tool to place the cell at a specific station and offset along the 
horizontal alignment. 
The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Typical Sections 
Typical Section Cells 
D&C location: Drafting Standards > Typical Sections > Typ Sec Cells 
MicroStation VBA Program: TypicalSectionCells.mvba 
Description: 
This program provides access to TDOT Design Division typical section cells. 
A command button is provided to access MicroStation command Drop Complex (command 
button Drop Cell For Editing). 
A command button is provided to access vba programs Area Patterns and Code Pavement 
Layers. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Typical Sections > Cells 
or by using the keyin  
vba run [TypicalSectionCells]TypSectioncells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Typ Sec Cells. The Typical Section Cells dialog appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  

Step 4. If changes in the typical section are needed: After cell has been placed click on the 
Drop Cell for Editing command button and identify the typical section to drop its 
complex status. Now the typical can be edited as needed for your roadway. 
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Area Patterns 
D&C location: Drafting Standards > Typical Sections > Area Patterns 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 

This program provides access to TDOT Design Division area pattern cells. Clicking on any area 
pattern description in the dialog list, will make all needed settings for that area pattern, start the 
area pattern tool and show an example in the preview window. In addition, it sets the active level 
used for the area pattern and sets the pattern cell as the active cell for review as needed. The 
current active scale is shown with a keyin field to reset as needed. Scale is used to control the 
pattern scale and pattern delta which is applied. 

The Change Pattern Element Level command button turns on the graphic group lock and starts 
the change level command so the user can correct area pattern's level as needed. 

The Place Area Pattern command button is provided to restart the area pattern command without 
re-selecting from the area pattern list. 

'The Change Shape To Fill Solid Black command button is provided to change shape elements to 
fill outlined with white fill which plots as black. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Area Patterns > Design Area Patterns or  
TDOT > Typical Sections > Area Patterns 
or by using the keyin  
vba run [AreaPatterns]AP.Main 

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 
Step 1. In D&C manager activate Area Patterns. The Design Area Patterns dialog appears. 
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Step 2. Check and reset Scale if needed. Pattern scale, row spacing & column spacing are 
based on the current active scale. Note that in some cases the resulting pattern scale 
will not be the same as the active scale.  

Step 3. Click on any area pattern description in the dialog list. The area pattern settings are 
made and an area pattern example is displayed in the preview window.  

 
The Pattern Area tool is activated with the appropriate settings.  The active level is 
set as well. 

 
Step 4. Set the desired method for area patterning in the Pattern Area tool settings and you 

are ready to apply the area pattern.  

 341



Code Pavement Layers 
D&C location: Drafting Standards > Typical Sections > Code Pvmt Layer 
MicroStation VBA Program: CodePavementLayers.mvba 
Description: 
This program places pavement layer code labels on typical sections. Option for vertical or 
dynamic leader is given. The current active scale is shown with a keyin field to reset as needed. 
Scale is used to control the text size of label. 
The code  number is automatically incremented by one after each placement, allowing 
continuous placement of codes for the typical section. 
If any given code number needs to be placed again it will be necessary to re-enter the value in 
the Code Number keyin field on the dialog before continuing with the placement of code labels. 
The type of leader can be changed on the fly as well, simply click the alternate leader type prior 
to placing the code number. 
If the initial scale given was in error, it is necessary to re-start the command by clicking on the 
Place Pavement Layer Code command button after resetting the given scale value. 

This program can also be activated from the MicroStation drop down menu  
 TDOT > Typical Sections > Code Pavement Layers 
or by using the keyin  
vba run [CodePavementLayers]CodePavement.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Code Pvmt Layer. The Code Pavement Layers dialog 

appears. 

 
Step 2. First choose the type of leader and check the scale. Enter the code number to start 

placement with and click on the Place Pavement Layer Code command button to 
start placement of the code. 
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The code text in a circle shows dynamically on the cursor and the user is prompted 
Identify Location for placement. 

 
Step 3. Once this point is given,  a second point is required to set the leader length. The user 

is prompted to Place Leader end point. 
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Step 4. The leader is placed with a filled dot for the terminator and all graphics are combined 
in a graphic group The code  number is automatically incremented by one and again 
prompts the user to Identify Location for the code label, allowing continuous 
placement of codes for the typical section. 

 
Step 5. The type of leader can be changed on the fly, simply click the alternate leader type 

prior to placing the code number. Here we have switched to a dynamic leader which 
allows a leader to be placed at any angle  
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Construction Supers  
TDOTsuper1 
D&C location: Construction Supers > TDOTsuper1 
Geopak 3PC Program: tdotsup1.x 
Description: 
Adds user specified superelevation data to horizontal  alignment curves. Used by Construction 
personnel.  

Special Requirements: 
All horizontal alignment graphics must be visible in View Window #1. 

Usage: 

Step 1. Using D&C item HA Roadway display the horizontal alignment(s). 

Step 2. In View Window #1 fit view so that all graphics are displayed in the view. If needed 
turn on level DESIGN - CENTERLINE - Proposed. 

Step 3. In D&C manager activate TDOTsuper1.  

Step 4. You are prompted for a job no. Key that in and click OK. 

 

Step 5. You are then prompted for the chain name. Key that in and click OK. 

 

Step 6. The 3PC processes the chain and finds the first curve. You are first prompted for the 
superelevation rate (e max) for the curve. Key that in and click OK. 
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If the curve is a simple curve without spirals: 

Step 7. You are then prompted for the transition length for the curve. Key that in and click 
OK. Complex curves with spirals use the spiral length instead of prompting for this 
value. 

 

Step 8. You are then prompted for the % of the transition on the curve. Key that in and 
click OK. 

 

 

If the curve is a complex curve with spirals or when steps 6 through 8 are completed for a 
simple curve: 

Step 9. The 3PC processes the chain and looks for additional curves. Depending on the type 
of curve found,  steps 6 through 8 are repeated as needed. On each curve the data 
entered is written to the curve elements. When all curves are processed the chain 
completion message is displayed. 

 

Once the chain is completed D&C item TDOTsuper2 or TDOTsuper3 can then be 
used. 
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TDOTsuper2 
D&C location: Construction Supers > TDOTsuper2 
Geopak 3PC Program: tdotsup2.x 
Description: 
Draws pattern lines with station values at critical superelevation transition points as well as the 
begin & end and builds autoshape input file for superelevation using values entered with D&C 
item TDOTsuper1. Used by Construction personnel. 

This application is specifically for undivided crown roadways. 

Special Requirements: 
Superelevation information must be written to horizontal alignment graphics with D&C item 
TDOTsuper1. 

Usage: 

Step 1. Using D&C item TDOTsuper1 to set up superelevation information. 

Step 2. In D&C manager activate TDOTsuper2.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

 

Step 5. You are then prompted for the profile name. Key that in and click OK. 
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Step 6. You are then prompted for the Horizontal Distance between Chain and Profile. 
Key that in and click OK.  

 

This is referring to the tie offset which is usually 0 for undivided crown roadways 
which is the default value given. 

Step 7. You are then prompted for the Left Offset which is used to define the outside limit of 
the superelevation shape to the left. Key that in and click OK. 

 

Offsets to the left of the centerline are always negative numbers. 

Step 8. You are then prompted for the Right Offset which is used to define the outside limit 
of the superelevation shape to the right. Key that in and click OK. 

 

Step 9. You are then prompted for the Autoshape File Name. This is the superelevation 
shape input file the program is to create. Key that in and click OK. 

 

Step 10. You are then given the option to place patterns where the outside slope = 0.000 (zero 
slope). Pick Yes or No and click OK. 
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Step 11. Finally you are prompted for the MicroStation DGN filename that super shapes are 
to be written into. Key in the filename and click OK. 

 

The pattern lines are drawn and annotated with station values in the open 
MicroStation DGN file. 

 

The autoshape input file is created and can be reviewed with any text editor. If 
desired, transitions back to existing cross slopes can be added at the ends by editing 
station and cross slopes listed. Note that cross slopes must be in a percentage format. 

 

Geopak's Autoshape Builder can now be used to process this input file to build 
superelevation shapes for the roadway. 
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TDOTsuper3 
D&C location: Construction Supers > TDOTsuper3 
Geopak 3PC Program: tdotsup3.x 
Description: 
Draws pattern lines with station values at critical superelevation transition points as well as the 
begin & end and builds autoshape input file for superelevation using values entered with D&C 
item TDOTsuper1. Used by Construction personnel. 

This application is specifically for divided roadways or ramps. 

Special Requirements: 
Superelevation information must be written to horizontal alignment graphics with D&C item 
TDOTsuper1. 

This program must be run twice to set up autoshape input files for left & right side of divided 
highways. 

In most cases it is only necessary to run once to the left for ramps. 

Usage: 

Step 1. Using D&C item TDOTsuper1 to set up superelevation information. 

Step 2. In D&C manager activate TDOTsuper3.  

Step 3. You are prompted for a job no. Key that in and click OK. 

 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

 

Step 5. You are then prompted for the profile name. Key that in and click OK. 
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Step 6. You are then prompted for the Offset to the inside edge of pavement or PGL 
(profile grade line). Key that in and click OK.  

 

Normally for ramps… this value would be 0. All other offsets to the left of the 
centerline are always negative numbers.  

Step 7. You are then prompted for the Offset to the outside edge of pavement which is used 
to define the outside limit of the superelevation shape. Key that in and click OK. 

 

Step 8. You are then prompted for the Normal Crown slope. This must be entered in a 
percentage format such as -2. Key that in and click OK.  

 

Normally for ramps… this value would be a positive 2 percent (i.e. 2). Only in 
special cases where ramp superelevation shapes are set up to the right would this 
value be -2.  

Step 9. You are then prompted for the Autoshape File Name. This is the superelevation 
shape input file the program is to create. Key that in and click OK.  

 

On the second pass for the opposite side of the road, keyin a different filename than 
entered on the first pass to avoid overwriting the first file (i.e. shape2.inp). 
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Step 10. You are then given the option to Draw Patterns?. Pick Yes or No and click OK.  

 

On the first pass using this program you would normally say Yes and on the second 
pass to set up the other side of the divided roadway you would say No having already 
placed patterns. 

Step 11. If you said Yes to place patterns then you are then given the option to place patterns 
where the outside slope = 0.000 (zero slope). Pick Yes or No and click OK. 

 

Step 12. Finally you are prompted for the MicroStation DGN filename that superelevation 
shapes are to be written into. Key in the filename and click OK. 

 

If the pattern line option was chosen then they are drawn and annotated with station 
values in the open MicroStation DGN file. 
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The autoshape input file is created and can be reviewed with any text editor. If 
desired, transitions back to existing cross slopes can be added at the ends by editing 
station and cross slopes listed. Note that cross slopes must be in a percentage format. 

 

Geopak's Autoshape Builder can now be used to process this input file to build 
superelevation shapes for one side of the roadway or you may wish to run this 
program again to set up the opposite side of the roadway and then process both 
autoshape input files at the same time. 

Step 13. Repeat steps 2 through 12 to set up the opposite side of  a divided highway. 
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Functional 
Place Horizontal Alignment Points 
D&C location: Functional > HA Points F 
MicroStation VBA Program: HApoints.mvba 
Description: 
This program places the required point text symbols for all keypoints of any horizontal 
alignment/chain stored in the project GPK file in the plan view. The PI symbol (triangle) with 
short sub tangents are placed for all spiral-curve combinations or simple curves. The point on 
chain symbol (circle) is placed at the begin & end and at all on chain curve points. The PI 
symbol (triangle) by itself is placed at any break in tangent direction without a curve along the 
horizontal alignment. This is applicable to the following horizontal alignment types: Proposed 
Roadway Centerline, Preliminary Roadway Centerline, Existing Roadway Centerline, Proposed 
Special Ditch Centerline, Existing Stream Baseline, Functional Roadway Centerline, Proposed 
Private Drive Centerline. 
All graphics are placed in a single graphic group for easy deletion as needed. 
This tool stores the current location of the dialog, GPK job number, chain name and horizontal 
alignment type in the file C:\Temp\MVBA_FormStorage.log when the dialog is closed. When 
opened later it uses this information if applicable to bring up the dialog as you last used it. 
This program can also be activated from the MicroStation drop down menu at  
TDOT > Centerlines > Place Horizontal Alignment Points  
or by using the keyin  
vba run [HApoints]HApointsStart.main   
Special Requirements: 
Chains that are to be processed must be stored in a Geopak GPK file in the folder where the 
MicroStation DGN file resides.  
The ID Chain function uses a special VBA reference to program GetCogoElement.mvba which 
was provided by Bentley and must be present with the program for it to function. 
Usage: 

Step 1. In D&C manager activate HA Points F. The Place Horizontal Alignment Points 
dialog is displayed. 

All Geopak jobs found within the current active folder are listed in the Job drop down 
box.  If this tool was used previously for that job, the last chain processed is set as 
well as the last horizontal alignment type which was used.  Scale defaults to active 
scale set in the MicroStation DGN file. 
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Step 2. After selecting the Geopak Job number as needed, the Chain drop down is populated 
with all chains stored in the job.  Select the chain to place point symbols for.  If you 
do not know the chain name but have chain graphics, the ID button can be used to 
select the chain.  

Step 3. Set the Type to Functional Roadway Centerline by clicking that option in the drop 
down list provided. This setting controls the level, symbology, etc. for the point 
symbols which are to be placed. 

 

If this tool was used previously, the last horizontal alignment type which was used is 
set automatically when the tool is activated. 

Step 4. Reset the Scale if needed and click the Place Points command button. Point symbols 
are displayed for the specified chain. 

Step 5. If you need to place point symbols for other chains, reset the chain name and click the 
Place Points command button for each one.  
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Pattern Functional Pavement Area 
D&C location: Functional > Pvmt Pattern F 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern Functional 
pavement areas and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns 
or by using the keyin  
vba run [AreaPatterns]FunctionalPavement.SetPattern   

Special Requirements: 
Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Pvmt Pattern F. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Pattern Functional Bridge Area 
D&C location: Functional > Br Pattern F 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a Functional 
bridge areas and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns 
or by using the keyin  
vba run [AreaPatterns]FunctionalBridge.SetPattern   

Special Requirements: 

Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate Br Pattern F. The Pattern Area tool is activated with the 
appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Pattern Functional ROW Area 
D&C location: Functional > ROW Pattern F 
MicroStation VBA Program: AreaPatterns.mvba 
Description: 
This application sets the area pattern parameters and active level needed to pattern a Functional 
R.O.W. areas and starts MicroStation's Pattern Area tool.  

This program can also be activated from the MicroStation drop down menu at  
TDOT > Area Patterns > Design Area Patterns 
or by using the keyin  
vba run [AreaPatterns]FunctionalROW.SetPattern   

Special Requirements: 

Depending on the method of area pattern placement to be used take the following actions: 

Flood method: Create a Selection Set of the elements bounding the area to be patterned. 

Element, Union, Intersection or Difference methods: Create shape element(s) bounding the 
area to be patterned. 
Fence method: Create a fence bounding the area to be patterned. 

Usage: 

Step 1. In D&C manager activate ROW Pattern F. The Pattern Area tool is activated with 
the appropriate settings.  The active level is set as well. 
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Or from the drop down menu in the Design Area Patterns dialog … 

 

Step 2. Choose the method of placing the area pattern from the choices at the top of the tool 
settings for Pattern Area. In this example we are using Flood. 

Step 3. Depending on the method chosen, the user is prompted for a data point or points to 
initiate the area patterning. With Flood, the user is prompted to Enter data point 
inside area. 
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Step 4. The user is then prompted to Accept @pattern intersection point. 

 

After giving the accept point, the area is patterned. 
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Utilities - Plan 
Utility Cells - Proposed 
D&C location: Utilities – Plan > Proposed > Utility Cells Pr 
MicroStation VBA Program: UtilityCellsProp.mvba 
Description: 
This program provides access to TDOT Design Division proposed utility cells. These do include 
existing guy anchors. 
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Utilities > Proposed Cells 
or by using the keyin  
vba run [UtilityCellsProp]Utiltycells.main 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Utility Cells Pr. The Utility Cells - Proposed dialog 

appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  
This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 
Any of these cell placement options can also be used in conjunction with Geopak’s 
DP Station/Offset tool to place the cell at a specific station and offset along the 
horizontal alignment. 
The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 

 365



Utility Cells - Existing 
D&C location: Utilities – Plan > Existing > Utility Cells E 
MicroStation VBA Program: UtilityCellsExist.mvba 
Description: 
This program provides access to TDOT Design Division existing utility cells.  
A command button is provided to access MicroStation's Cell Tools mdl program for various 
placement control options. When clicked the Cell Tools tool bar is opened. 
This program can also be activated from the MicroStation drop down menu  
TDOT > Utilities > Existing Cells 
or by using the keyin  
vba run [UtilityCellsExist]Utiltycells.main 

Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Utility Cells E. The Utility Cells - Existing dialog 

appears. 

 
Step 2. Click on any cell description in the dialog list. The cell is made active and is 

displayed in the preview window. MicroStation’s Place Cell command is 
automatically started. 

Step 3. Adjust scale if needed in the MicroStation Tool Settings dialog. Place cell as desired.  
This can be done with Place Cell which is currently active or by accessing 
MicroStation’s Cell Tools with the command button provided. The Cell Tools tool 
bar  has additional cell placement options including place cell with a spin to set the 
angle or place cells along an element at a specific spacing, offset and angle. 
Any of these cell placement options can also be used in conjunction with Geopak’s 
DP Station/Offset tool to place the cell at a specific station and offset along the 
horizontal alignment. 
The Restart Cell Place command button can be used anytime other MicroStation 
commands have been used and you wish to go back to placing the currently selected 
cell. 
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Pay Items  
Curb 702-01 
Concrete Curb Volume Computation 
D&C location: Pay Items > Curb 702-01 > (all curb items) 
Geopak 3PC Program: Curb_Computation.x 
Description: 
This application reads a D&C Manager set of curb lines, prompts the user for the volume per 
linear foot rate for each line & then calculates the total volume and reports the quantity back to 
D&C Manager.  

Special Requirements: 
None 

Usage: 

Step 1. Set up any of the computational methods provided by Geopak’s D&C Manager and 
click on the Compute Quantities command button in the Plan Quantity Computation 
Dialog. 

Step 2. As Geopak reads the individual curb lines, a prompt is given for the user to provide 
the cubic yards of concrete per linear foot of curb. Enter the appropriate rate and click 
OK. These rates can be found on standard roadway drawings RP-MC-1, RP-MC-2 
and RP-NMC-10. 

. 

Step 3. This prompt is repeated for each curb element computed. The initial rate which was 
entered is retained so the user can simply click the OK button each time. When all 
elements have been measured the total quantity is passed back to D&C Manager’s 
Computation Results dialog. 

 
If more than one type of curb is found on the project, it will be necessary to add their 
volumes together to get the total volume for item number 702-01 Concrete Curb. 

If side roads include the same type of curb but with a different cubic yards of concrete 
per linear foot rate, then it is recommended that they be computed separately to 
ensure accurate results. 
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. Set up any of the computational methods provided by Geopak’s D&C Manager and 
click on the Compute Quantities command button in the Plan Quantity Computation 
Dialog. 

utter 702-03 
 Curb & Gutter Volume Computation 

D&C location: Pay Items > Curb & Gutt
Geopak 3PC Program: Cur
Description: 
This application reads a D&C Manager set of curb & gutter lines, prompts the user 
volume per linear foot rate for each line & then calculate
quantity back to D&C Manager.  

Special Requirements: 
None 

Usage: 

Step 1

Step 2. As Geopak reads the individual curb & gutter lines, a prompt is given for the user to 
provide the cubic yards of concrete per linear foot of curb & gutter. Enter the 
appropriate rate and click OK. These rates can be found on standard roadway 
drawings RP-MC-1, RP-MC-2 and RP-NMC-10. 

. 

Step 3. This prompt is repeated for each curb & gutter element computed. The initial rate 
which was entered is retained so the user can simply click the OK button each time. 
When all elements have been measured the total quantity is passed back to D&C 
Manager’s Computation Results dialog. 

 
If more than one type of curb & gutter is found on the project, it will be necessary to 
add their volumes together to get the total volume for item number 702-03 Concrete 
Combined Curb and Gutter. 

 
 

If side roads include the same type of curb & gutter but with a different cubic yards of
concrete per linear foot rate, then it is recommended that they be computed separately
to ensure accurate results. 
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Erosion Control Items 
Berm Volume Computation 
D&C location: Pay Items > Erosion Control > (all berm items) 
Geopak 3PC Program: Berm_Computation.x 
Description: 
This application reads a D&C Manager set of erosion control earth, compost or mulch berm 
lines, prompts the user for the cross section area of  each line & then calculates the total volume 
and reports the quantity back to D&C Manager.  

Special Requirements: 
None 

Usage: 

Step 1. Set up any of the computational methods provided by Geopak’s D&C Manager and 
click on the Compute Quantities command button in the Plan Quantity Computation 
Dialog. 

Step 2. As Geopak reads the individual berm lines, a prompt is given for the user to provide 
the cross section area of the berm. Enter the appropriate area or use the default area 
given and click OK. Default area values are based on standard roadway drawings EC-
STR-27 and EC-STR-35. 

. 

Step 3. This prompt is repeated for each berm element computed. Default areas are given 
each time so it will be necessary to re-enter if you are using a different value. Click 
OK to proceed. When all elements have been measured the total quantity is passed 
back to D&C Manager’s Computation Results dialog. 

 
If more than one size of a given berm type is used on your project , then it is 
recommended that they be computed separately and then added together later to 
ensure accurate results. 
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Temporary Slope Drain Computation 
D&C location: Pay Items > Erosion Control > 209-02.__ temporary slope drain (all sizes) 
Geopak 3PC Program: SlopeDrain_Computation.x 
Description: 
This application reads a D&C Manager set & then takes the length of each slope drain pipe, 
adjusts for slope distance,  using side slope adhoc information attached to them and reports the 
adjusted lengths back to D&C Manager with other pay item data stored as adhoc info. This 
program is used to tabulate either temporary or permanent slope drains.  
This application of the program looks for linework that matches standard level and symbology 
for temporary slope drains. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically calculates the quantity from the temporary slope drains found and sends the total 
back to D&C Manager.  

Rock Check Dam Computation 
D&C location: Pay Items > Erosion Control > 209-08.07 
Geopak 3PC Program: RockCheckDams_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the rock check dam cells and reports 
the quantity back to D&C Manager.  
This includes “V” ditch rock check dams (cell name: RCDV) and trapezoidal ditch rock check 
dams (cell name: RCDT). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  
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Enhanced Rock Check Dam Computation 
D&C location: Pay Items > Erosion Control > 209-08.08 
Geopak 3PC Program: EnhancedRockCheckDams_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the enhanced rock check dam cells and 
reports the quantity back to D&C Manager.  
This includes “V” ditch enhanced rock check dams (cell name: ERCDV), trapezoidal ditch 
enhanced rock check dams (cell name: ERCDT), channel enhanced rock check dams (cell name: 
ERCDCH) and sediment traps with trapezoidal ditch enhanced rock check dams (cell name: 
STERCD). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  

Proposed Tree Computation 
D&C location: Pay Items > Erosion Control > 802-01.__ proposed trees(all types) 
Geopak 3PC Program: Tree_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the proposed tree cells, reading pay 
item adhoc information attached to them and reports pay item number, description and quantities 
back to D&C Manager.  
This program looks for cell name: TREEPROPOSED. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  

 372



Level Spreaders Computation 
D&C location: Pay Items > Erosion Control > 805-01.69 
Geopak 3PC Program: LevelSpreaders_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the level spreader cells and reports the 
quantity back to D&C Manager.  
This includes level spreaders with single direction of in-flow (cell name: LEVELSPS) and level 
spreaders with dual direction of in-flow (cell name: LEVELSPD). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  
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Pavement Marking 
Thermoplastic Flatline Pavement Striping Lines with LM units Computation 
D&C location: Pay Items > Pavement Marking > Thermoplastic Striping > ThermoFlat LM 
Geopak 3PC Program: Striping_Thermo_Flatline_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement striping lines 
that are measured in linear miles (4” and 6” stripes) and reports the quantity, item number & 
description back to D&C Manager. Program automatically adjusts for gaps & double lines. This 
program is specifically set up to tabulate pavement striping lines as the thermoplastic flatline 
type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

This should not be used in conjunction with painted or spray thermoplastic pavement striping 
computational items since lines may be counted twice yielding incorrect quantities. 

Thermoplastic Flatline Pavement Striping Lines with LF units Computation 
D&C location: Pay Items > Pavement Marking > Thermoplastic Striping > ThermoFlat LF 
Geopak 3PC Program: Striping_Thermo_Flatline_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement striping lines 
that are measured in linear feet (4”, 6” & 8” dotted stripes, 8” & 24” barrier stripes) and reports 
the quantity, item number & description back to D&C Manager. Program automatically adjusts 
for gaps & double lines. This program is specifically set up to tabulate pavement striping lines as 
the thermoplastic flatline type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

This should not be used in conjunction with painted or spray thermoplastic pavement striping 
computational items since lines may be counted twice yielding incorrect quantities.Care should 
be taken when setting up the control for what elements should be computed so that 8” barrier 
striping lines used as borders around channelization areas are not included. 
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Thermoplastic Spray (60mil) Pavement Striping Lines with LM units 
Computation 
D&C location: Pay Items > Pavement Marking > Thermoplastic Striping > ThermoSpray60 LM 
Geopak 3PC Program: Striping_Thermo_Spray60_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement striping lines 
that are measured in linear miles (4” and 6” stripes) and reports the quantity, item number & 
description back to D&C Manager. Program automatically adjusts for gaps & double lines. This 
program is specifically set up to tabulate pavement striping lines as the spray thermoplastic 
(60mil) type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

This should not be used in conjunction with painted, spray thermoplastic (40mil) or 
thermoplastic flatline pavement striping computational items since lines may be counted twice 
yielding incorrect quantities. 

Thermoplastic Spray (60mil) Pavement Striping Lines with LF units 
Computation 
D&C location: Pay Items > Pavement Marking > Thermoplastic Striping > ThermoSpray60 LF 
Geopak 3PC Program: Striping_Thermo_Spray60_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement striping lines 
that are measured in linear feet (4”, 6” & 8” dotted stripes, 8” & 24” barrier stripes) and reports 
the quantity, item number & description back to D&C Manager. Program automatically adjusts 
for gaps & double lines. This program is specifically set up to tabulate pavement striping lines as 
the spray thermoplastic (60mil) type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

This should not be used in conjunction with painted, spray thermoplastic (40mil) or 
thermoplastic flatline pavement striping computational items since lines may be counted twice 
yielding incorrect quantities. Care should be taken when setting up the control for what elements 
should be computed so that 8” barrier striping lines used as borders around channelization areas 
are not included. 
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Thermoplastic Spray (40mil) Pavement Striping Lines with LM units 
Computation 
D&C location: Pay Items > Pavement Marking > Thermoplastic Striping > ThermoSpray40 LM 
Geopak 3PC Program: Striping_Thermo_Spray40_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement striping lines 
that are measured in linear miles (4” and 6” stripes) and reports the quantity, item number & 
description back to D&C Manager. Program automatically adjusts for gaps & double lines. This 
program is specifically set up to tabulate pavement striping lines as the spray thermoplastic 
(40mil) type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

This should not be used in conjunction with painted, spray thermoplastic (60mil) or 
thermoplastic flatline pavement striping computational items since lines may be counted twice 
yielding incorrect quantities. 

Thermoplastic Spray (40mil) Pavement Striping Lines with LF units 
Computation 
D&C location: Pay Items > Pavement Marking > Thermoplastic Striping > ThermoSpray40 LF 
Geopak 3PC Program: Striping_Thermo_Spray40_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement striping lines 
that are measured in linear feet (4”, 6” & 8” dotted stripes, 8” & 24” barrier stripes) and reports 
the quantity, item number & description back to D&C Manager. Program automatically adjusts 
for gaps & double lines. This program is specifically set up to tabulate pavement striping lines as 
the spray thermoplastic (40mil) type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

This should not be used in conjunction with painted, spray thermoplastic (60mil) or 
thermoplastic flatline pavement striping computational items since lines may be counted twice 
yielding incorrect quantities. Care should be taken when setting up the control for what elements 
should be computed so that 8” barrier striping lines used as borders around channelization areas 
are not included. 
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Thermoplastic Channelization Lines with SY units Computation 
D&C location: Pay Items >Pavement Marking >Thermoplastic Striping >T Channelizaton 
Geopak 3PC Program: Striping_Thermo_Channelization_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement 
channelization striping lines (8” and 12” stripes),  calculates the area and reports the quantity, 
item number & description back to D&C Manager. This program is specifically set up to tabulate 
pavement channelization striping lines as the thermoplastic type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

This should not be used in conjunction with painted pavement striping computational items since 
lines may be counted twice yielding incorrect quantities. Care should be taken when setting up 
the control for what elements should be computed so that regular 8” pavement striping lines and 
12” transverse shoulder striping lines are not included with channelization striping lines. 

Thermoplastic Transverse Shoulder Lines Computation 
D&C location: Pay Items >Pavement Marking >Thermoplastic Striping >Transverse Shld 
Geopak 3PC Program: Striping_Thermo_Transverse_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement transverse 
shoulder striping lines (12” stripes) and reports the quantity, item number & description back to 
D&C Manager. This program is specifically set up to tabulate pavement transverse shoulder 
striping lines as the thermoplastic type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

Care should be taken when setting up the control for what elements should be computed so that 
other channelization striping lines are not included with transverse shoulder striping lines. 
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Painted Pavement Striping Lines with LM units Computation 
D&C location: Pay Items > Pavement Marking > Painted Striping > Paint LM 
Geopak 3PC Program: Striping_Paint_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement striping lines 
that are measured in linear miles (4” and 6” stripes) and reports the quantity, item number & 
description back to D&C Manager. Program automatically adjusts for gaps & double lines. This 
program is specifically set up to tabulate pavement striping lines as the painted type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

This should not be used in conjunction with flatline or spray thermoplastic pavement striping 
computational items since lines may be counted twice yielding incorrect quantities. 

Painted Pavement Striping Lines with LF units Computation 
D&C location: Pay Items > Pavement Marking > Painted Striping > Paint LF 
Geopak 3PC Program: Striping_Paint_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement striping lines 
that are measured in linear feet (4”, 6” & 8” dotted stripes, 8” & 24” barrier stripes) and reports 
the quantity, item number & description back to D&C Manager. Program automatically adjusts 
for gaps & double lines. This program is specifically set up to tabulate pavement striping lines as 
the painted type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

This should not be used in conjunction with flatline or spray thermoplastic pavement striping 
computational items since lines may be counted twice yielding incorrect quantities. Care should 
be taken when setting up the control for what elements should be computed so that 8” barrier 
striping lines used as borders around channelization areas are not included. 
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Painted Channelization Lines with SY units Computation 
D&C location: Pay Items >Pavement Marking > Painted Striping >P Channelizaton 
Geopak 3PC Program: Striping_Painted_Channelization_Computation.x 
Description: 
This application reads a D&C Manager set and then counts the length of pavement 
channelization striping lines (8” and 12” stripes),  calculates the area and reports the quantity, 
item number & description back to D&C Manager. This program is specifically set up to tabulate 
pavement channelization striping lines as the painted type. 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the line work found and sends the total back to D&C 
Manager.  

This should not be used in conjunction with flatline or spray thermoplastic pavement striping 
computational items since lines may be counted twice yielding incorrect quantities. 

Care should be taken when setting up the control for what elements should be computed so that 
regular 8” pavement striping lines, 12” transverse shoulder striping lines are not included with 
channelization striping lines. 

Pavement Marking Turn Arrow Computation 
D&C location: Pay Items > Pavement Marking > 716-02.06 
Geopak 3PC Program: TurnArrow_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the turn arrow pavement marking cells 
and reports the quantity back to D&C Manager.  
This includes left turn arrow (cell name: PVAL), right turn arrow (cell name: PVAR), left turn 
lane arrows (cell name: PVA2L) and left turn fish-hook arrow (cell name: PVFHAL). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  

 379



Pavement Marking Straight-Turn Arrow Computation 
D&C location: Pay Items > Pavement Marking > 716-04.01 
Geopak 3PC Program: StraightTurnArrow_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the combination straight or turn arrow 
pavement marking cells and reports the quantity back to D&C Manager.  
This includes the following cells:  
straight or left turn arrows (cell name: PVASL)  
straight or right turn arrows (cell name: PVASR)  
straight, left or right turn arrows (cell name: PVASB)  
straight or left turn fish-hook arrows (cell name: PVFHALS)  
straight or right turn fish-hook arrows (cell name: VFHARS)  
straight, left or right turn fish-hook arrows (cell name: PVFHARSL). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  

Pavement Marking Double -Turn Arrow Computation 
D&C location: Pay Items > Pavement Marking > 716-04.02 
Geopak 3PC Program: DoubleTurnArrow_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the double-turn arrow pavement 
marking cells and reports the quantity back to D&C Manager.  
This includes left & right turn arrow (cell name: PVALR) and left & right turn fish-hook arrow 
(cell name: PVFHARL). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  
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Pavement Marking Exit Only Arrow Computation 
D&C location: Pay Items > Pavement Marking > 716-04.07 
Geopak 3PC Program: ExitOnlyArrow_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the exit only arrow pavement marking 
cells and reports the quantity back to D&C Manager.  
This includes straight exit arrow (cell name: PVASI) and right exit arrow (cell name: PVARI). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  
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R.O.W.  
Count ROW Markers by Sheet Area 
D&C location: Pay Items > R.O.W. > ROW Markers 
Geopak 3PC Program: count_row_markers.x 
Description: 
This application reads a selection set of a given sheet area & then counts all R.O.W. markers and 
appends this info to a CSV file named ROWmarkers.csv.  

Data in the file reads sheet no., number of A's, number of B's, number of C's. 

Special Requirements: 
MicroStation selection set which includes graphics from level DESIGN - ROW - Right-of-Way 
Markers must be active. 

Usage: 

Step 1. Turn on level 46 if not already on. Create a MicroStation selection set of elements for 
the first sheet area.  

 Step 2. In D&C manager activate ROW Markers.  

Note: Although under the Pay Items group this function is activated in D&C 
Manager’s Design mode. 

Step 3. You are prompted for the sheet no. Key that in and click OK. 

 

Step 4. The selection set is processed and graphics are read looking for proposed R.O.W. 
marker cells (PROWA, PROWB & PROWC). When processing is finished the 
numbers are totaled and appended to CSV file ROWmarkers.csv .Click OK to 
dismiss the completion message. 
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Step 5. Repeat steps 1 through 4 for the remaining sheet areas. At any time Excel can be used 
to review the contents of the CSV data file being built. Remember the data in the file 
reads sheet no., number of A's, number of B's, number of C's. 

 

Step 6. When all sheets have been counted, open ROWmarkers.csv with Excel, highlight all 
the data and click Copy. Open your projects estimated roadway quantities Excel file 
to your R.O.W. markers tabulation worksheet. Use Insert to add this worksheet if 
needed. Click into the first field of the block, right click choose Paste Special, set to  
Values and click OK to paste the data into the block. 
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ROW Markers Computation 
D&C location: Pay Items > R.O.W. > ROW Markers 
Geopak 3PC Program: ROW_Markers_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the R.O.W. marker cells and reports 
the quantity back to D&C Manager.  
This includes type A markers (cell name: PROWA), type B markers (cell name: PROWB) and 
type C markers (cell name: PROWC). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  
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Signalization Items 
Saw Slot from Signal Loop Detector Cells Computation 
D&C location: Pay Items > Signalization Items > 730-14.02+ 
Geopak 3PC Program: SignalLoop_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the signal loop detector cells and 
reports the saw slot linear feet quantity back to D&C Manager.  
This includes single 50’ loop (cell name: LDS), double 50’ loop (cell name: LDD), single 20’ 
loop (cell name: LDS20), quadrapole loop (cell name: LDQUAD), single density loop (cell 
name: LDVDS), double density loop (cell name: LDVD) and square series loop (cell name: 
LDSQSE). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  

Loop Wire from Signal Loop Detector Cells Computation 
D&C location: Pay Items > Signalization Items > 730-14.03+ 
Geopak 3PC Program: SignalLoop_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the signal loop detector cells and 
reports the loop wire linear feet quantity back to D&C Manager.  
This includes single 50’ loop (cell name: LDS), double 50’ loop (cell name: LDD), single 20’ 
loop (cell name: LDS20), quadrapole loop (cell name: LDQUAD), single density loop (cell 
name: LDVDS), double density loop (cell name: LDVD) and square series loop (cell name: 
LDSQSE). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  
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Traffic Control Items 
Traffic Control Flexible Drum/Barrel Computation 
D&C location: Pay Items > Traffic Control Items > 712-04.01 
Geopak 3PC Program: Barrel_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the flexible drum cells and reports the 
quantity back to D&C Manager.  
This includes left barrel (cell name: BARRLT), right barrel (cell name: BARRRT) and center 
barrel (cell name: BARREL). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  

Traffic Control Vertical Panel Computation 
D&C location: Pay Items > Traffic Control Items > 712-06.01 
Geopak 3PC Program: VerticalPanel_Computation.x 
Description: 
This application reads a D&C Manager set & then counts the vertical panel sign cells and reports 
the square feet quantity back to D&C Manager.  
This includes single faced vertical panel signs (cell name: TVP) and double faced vertical panel 
signs (cell name: T2VP). 

Special Requirements: 
None 

Usage: 
Use any of the computational methods provided by Geopak’s D&C Manager and the program 
automatically tabulates the quantity from the cells found and sends the total back to D&C 
Manager.  
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